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Preface

This ASG-SmartTest Installation Guide explains the installation and maintenance of
ASG-SmartTest (herein called SmartTest). SmartTest is the Testing/Debugging
component of the ASG Existing Systems Workbench (ESW). It automates the time
consuming and error prone process of testing and debugging application programs.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical
support is available around the world, 24 hours a day, 7 days a week.

A SG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

About this Publication

This publication consists of these chapters:

Chapter 1, "Introduction," provides an overview of SmartTest and ASG's ESW
products.

Chapter 2, "Installing and Customizing SmartTest," describes the system resources
needed and provides the instructions for installing and maintaining SmartTest.

Chapter 3, "Customizing CICS," contains installation instructions and describes the
system resources needed to install and maintain SmartTest-CICS.

Chapter 4, "Customizing IMS," describes the procedures used to customize specific
SmartTest-IMS libraries.

Chapter 5, "Validating ASM," describes the validation of the SmartTest-ASM
installation.

Chapter 6, "Customizing APS," providesinformation for using SmartTest with APS
programs.

Chapter 7, "Validating PL1," describes how to validate the SmartTest-PLI
installation.

Chapter 8, "Customizing Stored Procedures,” provides instructions for installing
and customizing the SmartTest Stored Procedure option.

Vi
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Related Publications

viii

The documentation library for ASG-SmartTest consists of these publications (where nn
represents the product version number):

Note:

ASG-Center Installation Guide (CNX0300-nn) contains installation and
maintenance information for ASG-Center, the common set of libraries shared by the
ASG-ESW suite of products.

ASG-ESW Enhancement Summary (ESW1000-nn) highlights the new functionality
for thisrelease.

ASG-SmartTest CICSUser’s Guide (STC0200-nn) contains specific commands and
test session setup information for the CICS environments.

ASG-SmartTest for COBOL and Assembler User’s Guide (STA0200-nn) contains
introductory and usage information for COBOL and Assembler. It also containstest
session setup information for the TSO, ISPF, IMS/DB, DB/2, BTS, and Batch
environments.

ASG-SmartTest IMS User’s Guide (STM0200-nn) contains specific commands and
test session setup information for the IMS/DC environments.

ASG-SmartTest Installation Guide (STX0300-nn) contains information for
installing and maintaining ASG-SmartTest.

ASG-SmartTest PLI User’s Guide (STL0200-nn) contains introductory and usage
information about how to use ASG-SmartTest with the PL/I language. It also
contains test session setup information for the TSO, ISPF, IMS/DB, DB/2, BTS,
and Batch environments.

ASG-SmartTest Quick Sart for COBOL/ASM (STA0900-nn) summarizes how to
use ASG-SmartTest with the COBOL or Assembler language.

ASG-SmartTest Quick Sart for PL/I (STL0900-nn) summarizes how to use
ASG-SmartTest with the PL/I language.

ASG-SmartTest Reference Guide (STX0400-nn) contains detailed reference
information about CUA pull-downs and pop-ups, ASG-SmartTest command
syntax, and pseudo code.

ASG-SmartTest Reference Summary (STX0600-nn) summarizes the syntax and
usage of ASG-SmartTest commands.

ASG-SmartTest TCA User’s Guide (STT0200-nn) contains procedures for using the
ASG-SmartTest-TCA (Test Coverage Analysis) option.

To obtain a specific version of a publication, contact ASG Customer Support.
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ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW
products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figurele+ ASG Existing Systems Workbench

Existing Systems Workbench I

ASG-Alliance for Application Understanding

ASG-AutoChange for Mass Change Projects
ASG-Bridge for Conversion Projects
ASG-Encore for Evolving COBOL Programs
ASG-Center ASG-Estimate for Resource Estimation
ASG-Insight for Program Understanding
ASG-Recap for Portfolio Analysis

. . ASG-SmartDoc for Program Documentation
Analytical Engine |«

Y

ASG-SmartEdit for COBOL Intelligent Editing

ASG-SmartQuest for Analyzing Abends

Application
Knowledge

Repository (AKR) - TS0
- CICs

- IMS

- ASM

- APS

- PLI

- TCA for Test Coverage Analysis
- DB2 Stored Procedure

ASG-SmartTest for Testing/Debugging




ASG-SmartTest Installation Guide

This table contains the name and description of each ESW component:

ASG-Alliance

Alliance

The application understanding component that is
used by I T professionalsto conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance alows the programmer/
analyst to accurately perform application analysis
tasks in afraction of the time it would take to
perform these tasks without an automated
analysistool. Theimpact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange AutoChange

The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge

Bridge

Thebridging product that enablesfield expansion
for program source code, without being required
to simultaneously expand the fieldsin files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center

Center

The common platform for al ESW products.
Center providesthecommon Analytical Engineto
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergisticaly.
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ASG-Encore Encore The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
Thecode generation facilitiesallow you to usethe
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate Estimate The resource estimation tool that enablesthe user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight Insight The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify dataflow,
find program anomalies, and trace logic paths. It
also has automated proceduresto assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap Recap The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysisinformation can also be viewed
interactively or exported to a database,
Spreadsheet, or graphics package.

ASG-SmartDoc SmartDoc The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
sourcelisting, structure charts, program summary
reports, exception reportsfor program anomalies,
and software metrics.

xi
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ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the | SPF/PDF
Editor isinvoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supportsall versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartQuest  SmartQuest Thediagnostic tool for analyzing batch and CICS
transaction abends. SmartQuest has been
designed to make the maximum use of simple
point-and-shoot techniques to enable fast and
easy navigation through any data dump.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programsin the TSO,
MV S Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembl ed object code support, and full screen
memory display.

Invoking ESW Products

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site startsa
product directly, use the I SPF selection or CLIST asindicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the I SPF selection or CLIST asindicated by your systems administrator and then
typing in the product command on the command line.

The product names can a so vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration” on page xiii for more information about
using ESW.

Xii
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To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Alliance (Application Understanding) AL Understand » Application
AutoChange (Conversion Set) CcC Change » Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Program Re-engineering) EN Re-engineer » Program
Estimate ES Measure » ASG-Estimate
Insight (Program Understanding) IN Understand » Program
Recap (Portfolio Analysis) RC Measure P Portfolio
SmartDoc (Program Documentation) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartQuest SQV Understand » Abend/Dump

SmartTest (Testing/Debugging) ST Test » Module/Transaction

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW
products directly, or through the main ESW screen. As aresult, different fields, values,
action bar options, and pull-down options display on a screen or pop-up depending on
how you accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Allianceisinstalled, SmartTest provides a dynamic
link to Alliance that can be used to display program analysisinformation. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
automatically available for viewing logic/data rel ationships and execution path. For
example, the Scratchpad option is available on the Options pull-down if you have Insight
installed.

Xiii
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Accessto these integrated products requires only that they be installed and executed in
the same libraries.

Example 1

Figure 2 shows the Encore Primary screen that displays when you access Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,
Extract, Generate, Search, List, Options, and Help.

Figure2+« EncorePrimary Screen

File Uiew Edtract Generate 3Zearch List Odptions Help

AEE-Encore
CoHHand ===
Aotttk Hetebbek bbbl Stk
Atk Hbtebk bbbkl ettt
Atttk Atttk Hhtebkbt kekR Atk
Aetetoick Aetetoick Atttk etk Atk
Atttk
Aotttk

Copyright ALLen $ystens Group, IncC., an unpublished work.
A proprietary product of ASG, Inc. Use pestricted to authorized licensees.
Visit the ASGE Support Web Site at www.asg.cod
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Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer » Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter
Encore through ESW. Also, the Logic menu item displaysif Insight isinstalled.

Figure 3+« ESW Encore Primary Screen

File Uiew Edtract Generate fearch Logic List Options Help

AZG-EZN — Prograd Re-engineering

CorAdand ===
Atttk Eoos 2 I S s 2 Atk
Aotttk Aebbt bbbk Aotk
Atttk Atttk Atttk stk Atk
Atttk Atttk debittck deboiolk Aok
Aotk
ettt

Copwright Allen Systens Group, INC.. an unpubliszhed vork.
A proprietary product of ASG, InC. Use restricted to authorized licensess.
Wigit the AZG Support Web Zite at wuw,asg.coH

Figure 4 shows the File - Analyze Submit pop-up that displays when you access
SmartTest directly. Figure 5 on page xvi showsthe File - Analyze Submit pop-up that
displays when you access SmartTest through ESW.

Figured« File- Analyze Submit Screen

File - Analyze SUbHiT
ConAand ===

E - Edit JCL % = EubMiT JCL

CoHpile and link JCL [PDE or sequentiall:
Data set nane

Analyze features [T-M]:
ASG-3HartTests ¥ Extended Analysis:s M

AKR data set nawe
AKR proghad nade  NEWDEHO [if overriding PROGRAA-IO0)

Analyze options:

CoHpile? [Y«H] « o o o o o« o T [¥ if needad by features)
Link 1oad Hodule reusable® [Y-M] T

XV
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The actions shown on these screens can also vary. For example, the D - Doc Options
action isonly available on the File Prepare Program screen (or File - Analyze Submit
screen) if SmartDoc isinstalled on your system. In Figure 4 on page xv, the Doc Options

action is not displayed.

Figure5e« ASG-ESW - Prepare Program Screen (accessed through ESW)

CoHHand ===

AZE-EIN - Prepare Prograd

E - Edit TCL % - Eubmit TCL

CoHpile and link JCL [PDE oF sequentiall:
Data =&t nane

0 - Doc options

Analyze features [T-M]:
Understand: M Testl T
Re-&ngineetl N Abend<DuMpl N

AKR data set nane

Extended Analysiss M

Docurent: M

AKR prograd nane  MEWMDEHO

Analyze options:

[if overriding PROGRAR-IO)

CoHpile? [¥«<H] « « o« @ & o & o T
Link l1oad Hodule reusable® (v-M] T

[¥ if needad by features)
[Test and Abend-Ounp onlyl

Notice that the Analyze featuresfield in Figure 5 lists additional ESW products than
shown on Figure 4 on page xv. Thisfield isautomatically customized to contain the ESW
products you have installed on your system. These are the names of the analyze types:

ASG-Encore Re-engineer
ASG-Insight Understand
ASG-SmartDoc Document
ASG-SmartQuest Abend/Dump
ASG-SmartTest Test

Extended Analysis (ASG-SmartTest with  Extended Analysis

Insight installed)

XVi
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Publication Conventions
ASG uses these conventions in technical publications:

Convention Represents

ALL CAPITALS Directory, path, file, dataset, member, database,
program, command, and parameter names.

Initial Capitals on Each Word Window, field, field group, check box, button, panel (or
screen), option names, and names of keys. A plussign
(+) isinserted for key combinations (e.g., Alt+Tab).

lowercase italic Information that you provide according to your
monospace particular situation. For example, you would replace
T1lename with the actual name of thefile.

Monospace Characters you must type exactly as they are shown.
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examplesin a paragraph.

Vertical Separator Bar (|) Optionsavailablewith thedefault valueunderlined (e.q.,
with underline Y|N).

Underline Denotes a cursor-selectable field or line.

ASG Customer Support

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during
normal business hours and emergency support during non-business hours.

ASG Third-party Support. ASG provides software products that run in a number of
third-party vendor environments. Support for all non-ASG productsis the responsibility
of the respective vendor. In the event avendor discontinues support for a hardware and/or
software product, ASG cannot be held responsible for problems arising from the use of
that unsupported version.

XVvii
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Intelligent Support Portal (ISP)

Online product support is available at: http://www.asg.com/support/support.asp via the
ASG Intelligent Support Portal (1SP). Y our logon information for | SP online support is:

Customer ID = NNNNNNNNN
Password = XXXXXXXXXX

where;

NNNNNNNNNN is your customer 1D supplied by ASG Product Distribution.
XXXXXXXXXX isyour unique password supplied by ASG Product Distribution.

The ASG-Intelligent Support Portal User's Guide providesinstructions on how to usethe
ISP and islocated on the ASG Support web page.

Telephone Support

To expedite response time, please have this information ready:

- Product name, version number, and rel ease number

- List of any fixes currently applied

- Any alphanumeric error codes or messages written precisely as displayed
- A description of the specific steps that immediately preceded the problem

- Verify whether you received an ASG Service Pack or cumulative service tape for this
product. It may include information to help you resolve questions regarding installation of
this ASG product. The Service Pack instructions are in atext file on the distribution media
included with the Service Pack. Y ou can access the latest software corrections and Service
Packs viathe | SP.

- The severity code (ASG Customer Support uses an escalated severity system to prioritize
serviceto our clients. The severity codes and their meanings are listed below.)

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response Time
1 Production down, critical situation Within 30 minutes
2 Major component of product disabled Within 2 hours
3 Problem with the product, but customer has ~ Within 4 hours
work-around solution
4 "How-to" questions and enhancement Within 4 hours
requests

XViii
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The Americas

Phone

Fax
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E-mail

United States and
Canada

Europe, Middle East, and Africa (EMEA)

800.354.3578

1.703.464.4901

support@asg.com

During normal business hours, we recommend that you call the Central Support number

first (except in South Africa).

Phone Fax E-mail
Central Support 00.800.3544.3578 44.1727.812018 support.emea@asg.com
English 44.1727.736305 44.1727.812018 support.uk@asg.com
French 33.141.028590 33.141.028589 support.fr@asg.com
German 49.89.45716.200 49.89.45716.400 support.de@asg.com
Italian 39.0290450025 support.it@asg.com
Dutch 31.30.241.6133 support.nl @asg.com
Spanish 34.913.523.800 34.917.156.961 support.es@asg.com
South Africa 800.201.423 support.sa@asg.com
Asia Pacific (APAC)

Phone Fax E-mail
Central Support 61.3.9645.8500 61.3.9645.8077 support.au@asg.com
Australia 800.637.947 61.3.9645.8077 support.au@asg.com
Hong Kong 800.96.2800 support.hk@asg.com
Japan 81.3.5326.3684 81.3.5326.3001 support.au@asg.com
Singapore 65.224.3080 65.224.8516 support.sg@asg.com
All Other Countries (Also for any non-working numbers)

Phone Fax E-mail
All other countries  1.239.435.2201 support@asg.com

If you receive a voice mail message, follow the instructions to report a production-down
or critical problem. Leave a detailed message including your name and phone number.
An ASG Customer Support representative will be paged and will return your call as soon
as possible. Please have available the information described previously when the ASG
Customer Support representative contacts you.
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ASG Documentation/Product Enhancements

XX

Submit all product and documentation suggestions to ASG’ s product management team
at http://www.asg.com/asp/email productsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at
(239) 263-3692. Please include your name, company, work phone, e-mail ID, and the
name of the ASG product you are using. For documentation suggestions include the
publication number located on the publication’ s front cover.


http://www.asg.com/asp/emailproductsuggestions.asp

1 Introduction

This chapter provides an introduction to SmartTest-CICS and contains these

sections:
ASG Service Pack 1
Overview 1
SmartTest Features 2

Note:

ASG-Center installation and customization must be performed before customizing
SmartTest. If Center has not been installed, see the ASG-Center Installation Guide.

ASG Service Pack

Verify whether you received an ASG Service Pack for this product. If so, read the
instructions for installing the Service Pack before proceeding with the product
installation. The installation instructions are located in atext file on the distribution
media included with the Service Pack. If you have any problems with the Service Pack,
contact ASG Customer Support.

Overview

SmartTest is the Testing/Debugging component of ESW for COBOL, PL/I, Assembler,
and APS programs in the TSO, MV S Batch, CICS (including file services), and IMS
environments. SmartTest features include program analysis commands, execution
contral, intelligent breakpoints, test coverage, pseudo code with COBOL source update,
batch connect, disassembled object code support, and full-screen memory display.
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SmartTest provides a comprehensive testing and debugging tool that brings intelligence
to testing. Knowledge of the program (syntax, logic relationships, and execution flows) is
the foundation for providing a broad array of testing/debugging utilities.

SmartTest Features

SmartTest executesin the CICS, IMS/DC, and TSO/ISPF environments and providesfull
| SPF compatibility, which facilitates learning and usage through a standard IBM
interface. It is an electronic window through which COBOL, PL/I, and Assembler
programs are viewed, analyzed, tested, and debugged.

SmartTest provides these comprehensive testing and debugging features and functions:

Comprehensive Program
Knowledge

Provides the testing environment with complete knowledge
about the program, including syntax, logic relationships, and
execution flow. This knowledge is stored in the AKR.

Reduction of Setup
Barriers

Eliminates test session setups and TSO resource
consumption via a batch connection facility. Conversion
utilities reduce the time spent setting up TSO/I SPF.

StorageProtection- CICS
only

Eliminates amajor deficiency of CICS, whichisits lack of
storage protection. Without SmartTest, atransaction can
corrupt the storage of other programs or CICS management
modules and storage, which can result in a system crash.

COBOL and PL/I
Intelligence

Supports COBOL -compatible pseudo code that can be
temporarily added to a program, saved permanently in the
AKR, or automatically added to the existing program.
Dynamic Breakpoints can be set based on COBOL or PL/I
syntax statements or conditions.

Script Automation

Provides a predefined command sequence that can be
included in any test session. These script files can be created
automatically during atest session, then used for regression
testing of a program.

Scrollable Window
Displays

Provides easy accessto related information using in-context
windows for data display and logic.

Memory Facilities

Provides memory identification, display, and update
facilities.
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Feature Description

Hot Key Branching Provides easy access to related logic between paragraphs,
sections, and CALLed routines.

Assembler Integration Provides full-screen Assembler integration of programs,
CALLed modules, or memory display of data elements.

Integrated Program Provides access to program analysis functions for viewing

Analysis logic/data rel ationships, execution paths, etc., through the
AKR.

Center Integration Supports the automation of the software maintenance cycle.
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Installing and Customizing SmartTest

This chapter describes the installation and customization steps for SmartTest and

contains these sections:

Prerequisite [§]

Installation Requirements and Considerations 6

Installation Checklist 8

Step 1 - Modifying and Executing CNTL Library Members 9

Step 2 - Modifying Installed CLIST Libraries 13
Step 3 - Adding SmartTest Modules to ML PA/PLPA 15
Step 4 - Preparing | SPF to Invoke SmartTest 16
Step 5 - Validating SmartTest (SmartTest-TSO Only) 17
Step 6 - Reviewing User Tables and Exits (SmartTest-TSO Only) 22
Step 7 - Testing | SPF Dialog Manager (SmartTest-TSO Only) 22
Step 8 - Testing Authorized Programs (SmartTest-TSO Only) 22
Step 9 - Validating IDM S Support by Analyzing an IDMS Program 22
Step 10 - Validating DB2 Support by Analyzing a DB2 Program 23
Step 11 - Validating Update Facility (SmartTest-TSO Only) 24
Step 12 - Operational Considerations (SmartTest-TSO Only) 25

(&)
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Prerequisite

Center installation and customization must be performed before customizing SmartTest.
If Center has not been installed, see the ASG-Center Installation Guide.

Installation Requirements and Considerations

Operating Environment
SmartTest has these requirements:
- MV S/ESA or OS/390
e TSOISPF Version 3.5 through 4.8
e« CICSVeson4.lor CICS/TS1.1,1.2, 1.3, and 2.1 (SmartTest-CICS only)
- IMSVersion5.1,6.1,0r 7.1
< VSAM for the AKR
=  TSOlogon region size of 2048K or larger
- Direct access storage

Note:
See the ASG-Center Installation Guide for quantities.

=  3270typeterminas, Models 2, 3,4, or 5
- INTERSOLYV, Inc.'s APS version 2.1 or later - for SmartTest-APS only

Supported Environments

SmartTest supports these environments:
- Languages
= COBOL Il (including releases 3 and 4)
- COBOL/370
- COBOL for MVSand VM
< COBOL for OS/390 and VM
- Enterprise COBOL Release 3.1
- CASE-generated COBOL
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- High-level Assembler through a.3.0
e« OSPL/I Version2.3
e PL/IforMVS& VM

Environments

« TSO
- BTS
- DLI

- CICSVersion4.1
- CICS Transaction Server 1.1, 1.2, 1.3, and 2.1

<  CICS command-level programs

- IMSDC

- | SPF Dialog Manager

- HOGAN

<  LANGUAGE environment
Databases

- VSAM

- IMS/DB (DL/1)

- DB2

- IDMS/DB

-  SYSTEM 2000
- DATACOM/DB
< TOTAL/TIS

-  CA-Optimizer Il (COBOL II)
- INTERSOLV APS

< JCL to CLIST conversion

e JCL PROC expansion

< COBOL syntax checking

- Batch system connection facility
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Installation Checklist

These are the installation stepsin this chapter:
Step Description

1 "Step 1 - Modifying and Executing CNTL Library Members' on page 9 to
customize them for your environment.

Modify the SmartTest Default Installation Option parameter file located in
ASG.VIACENXX.CNTL as member VIASPRMP.

2 "Step 2 - Maodifying Installed CLIST Libraries' on page 13.

4 "Step 3 - Adding SmartTest Modulesto MLPA/PLPA" on page 15.

5 "Step 4 - Preparing | SPF to Invoke SmartTest" on page 16.

6 "Step 5 - Validating SmartTest (SmartTest-TSO Only)" on page 17.

7 "Step 6 - Reviewing User Tables and Exits (SmartTest-TSO Only)" on

page 22. See Appendix C, "SmartTest User Tables and Exits," on page 135
for more information.

8 "Step 7 - Testing | SPF Dialog Manager (SmartTest-TSO Only)" on
page 22.

9 "Step 8 - Testing Authorized Programs (SmartTest-TSO Only)" on page 22.

10 "Step 9 - Vdlidating IDMS Support by Analyzing an IDMS Program” on
page 22.

11 "Step 10 - Validating DB2 Support by Analyzing aDB2 Program'” on
page 23.

12 "Step 11 - Validating Update Facility (SmartTest-TSO Only)" on page 24.

13 "Step 12 - Operationa Considerations (SmartTest-TSO Only)" on page 25.

If you areinstalling SmartTest for CICS, IMS/DC terminal emulation, Assembler, APS,
PL/1, or DB2 Stored Procedures, you are ready to perform the customization and
validation steps for those environments.



2 Installing and Customizing SmartTest

Step 1 - Modifying and Executing CNTL Library Members

Modifying JCL Parameters for Installation Members

Inthe CNTL library members described in this chapter, you will need to specify the
correct values for these parameters:

VIASOFT Specifies the high-level node where the ESW products are installed.

CENTER Specifies the second-level node where ESW products are installed.
If the ESW dataset names contain more than three nodes, then
specify all nodes except the first and the last as CENTER. For
example, the dataset name of SY S3.CENxX.NEW.LOADLIB
should have VIASOFT=SY S3 and CENTER=CENXX.NEW.

SYSOUT Specifies the correct SY SOUT character.

SYSDA Specifies the appropriate UNIT for temporary datasets.
COMPILR Specifies the COBOL compiler load module name.
COBLIB Specifies the COBOL compiler run time subroutines.
COBCOMP Specifies the COBOL compiler load library name.
USERLIB Specifies the user load library.

Allocating the SmartTest Batch Submit Queue File

VIASBDAM isthe JCL to allocate and format the batch execution queuefile,
VIAQUEUE. The name of the queue must match the name specified in the SMARTEST
CLIST. Because VIASBDAM is used as input and output for SmartTest users, special
consideration should be given when defining security for this dataset.

Note:
Update authority is required for the queuefile.

To allocate the batch submit queuefile
1 Review VIASBDAM and make the necessary modifications.

2 Submit thejob.
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Optional CNTL Members

Modify these CNTL library members, even though they are not executed during the
installation process:

VIALAB SmartTest VIAMAIN demonstration program execution JCL..

VIAMEJCL  SmartTest VIAMERGE demonstration program execution JCL.

VIAPASMA  JCL to assemble and link the VIAPASM demonstration program.

VIAPASMJ  SmartTest VIAPASM demonstration program execution JCL.

VIAPCII COBOL 11 or later compile procedure. Copy this PROC to a user
PROCLIB or embed it in compile JCL members.

VIAPCOBC  JCL to compile and link the VIAPCOB demonstration program.

VIAPCOBJ  JCL to execute the VIAPCOB demonstration program.

VIAPDLGC  JCL to compile and link the VIAPDLGM demonstration program.

VIAPEXIT JCL to assemble and link-edit the SmartTest user exits and tables.

VIAPPLIC JCL to compile and link the VIAPPLI demonstration program.

VIAPPLVC  JCL toinvoketheVisual Ageor Enterprise PL/I compiler to compilethe
SmartTest PL/I VP programs.

VIAPPLIJ JCL to execute the VIAPPLI demonstration program.

Note:

Appendix F, "SmartTest CNTL and CLIST Members," on page 153 contains a complete
list of all SmartTest CNTL members and their descriptions.

10
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2 Installing and Customizing SmartTest

To override the default SmartTest installation options

Edit the ASG.VIACENXxX.CNTL member VIA$PRMP and modify the appropriate
options, which are shown in this example:

ASMH-Deck=YES
ASMH-Object=NO
*

; Default=YES
; Default=NO

DB2-Procedure-Plan=VIAPPLAN ; Default=VIAPPLAN
*

Batch-Connect-JCL-STEPLIB= ; No Default
Analyze-Force-NOOPT=NO ; Default=NO

*

Reserved- IMS-Message-Classes=(254, 255) ;Default=(254,255)
* IMS Time Stamp Representation U=UTC L=LOCAL

IMS-TSR=L
ZCAPABLE=NO

; Default=L
; Default=NO

This table contains a description of the SmartTest installation options:

ASMH-Deck Specifies the default value of the DECK option for
Anayze Assembler H (IEV90) support. This should
duplicate the value in the actual Assembler H
installation for your shop. The default is YES.

ASMH-Object Specifies the default value of the OBJECT option for

Anayze Assembler H (IEV90) support. This should
duplicate the value in the actual Assembler H
installation for your shop. The default is NO.

DB2-Procedure-Plan

Specifies the DB2 plan name to be used by the
SmartTest-DB2-SP option to access

SY SIBM.SY SPROCEDURES Table definitions.
This must be the same name as that specified for the
PLAN parameter of the VIAPBIND step during
SmartTest customization. The default is VIAPPLAN.

11
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Batch-Connect-JCL-STEPLIB

Specifies the name of an alternate load library to be
used on the STEPLIB DD for the batch connect JCL.
This parameter is useful when you are using DFSM S
Extended Alias support.

Note:
Ensure that the VIAPPRBE monitor program resides
in the alternate load library. If it does not, the Batch
connect job will fail.

Analyze-Force-NOOPT

Forces the NOOPT compiler option during an
analyze, which enables sites with a default compiler
option of OPT(FULL) to overrideit without having to
manually edit analyze or compile JCL. The defaultis
NO.

Reserved-IM S-Message-Classes

Specifies the IMS message classes reserved for
SmartTest-IM S testing. The default valueis
(254,255).

IMS-TSR

Specifies the time stamp extension to the I/0O PCB.
The control region parameter, TSR=(U/L), specified
in DFSPBxxx PROCLIB member, controls the
representation of the time stamp with respect to local
time versus Coordinated Universal Time (UTC). The
default valueisL.

ZCAPABLE

Specifies whether 64-bit addressing support is
enabled. If ZCAPABLE=YES, SmartTest loads the
modules necessary to support 64-bit addressing. If
ZCAPABLE=NO, SmartTest runs normally unless
the program being tested contains instructions
specific to z/Architecture. The default is NO.

Note:

See the installation option parameters in the ASG-Center Installation Guide for
information on changing the installation parameters values.

Procedure Library Allocation

SmartTest uses the same procedure libraries as the other ESW products. Procedure
libraries that you list on the Procedure Libraries pop-up (see the applicable SmartTest
user guide for your installation for more information about this pop-up) are searched
before those located through the JESPROC or PROCLIBs entry in VIA$SPRMS.

12
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If you do not want to append the default libraries, change the value to NO on this
parameter in the VIA$SPRMP CNTL member:

SmartTest-Append-Proclibs=NO

ISPF Library Allocation

SmartTest allocates the default | SPF libraries to be used for the | SPF test. Y ou can
specify user-defined libraries on the | SPF Panel/Link Libraries pop-up or the ISPF
Table/Message/Skeleton Libraries pop-up. If you do not specify libraries on these
pop-ups, only the libraries alocated to ISPPLIB and ISPLLIB (Panel and Link libraries)
orto ISPTLIB, ISPMLIB, and ISPSLIB (Table, Message, and Skeleton libraries) are

used.

If you do not want to append the default libraries, change the value to NO on this
parameter in the VIA$SPRMP CNTL member:

SmartTest-Append-ISPLIBS=NO

Step 2 - Modifying Installed CLIST Libraries

If you plan to use SmartTest to test BTS, IMS, or ISPF dialogs, review these CL1STs and
ensure that the listed libraries and work datasets are valid for your site. If you do not plan
to use SmartTest to test BTS, IMS, or | SPF dialogs, you can skip this step.

VIAPUBTS Restores BTS system variables and parameters to the site defaults.
Default dataset names are provided and should be modified to use site
standards, which can be found in existing BTS test JCL or CLISTSs.
These items have been provided with standard IBM installation

defaults:
BTSLOADLIB
BTS FORMAT
QIOPCB
QALTPCB
QALTRAN
BTSOUT
BTSPUNCH
BTSDEBUG
BTSSNAP

'‘BTS.BTSLIB'
MS.FORMAT
TEMPORARY DATASET
TEMPORARY DATASET
TEMPORARY DATASET
TERM

None

None

None

13
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Member Purpose

VIAPUIMS  Restores IMS system variables and parameters to the site defaults.
Default dataset names and parametersfor DLI and BMP are provided and
should be modified to use site standards, which can be found in existing
IMStest JCL or CLISTs. These items have been provided with standard
IBM installation defaults:

IMSRESLIB
IMSPROCLIB
DFSVSAMP
DB2 LOADLIB
IMSMON
IEFRDER
IMSPSB LIB
IMSDBD LIB
IMSACB LIB
DLI PARMS

BUF
SPIE
TEST
EXCPVR
RST
SRCH
MON
SWAP
IRLM
BKO
BMP PARMS
OPT
SPIE
TEST
DIRCA
CPUTIME

IMS.RESLIB'
'IMS.PROCLIB'
'IMS.PROCLIB(DFSVSMDB)'
'DSN220.DSNLOAD!

None

TEMPORARY DATASET
None

None

None

220 Z000000

o oz
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VIAPUSPF Restores | SPF dialog system variables to the site standards.
ISPF PROGRAM LOAD LIBRARY 'ISP.SISPLOAD'(REQUIRED)

ISPF PANEL LIBRARY None (see Note below)
ISPF LINK LIBRARY None (see Note below)
ISPF TABLE LIBRARY None (see Note below)
ISPF MESSAGE LIBRARY None (see Note below)
ISPF SKELETON LIBRARY None (see Note below)
ISPF LIST DATASET SYSOUT

ISPF LOG DATASET SYSOUT

Note:

For those default libraries listed as None, your existing | SPF libraries are used if they are
not supplied. Appendix F, "SmartTest CNTL and CLIST Members," on page 153
contains acomplete list of all SmartTest CLIST members and their descriptions.

Step 3 - Adding SmartTest Modules to MLPA/PLPA

These SmartTest load modules are re-entrant and can be linked:

VIAPEMRP VIAPOCRP VIAPPGMP VIAPRESP
VIAPESUP VIAPODBP VIAPPRBE
VIAPFSPP VIAPPCPP VIAPPVRP

Use this statement to add load modules to MLPA/PLPA:
AMODE(31) ,RMODE (ANY)

For the names of other modules that are eligible for location in the MLPA or PLPA, see
the installation guide(s) for any other ESW product(s) you have installed.

These are some of the advantages of locating these modulesin the MLPA or PLPA:
< A reduction of the memory requirement per user.
= Anoveral decreasein required swap space.

- Performance improvements.

15
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Moving these modules to MLPA/PLPA is optional. ASG recommends that the original
ESW load library (from the installation tape) be kept as a staging library so that any
required PTFs can be easily applied. The re-entrant modules can be copied to LPA and
the non-reentrant modules copied to a separate user library. These steps also require
changes to user logons or product allocations. The CNTL library contains two members,
VIASLPAJand VIASLPXJ, which you can use to perform these copy steps.

Note:
Do not use the ISPF 3.3 copy feature to copy these modul es because some of them have
aiases.

Step 4 - Preparing ISPF to Invoke SmartTest

16

Note:
Skip this step if the ESW product menu has already been installed.

Use this panel definition card to add a SmartTest option to the | SPF Primary Menu or
another dialog menu. This line describes the SmartTest option to the user:

%S + ASG-SmartTest - ASG Integrated Testing/Debugging System
Use this statement to invoke SmartTest based on the user selection of the letter S:
S, "CMD(%SMARTEST) NEWAPPL(VIAP)*®

Note:

After updating the | SPF environment, it might be necessary to re-enter | SPF before the
facilities are available.

To invoke SmartTest with a CLIST, follow this step:

» TypeTSO VIATEST onthecommand lineinthe ESW primary panel. The VIATEST
CLIST invokesthe SMARTEST CLIST while specifying the NEWAPPL (VIAP)
parameter to set the correct application ID.
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To invoke SmartTest as a command

Note:

Completethis step if you are using SmartTest to debug DB2 programs and you received
error message ASG2367 when starting a SmartTest-DB2 session.

1 Editthe VIASGBL CLIST member. Seethe ASG-Center Installation Guidefor more
information about editing VIASGBL.

2  Changethe value from NO to YES in this statement:
SET &STCMD = NO /*INVOKE ASG-SMARTTEST AS COMMAND?
Caution! Thischange disables SmartEdit access from SmartTest. If you areina

SmartTest session creating pseudo code and try to access SmartEdit, you
receive the message ASGO999E INTERNAL ERROR IN REENEDIT.

Step 5 - Validating SmartTest (SmartTest-TSO Only)

Note:

The dataset namesin the validation steps are the default installed names. If you have
changed them, use the changed names where the default names are specified.

To test the logon library allocations
1  Start SmartTest by selecting the correct option for your site.

If you installed SmartTest as described in "Step 4 - Preparing | SPF to Invoke
SmartTest" on page 16, use the appropriate | SPF menu selection or CLIST to start
SmartTest. If you installed the ESW product menu as described in the ASG-Center
Installation Guide, use the appropriate | SPF menu selection or the CLIST to display
the ESW product primary screen. Select Test » Module/Transaction to display the
SmartTest primary screen.

If you start SmartTest using the ESW primary screen, the product name displays as
ESW - Testing/Debugging.

2  Select Help » About to verify the product releases and levels of SmartTest and
Center that are installed. The product names, rel ease numbers, maintenance levels,
and the operating system display.

Press PF3/PF15 to return to the SmartTest primary screen.

3 Review and/or modify SmartTest options by selecting Options on the action bar.

17
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a  Select Options » Product Parameters. The Options - Product Parameters
pop-up displays. Review and/or modify parameter definitions and then press
PF3/PF15.

b  Select Options» Log/list/punch. The Options - Log/List/Punch Definition
pop-up displays. Review and/or modify the log, list, and punch file defaults.

c  Enter thejob statement information and press PF3/PF15.
This step is recommended before proceeding to ensure valid options for your user

ID. Seethe online help or the ASG-SmartTest Reference Guide for more information
about using these options.

To allocate an AKR

Note:

If you aready created an AKR when validating another ESW product, skip this
procedure.

Select File » AKR utility. The File - AKR Utility pop-up displays.

Complete the File - AKR Utility pop-up by entering the name of a AKR to be
alocated. Type A in the command input area and press Enter.

Thefieldson the File - AKR Allocate/Expand pop-up vary depending on the values
for the AKR-DSORG-V SAM and SM S parametersin the Center installation options
file.
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3 OntheFile- AKR Allocate/Expand pop-up (shown in Figure 6), verify the AKR
name.

Figure 6« File-AKR Allocate/Expand Pop-up

File - AKR Allocate~<EXpand
CoHHand ===k

% - BubHit TJCL E - Edit TCL G - Bpecify Catalog
Expand edisting AKR . . . HO [¥es or Mol
AKR data =zet naMe . . . . 'USER1Z.GENERAL.AKR'
L T T T S,
Unit o w w w0 0 ono 12 [Generic unit nane]
Zpace units . . . . . . RECORDE [Records, Tracks o Culinders)
PRiHary Space . . . . . LT [Pridary amount in above units)
fecondary Space . . . . B [#econdary aWount in aboue units)

Job statedent information:
<#USER1Z_ TOE [DEUTHE,253200],

0 HEGCLAZE=A
< INZERT '~#ROUTE PRINT MODE.UZER' HERE IF NEEDED.
sk

a  Typethe SMSclassesor the Volume and space information for the permanent
AKR.

b  Typethe appropriate Unique parameter for the selected volume if you are
alocating aVSAM AKR.

c If this dataset must be cataloged in auser catal og, type C on the command line
to display the AKR Catalog Information pop-up. Enter the Catalog DSN and
Password as required and press PF3/14 to return to the File - AKR
Allocate/Expand pop-up.

d Typethejob statement information for your site and submit the job by typing
S in the command input area.

e  Wait for thejob to finish and verify that the AKR was successfully allocated
and initialized.

f Press PF3/PF15 to exit.

19
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To compile and analyze the demonstration programs

1

2

Select File » Compile/Analyze. Type the appropriate information on the
File - Analyze Submit pop-up shown in Figure 7.

Figure 7« File- Analyze Submit Pop-up

File — Analyze IubMit
CoHHand ===

E - Edit JCL 2 - Eubnit TCL

CoHpile and link JCL [PDE oF sequentiall:
Data set nane 'ASG.UIACENSM.CHNTLI{VIAHECII)

Analyze features [T-M]:
AEG-EHartTests ¥ Extended Analysiss 1

AKR data zet nane 'VIAL23,GENERAL.AKR’

AER prograd nade [if overriding PROGRAR-IO]

Analyze options:

CoHpile? [¥«<H] « « o« @ & o & o T [7¥ if needad by features)
Link l1oad Hodule reusable® (v-M] T

d

The name of the dataset that contains the compile and link JCL should be
ASG.VIACENXX.CNTL(VIAMECII). Set the ASG-SmartTest fieldto Y.

Enter the dataset name of the AKR you created.

Set the Compile and Link load module reusable fieldsto Y. Verify the JOB
card and routing information by typing E in the command input area and
pressing Enter. Check the Job information and type SUB in the command input
area to submit the analyze job. Press PF3/PF15 to exit.

Verify that the analyze job completed successfully.

Prepare program VIAMAIN, whichisusedin thetraining classesand also to validate
the UPDATE facility.

a

Type E in the command input area and press Enter. Change the JCL
MEMBER=name on the VIASUB step from VIASUB to VIAMAIN, delete
the VIAMERGE step and submit the new analyze job by typing SUB in the
command input area. Press PF3 to exit.

Verify that the analyze job completed successfully.
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Set up the VIAM ERGE demonstration program by typing ENV (the abbreviation for
the ENVIRONMENT command) in the command input area and pressing Enter.
This displays the Environment Selection Menu.

a Verify the AKR and load library names shown.

b  Toselect the TSO execution environment, type 1 in the command input area
and press Enter. The TSO Session Setup screen displays.

¢ OntheTSO Session Setup screen, specify the load module VIAMERGE. The
Break on Entry field should have avalue of YES.

d Toview the Convert Batch JCL screen, type C in the command input area and
press Enter.

e  Onthe Convert Batch JCL screen, specify the default JCL library setup when
the libraries were loaded from the installation tape and the member name
VIAMEJCL.

Enter your CLIST dataset name for the File Allocation CLIST. Type C in the
command input area and press Enter to generate a CLIST from the JCL. A
short message displays that indicates a successful JCL conversion.

Press PF3/PF15 to return to the TSO Session Setup screen.

To test the VIAMERGE program

1

Press PF4/PF16 (RUN) to start the test and display the Program View screen.

The status box displays at the bottom of the screen. This box showsaBREAK AT
START OF TEST SESSION status message. The current statement lineis
highlighted and contains chevrons (>>>>>>) in the line prefix area.

Press PF4/PF16 (RUN) again. A system OC7 error should occur onthe ADD 1 TO
END-FILE-COUNT statement. A window is automatically displayed noting that
END-FILE-COUNT containsinvalid data.

Replace the invalid data message with a zero and press the Erase EOF key to clear
the rest of the field. Then, press PF4/PF16 once again to resume the test.

The test should now be complete and the status box should display aBREAK AT
END OF TEST SESSION status. Press PF4/PF16 again to clear the status box from
this test session.

If you do not trap the 0C7, check your compiler options. Make sureyou areincluding
the NUMPROC(PFD) option.

Type =X in the command input area to exit SmartTest.

21
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Step 6 - Reviewing User Tables and Exits (SmartTest-TSO Only)

To complete the SmartTest installation, it might be necessary to modify user tables and
exits, such as the Step Exclusion Table, the Module Exclusion Table, Backtrack Control
Table, or the Batch Submit Exit. Review Appendix C, "SmartTest User Tables and
Exits," on page 135 for information about modifying these tables and exits.

Step 7 - Testing ISPF Dialog Manager (SmartTest-TSO Only)

To test ISPF Dialog Manager programs, copy VPPISPFT to a user-accessible panel
library (DDNAME=ISPPLIB).

Step 8 - Testing Authorized Programs (SmartTest-TSO Only)

SmartTest supports testing of authorized programs. However, because of the security
issues involved, SmartTest's main load module is distributed non-authorized. If your site
requires authorized program testing, ASG recommends creating a separate, secure load
library, then relinking VIAPPRBE authorized.

Note:
VIAPPRBE must not be link authorized if it isto be copied into the MLPA/PLPA.

Step 9 - Validating IDMS Support by Analyzing an IDMS

Program

22

Note:
If your site has tests that involve both IDMS and DB2, execute the VIAPEMOX member
from the ESW CNTL library. This addresses IDM S U4005 abends, which can occur
during execution.

To validate I DM S support
1  Select File» Anayze/Analyze. The Analyze Submit pop-up displays.

2  Typethe dataset name for the compile and link JCL for the IDMS program to be
analyzed.

3  Typethe AKR dataset name.
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4  Setthe SmartTest analyzeflagto Y.
5  TypeS inthe command input area and press Enter to submit the analyze job.

6  Verify that the analyze job ran successfully.

Step 10 - Validating DB2 Support by Analyzing a DB2 Program

Note:
If you have DB2, verify that ASG.VIACENXX.CNTL(VIASBIND) has been run (see
"Step 1 - Madifying and Executing CNTL Library Members' on page 9). This
installation step isrequired for sites having DB2. Failure to complete the DB2 installation
step results in erroneous behavior by ESW products.

To validate DB2 support
1  Select File» Compile/Analyze. The Analyze Submit pop-up displays.

2 Enter the dataset name for the compile and link JCL for the DB2 program to be
analyzed.

3  Enter the AKR dataset name.
4  Setthe SmartTest analyzeflagto Y.
5  TypeS inthe command input area and press Enter to submit the analyze job.

6  Verify that the analyze job ran successfully.
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Step 11 - Validating Update Facility (SmartTest-TSO Only)
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If you completed the SmartTest validation, use this AKR member to verify the Update

facility:

VIAMAIN (for TSO)

To validate the Update Facility

1

Save pseudo code linesin the VIAMAIN demonstration program:

a

On the primary screen, type TEST in the command input area and press Enter
to display the Test Menu.

Ensure the PROGRAM/CSECT field or the AKR MEMBER field contains
VIAMAIN. Also, ensure the AKR nameis correct on your Environment
screen.

Type VIEW in the command input area and press Enter to select the Program
View screen. The VIAMAIN COBOL program displays.

Scroll or use the ISPF FIND command to locate the WORKING STORAGE
section of the program and insert anew line immediately after the line
containing 77 PCTR PIC 99 COMP. This should be the new line:

77 NEW-PCTR PIC 99 COMP.

Scroll or usethe I SPF FIND command to locate the program label PO00-END.
After thislabel, insert anew line:

MOVE ZEROES TO NEW-PCTR.

Type SAVE PSEUDO in the command input area and press Enter to save the
new pseudo code lines for VIAMAIN inthe AKR.

Type QUALIFY CANCEL and press Enter to release control of the AKR.

Type RETURN in the command input area and press Enter to return to the
Primary screen.

Type U in the command input area and press Enter to proceed to the Update
facility.
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2 UsetheUpdatefacility to automatically update the VIAMAIN COBOL source code
with the pseudo code lines from the VIAMAIN AKR member.

a  PressEnter to display the Edit Entry panel and type this dataset name and
member in the Data Set Name field:

"ASG.VIACENXX.CNTL(VIAMAIN) "
where xXx isthe Center version number. Press Enter to make the VIAMAIN
COBOL source available for editing.

b TypeUPDATE ALL inthecommand input areaand press Enter to display the
Pseudo Code Update screen.

c Ensurethe AKR nameis correct, specify VIAMAIN asthe program name, and
press Enter. This automatically adds the pseudo code lines to the VIAMAIN
source code and displays amessageindicating the number of pseudo codelines
inserted.

d Verify the proper placement of the inserted lines. This validates the Update
Facility.

To restorethe VIAMAIN sourcetoits original state
1  Type CANCEL inthe command input area and press Enter.

Note:
Typing SAVE permanently altersthe VIAMAIN source.

2 Type=Xinthe command input areato exit the SmartTest Update Facility.

Step 12 - Operational Considerations (SmartTest-TSO Only)

Batch Session Testing

A SmartTest batch session simulates the SMF Job Wait Time. If thistime is exceeded, a
user abend (UQ978) isissued.

Using the CANCEL command to terminate a Smart Test batch session resultsin aUser

222 abend code. This simulates the operator's cancel command, and permits subsequent
steps to execute, or be flushed, depending on the JCL COND= parameters.
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3 Customizing CICS

This chapter describes how to customize SmartTest-CICS and contains these

sections:
Prerequisites 27
Installation Requirements and Considerations 28
Installation I nstructions 41
Note:

If you are afirst time user, read "I nstallation Requirements and Considerations' on page 6
before you begin to install and customize SmartTest-CICS. If Center has not been
installed, see the ASG-Center Installation Guide.

Prerequisites
Before beginning SmartTest-CICS customization, ensure that these prerequisites have
been met:
=  The SmartTest-CICS option has been downloaded from the product tape.
=  Center and SmartTest product installation and customization are completed.
- For CICS/TS, you must have the Optional Source and DSECT libraries. To
assemble the SmartTest installation table, you typically need:

Optional Source  DFHOPTO01 and DFHOPT02
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These are the members required from the above libraries:

DFHLDLDA DFHLDLDM DFHMPARS
DFHMSET DFHPGDCD DFHSMMCA
DFHSMMCM DFHTSHD DFHXMIQA
DFHXMIQI DFHXMXND

- For CICS/TS 1.3, these IBM APARs are required: PQ24735 or PQ34321 and
PQ38830.

Installation Requirements and Considerations
This section can help you determine the system requirements for installing and activating
SmartTest-CICS. These are some of the topics included:

< Anoverview of SmartTest under MV S and a description of the communication
reguirements.

=  CICS Signon requirements.

«  CICS security setup.

- Restrictions and performance considerations for SmartTest-CICS.

The steps to perform the SmartTest-CICS installation are described in "Installation
Instructions” on page 41. If you are installing SmartTest-CICS for the first time, please

review theinformation in the rest of this section before proceeding to the installation
instructions.

VTAM Definition Requirements

As part of the installation instructions, you or your VTAM systems programmer will add
VTAM definitions for SmartTest-CICS. These VTAM definitions are used to enable
virtual terminal communication between SmartTest-TSO and SmartTest-CICS.

After installation of SmartTest-CICS, programmers can log on to specified CICS regions
from TSO/ISPF using the SmartTest interface. Requests and responses are transmitted

through the virtual terminal to and from CICS. CICS application maps and other screens
are transmitted through the virtual terminal to the TSO terminal. Input that is destined for
CICSis entered through the TSO terminal and sent through the virtual terminal to CICS.
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Figure 8 showshow MV S, TSO/ISPF, ACF/VTAM, CICS, and SmartTest work together.

Figure8e+ ASG-SmartTest-CICSwith MVS, ACF/VTAM, TSO/ISPF, and CICS

§
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Note:
SmartTest-CICS and SmartTest-TSO do not need to operate in the same VTAM domain.

CICS Terminal Definition Requirements

The virtual terminal support requires compatible terminal definitionsin CICS. You or
your CICS systems programmer can add or change the CICS terminal definitions as
needed during the installation.

Note:
Hard-coded TCTs are no longer supported.

Terminal Autoinstall

Y ou need to determine the appropriate TY PETERM and MODEL definitionsfor defining
SmartTest-CICS terminals. To determine the TY PETERM in use, use the CICS log that
records terminal access (usually CSSL). For each terminal model that is used for
SmartTest-CICS access to CICS, find a representative log entry in the terminal owning
region, and determine the MODEL TERMINAL definitionin use.
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A CSSL log entry for an autoinstalled terminal can have this format:

DFH59351 INSTALL FOR TERMINAL: X214, NETNAME:REMTX214,
MODEL_NAME: LU20

A CEDA EXPAND GROUP(*) TERMINAL (LU20) request for the MODEL_NAME in
the log might show:

OBJECT CHARACTERISTICS

CEDA View
TErminal : LU20
Group : REMTCT1

AUTINSTModel: Only
AUTINSTName: LU20
TERMINAL IDENTIFIERS
TYpeterm : LU2000
Netname : LU2000

Note the TYPETERM in use, and use CEDA to investigate the TY PETERM definitions:

CEDA EXPAND GROUP(*) TYPETERM(LU2000)

After selecting one of the resulting entries for viewing, page down through the display to
locate the DEVICE and IOAREALEN definitions:

DEVice - LUTYPE2
loarealen : 01536, 16384

This TYPETERM definition is adequate for SmartTest-CICS terminals that require
DEVICE (LUTYPE2) and IOAREALEN 01536, 16384. If you cannot |ocate an existing
TYPETERM definition that meets the SmartTest-CI CS requirements, you must create a
new TYPETERM. You can then create individual TERMINAL definitions (one per
VIACVTAM label) specifying the new TYPETERM.

Note:

If the correct DLOGM ODs have been chosen for VIACVTAM, CICS attemptsto find
support for aLUTY PE2 terminal. SmartTest-CICS passes data back and forth between
the CICSregion and TSO in the form of Terminal I/O Areas (TIOAS). The complexity of
the user's request for information from CICS controls how large a given TIOA might be.
SmartTest-CICS cannot function properly if the IOAREALEN istoo small.

Autoinstall Programs
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Your CICS Autoinstall program can implement verification routines or other site-specific
requirements. If your Autoinstall processing verifiesthe NETNAME, ensure that the
SmartTest-CICS virtual terminal VTAM labels are accepted. Autoinstall requirements
might be another reason to make use of the ACBNAME exit, VIACEX04, documented in
Appendix D, "SmartTest-CICS User Exits," on page 141.
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| Defining the Signon/Logoff Process

Y ou must inform SmartTest-CICS how your installation logs onto CICS, so that
SmartTest-CICS does not interfere with normal or installation-specific logon procedures
and screens.

Depending on your installation, entries might be required in the VIACAPPL CNTL
library member. Entries can be required for every region that is to be logged on to
through SmartTest-CICS. To verify if VIACAPPL entries are required, log onto CICS
fromaVTAM screen using the command:

LOGON XXXXXXX
where XXxXxxxX is the character string used for accessing the CICS region.

Make a note of every screen that displays, every transid or keystroke you enter, and all
messages returned to the screen, such as the CICS signon acknowledgement. If your
signon sequence is standard (and it is permissible for users to specify the CICSregion's
actual VTAM APPLID on the SmartTest-CICS Session Setup screen), you might not
need to customize the CNTL library member VIACAPPL.

You can use the default signon settings if your CICS logon procedure consists of these

actions:
- Sending aVTAM logonto aCICSVTAM APPLID that resultsin a Good Morning
screen.

- Clearing your screen and typing some version of CSSN/CESN.
- Entering an 1D and password and receiving a message from CICS (or ACF2)
indicating that signon is complete.

If you do not use any of these logon procedures, you must describe the signon processin
"Step 4 - Specifying Y our CICS Signon/L ogoff" on page 51.

Note:

There are specia requirementsif you have a pseudo-conversational menu that displays at
CICS signon. It might also be necessary to specify the SIGNOFF parameter for each
Terminal Owning Region (TOR) in VIACAPPL. With this parameter, you can tell
SmartTest-CICS to drive a particular transaction at disconnect time. See"Step 4 -
Specifying Y our CICS Signon/L ogoff" on page 51 for more information.
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Security Requirements

If your site implements Command Security or Resource Security in your CICS test
regions, these considerations apply:

= All SmartTest Transaction definitions (other than the demo transactions) must
specify CMDSEC(NO) and RESSEC(NO).

e  Thesystem initiaization parameters CMDSEC and RESSEC must be set to
ALWAYS.

<  SmartTest-CICS uses CICS commands and resources to service the testing of user
application transactions. If your site hasimposed rigid security on your CICS test
regions, it may be necessary for you to create specific rulesto allow SmartTest to
function properly. For example, if you enabled Command Security with the SIT
parameter XCMD, you must specify UPDATE authority for the EXITPROGRAM
resource for all SmartTest users.

- If you should receive a security error message related to SmartTest-CICS
processing, determine the affected resource and the access authority required and
arrange to permit the required accessto all SmartTest users. For example, a RACF
error message relating to insufficient access to the EXITPROGRAM resource
would have these components:

1CH4081 USER(userid ) GROUP(group ) NAME(lastname, firstname)
EX1TPROGRAM CL(CCICSCMD)
INSUFFICIENT ACCESS AUTHORITY
FROM **_* (G)
ACCESS INTENT(UPDATE ) ACCESS ALLOWED(READ )

This message indicates that the user required UPDATE access to resource
EXITPROGAM (whichisincluded in the CCISSCMD class or the related group
class) and that the profile used was **.* (which is ageneric profile).

Temporary Storage Requirements
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SmartTest-CICS creates Temporary Storage queues as part of its processing. If you have
a Temp Storage table defined for your CICSregion, it is necessary to ensure that
SmartTest-CICS queues will not be defined as Remote or Recoverable. SmartTest-CICS
Temp Storage queues begin with the character string VIA and with the character
specified in the SmartTest-CICS Installation table parameter HEXPREF. The default
character isv (lower case).
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CICS and External Security Software

Exclude al load modules that are names of security software from SmartTest-CICS
monitoring. You can exclude these names generically using the TY PEEEXCLUDE
option found in the VIACEMT1 Environment Table. In addition, you should initialize
security software before starting SmartTest-CICS and terminate after SmartTest-CICS.

SmartTest-CICS operates under the security established for the operator and monitored
transaction. SmartTest-CICS does not interfere with preestablished CICS security
Settings.

SmartTest-CICS Internal Security

SmartTest-CICS internal security provides the capability to restrict the use of certain
SmartTest-CICS commands, resources, and features. By default, SmartTest-CICS is
delivered with no restrictions active; all functions are available to everyone. Y ou can
review al protectable options and restrict access by operator id during the installation
process.

The SmartTest-CICS diagnostic transactions VIAL and VIAD are intended for use by
your Systems/Technical staff. Y ou might want to restrict it.

Transaction VIAI isused to start and stop SmartTest-CICS and transaction VIAH isused
to start and stop the Dynamic CALL Support from a native CICS session. Application
programmers normally do not need accessto VIAI because its functions areimplicit in
the first connection from TSO to CICS under SmartTest.

Transactions VIAA, VIAR, and VIAC are interna to SmartTest-CICS. ASG
recommends that you do not restrict these transactions.

If Resource Security Level Checking (RSLC=YES) is specified for transactions running
under SmartTest-CICS and the PPT entry DFHEMTA has Resource Security Level
(RSL) set to zero, some functionality is not available to the SmartTest-CICS users (for
example, NEWCOPY and File Services directories). RSL=PUBLIC is recommended for
the PPT entry DFHEMTA, aswell asfor the ESW programs.

Restrictions

RENTPGM Restrictions

To test programs that are link edited RENT, install the re-entrant program support SVC
(see "Re-entrant Program Support" on page 77). If you do not want to install the
SmartTest re-entrant program support SV C, you must specify the SIT override option
RENTPGM=NOPROTECT. Otherwise, ERDSA errors can prevent testing.
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Data Compression Restrictions

SmartTest-CICS terminals must be excluded from data compression. SmartTest-CICS
control blocks are passed in TIOAs and have positional parameters.

BMC Superoptimiser data compression is handled automatically. As of thiswriting,
BMC's Input Suppression feature is not implemented in such away that it can be
recognized and bypassed. Since it is not possible to exclude SmartTest-CICS terminals
from BMC Input Suppression, the feature must be turned off.

Products such as Pl and McKinney System's Show and Tell can be configured to exclude
SmartTest-CICS terminals from data compression. If UFO's compression exit isin use, it
might be necessary to disable it for SmartTest-CICS. DATAPACKER and
MEGAPACKER also have terminal data compression components. If you use a session
manager with a data compression feature enabled, it might be necessary to log onto TSO
using a session that does not have the data compression feature enabled. You may want to
review an AUXTRACE for any region that SmartTest-CICS will be used in, to
investigate any XZC... exits.

Uppercase Translation User Exits (XZCIN)

If your installation has an exit that provides uppercase tranglation for terminal input, it
must include a check for READ TYPE=TEXT requests and ignore the trandation (as
IBM does) to allow SmartTest-CICS to operate. SmartTest-CICS issues DFHTC READ
TYPE=TEXT requests and expects non-translated inpuit.

Thisisthelogic required to check for READ TEXT requests:

TM TCTTECS,TCTTENTR Q-TERMINAL READ TYPE=TEXT
BO BYPASSUC Y-DON"T TRANSLATE

Terminal Control (XZCATT) Exit VIACZATT
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SmartTest uses the terminal control exit VIACZATT to partially control communication
between TSO and CICS during pseudo-conversational transactions and CRTE
processing. This exit is automatically enabled when one of these occurs:

<  Thefirst user connects from TSO.

<  SmartTest-CICSisinitialized through the PLTPI.

- The VIAI START transaction.

If the TERMINAL definitions used for SmartTest-CICS terminal s specify atransaction

ID, you must either specify SmartTest in the startup PLT or enable the VIACZATT exit
program during PLT processing using the command:

EXEC CICS ENABLE PROGRAM (VIACZATT) EXIT (XZCATT) START
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CSECT Number Limitation

SmartTest-CICS currently supports the first 285 CSECTs of aload module for symbolic
testing. If you want to set breaksin and otherwise closely monitor the 300th CSECT, itis
necessary to relink the load module so that the CSECT is one of the first 285.

ESW Dataset Restrictions

It is recommended that all ESW product |oad modules be kept in one load module
dataset. This procedure simplifiesinstallation and subsequent application of maintenance.

Installations that choose to create separate ESW |oad modul e datasets must make specific
SmartTest-CICS load modules available to SmartTest-TSO and vice versa.

SmartTest-TSO must have access to these SmartTest-CICS specific load modules:

VIACVTAM

VIACEMT1

VIACCPU (if one was created at installation)
SmartTest-CICS requires access to these load modules:

= All modules prefixed with VIAC (with the exception of VIACVTAM and
VIACCPU).

< VIAPBKRP (required for Backtrack Facility).

SmartTest-CICS Temporary Storage Queues
SmartTest-CICS Temporary Storage queues cannot be shared between CICS regions.

Language Optimization Limitations

Note:

See Optimization Limitations in the ASG-SmartTest for COBOL and Assembler User’s
Guide or the ASG-SmartTest PLI User’s Guide.

COBOL Limitations
See"COBOL Compiler Options' on page 129.

CICS/VTAM Connectivity Considerations
These are considerations for CICS/VTAM connectivity:
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Whether you use autoinstall, TCT macros, or CEDA terminal definitions for each
terminal, SmartTest terminal support requires:

DEVICE(LUTYPE2) TRMTYPE=LUTY PE2
IOAREALEN(1536,16384) TIOL=(1536,16384)
USERAREALEN(thelargest of any TCTUAL=(the largest of any transaction
transaction that will be tested) that will be tested)

Otherwise, the definitions should support the same features as your other
LUTYPE2 terminals.

The VIACCPU load module is available to TSO. It accurately reflects the SMF
CPU ID for any CPU with a TSO that will be used to connect to SmartTest-CICS.

ThereisaVIACVTAM member in SYSLVTAMLST (or its equivalent) of every
CPU with a TSO that will be used to connect to SmartTest-CICS. VIACVTAM has
been VARY ed activeto VTAM.

The VIACVTAM definitions for each terminal type use the sasme DLOGMODs
specified for the real terminals that are used to access your CICS regions.

The labels used in the VIACVTAM definitions are acceptable to your autoinstall
program in CICS, or are specified in TCT definitionsin the NETNAME parameter.
The labels can be changed to create better terminal 1Ds, but the ACBNAMESs
should not be changed. If your installation has ACB naming requirements, you
might need to use EX1T4 (see Appendix D, "SmartTest-CICS User Exits' on

page 141).

For an MRO installation, use your standard method of defining local and remote
terminal support for your TORs and AORs.

The terminal support in your CICS region can accept the SmartTest VTAM
NETNAME created on the CPU being used for TSO.

The signon procedure for your CICS region is standard:
— A VTAM logon results in a Good Morning screen.
—  After clearing the screen, type in some version of CSSN/CESN.

— Enter an D and password, and amessageis returned to the screen by CICS (or
ACF2) to indicate that signon is complete.

If this does not accurately describe a signon sequence, you must code TY PE=APPL
entriesin the VIACAPPL installation table. With these entries, you can tell
SmartTest what to expect at signon, so that SmartTest's initialization can proceed
properly. For information on APPL entries, see " Step 4 - Specifying Your CICS
Signon/L ogoff" on page 51. Contact ASG Customer Support if you need assistance
selecting the appropriate parameters.
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The product Command-CICS must be initialized before SmartTest-CICSto avoid storage
violation warning messages during a test session.

Data Space Testing

SmartTest-CICS supports Assembler modules that access ESA data spaces during
testing. If applications are using data spaces, you must add OEQ and 01D to the System
Recovery Table (SRT) to prevent CICS from abending when it encounters a data space
program check that is caught by the CICS ESTAE.

Performance Considerations

SmartTest-CICS has aminimal impact on response time because of these reasons:

Only those programs being monitored incur overhead. (Since SmartTest-CICS
Monitors only the programs you specify, it is best to request monitoring only for the
programs you want to test. If you specify monitoring at the transaction level,
SmartTest monitors every program associated with the transaction.)

Note:

See the ASG-SmartTest CICSUser’ s Guide for more information about how to
specify which programs are to be monitored. Entries made on the Session Setup
screen and on the Test Session Tailoring screen determine what is monitored.

Program code comprises only a small part of the transaction path length. Most task
response timeis actually spent waiting for resources or data transmission;
SmartTest-CICS is not involved in these processes.

Y ou generally do not need to change any parametersin the CICS System Initialization
Table (SIT) to support SmartTest-CICS. However, a high value for the Interval Control
Exit (ICV) time resultsin slow response during periods of light CICS activity.

Also, the Terminal Scan Delay value (ICVTSD) affects response time. A recommended
value for the SIT ICVTSD parameter is 100. It is possible that you will need to increase
your ICVR (Runaway Task Time) value if transactions to be tested are approaching your
current limit without SmartTest-CICS.
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Performance Techniques

These are some techniques for improved performance with long-running transactions:

=  Consider putting the TSO SmartTest modulesin the MLPA/PLPA.

Note:
See the ASG-Center Installation Guide for alist of MLPA/PLPA candidates.

- Monitor only the PPT modules that are to be tested, rather than all modules for the
transaction. (Do not enter the TRAN 1D on the Task Protection screen unless you
really want to monitor everything running under that TRAN-ID.)

- Review the contents of the Global Task and Program Protection tables. Migrate as
many entries as possible to the individual user task and program protection tables.

- If a single module contains multiple CSECTSs, consider excluding some of the
CSECTs.

=  Turning off Storage Protection, Execution Tracking, and Counts provides
significant performance improvement.

- Minimize the number of Breakpoints set to only those required.

Installing SmartTest in Different CICS Releases

The SmartTest-CICS Environment Table option TLCIREL (described on page 63)
controls SmartTest-CICS' ability to simultaneously support multiple releases of CICS.

Region Names and Configurations Used in Installation Examples

For illustrative purposes, these names are used in the installation examples:

CICSTEST CICT Standalone CICS TS 1.3 region

CICSTOR1 TCS1 CICS 4.1 Terminal Owning Region (TOR)
CICSAOR1 ACS1 CICSTS 2.2 Application Owning Region (AOR)
CICSAOR2 ACS2 CICS TS 1.3 Application Owning Region (AOR)
CICSAORS ACS3 A region in which SmartTest-CICSis not installed
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SmartTest-CICS provides user exits. Use of these exitsis optional and most installations
will not need to use them. Y ou should review the descriptions to determine if any of the

User Exits are needed in your site. See Appendix C, "SmartTest User Tables and Exits,"

on page 135 for more information.

Exit # Description

1 Initialization exit used to define global shared storage locations to
SmartTest-CICS.

2 Storage Validation exit for overriding default storage protection rules.

3 Removed as of SmartTest-CICS Version 2.1; it isno longer required.

4 Exit to provide VTAM ACB names to SmartTest-CICS.

5 Removed as of SmartTest-CICS Version 2.1; it is no longer required.

6 Exit to provide logon message datato CICS at SmartTest-CICS connect

ime.

Other Vendor Product Precautions

Co-existence With Other Vendor Products

Thislist of software products should have an entry on the Global Program Specification
screen that specifies MONITOR=NO. SmartTest-CICS automatically adds the entriesin
the VIACTBLSfile. Thisfile includes (at a minimum) these products:

Product Entry

IDMS 41DMS
NATURAL 3NAT
EYEWITNESS 3DAS
UFO 3UFO
DB2 3DSN
TOP SECRET 3TSS
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SmartTest-CICS co-exists with these and many other proprietary vendor software
products. However, products that violate CICS coding standards can cause unpredictable
results during a testing session. ASG makes a reasonabl e attempt to provide support for
such products, but cannot guarantee success.

Co-existence With Other Software Debuggers

If you have another debugging product in the same region with SmartTest-CICS, do not
allow it to monitor SmartTest-CICS programs (all ESW programs start with VIA*). Itis
often best to exclude from the other debugger any events that run on a SmartTest-CICS

terminal. Also, it isimportant that the other debugger is hot set up to monitor any part of
an application that you are testing under SmartTest-CICS.

CA-PANSOPHIC Requirements

If your installation uses PANEXEC in the CICS environment, the PANEXEC
PANEACCS module must be MV S loadable and the SmartTest VIAPEPAN module
must be included in the system link list library or in the CICS STEPLIB.

HOGAN Requirements

For COBOL/370, COBOL |1, and Assembler support:

- If your shop uses HOGAN only for COBOL/370, COBOL Il, and Assembler
modules, excluding the module CICSPEM from monitoring significantly improves
performance. For information about excluding modules, seethe TY PEEEXCLUDE
topicin "Step 6b - Using the Type= Entriesin VIACEMT1" on page 66.

=  Toensurethe best performance when the CICSPEM module is added to the Global
Program Protection table as MONITOR=YES, users who test COBOL Il and/or
Assembler modules should either monitor at the program level or add CICSPEM to
the User Program Protection table as MONITOR=NO.

SmartTest-CICS Abend Codes

These abend codes apply to SmartTest-CICS only. If you receive one of these abends,
contact ASG Customer Support:

VEXE The SmartTest Command Level requester module VIACEXEC has
encountered alogic error. A message that provides basic information about
the request failure may have been written to the CSSL. Thereisaso a
Vacillates temp storage record that can be examined (see Appendix G,
"Problem Determination,” on page 163). Obtain the transaction dump and
contact ASG Customer Support.

VIAl Aninternal error occurred while processing atemporary storage control
record.
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Code Description

VIA2 Aninternal error occurred because SmartTest-CICS could not find the
SmartTest control blocks on the user TCA chain.

VIAS Aninternal error occurred due to unexpected module encountered in the
Return processing logic. Expected DFHEIP module.

VIA4 Aninternal error occurred because SmartTest-ClICS was unable to find
SmartTest control blocks.

VIAS An internal error occurred because the SmartTest-CICS monitor
VIACEMAN is corrupted.

VIA6 An internal error occurred while processing the VIACTBL Sfile. Possible
installation error or storage corruption by another task.

VIA7 Aninternal error occurred while processing a File Utility request.

VIA8 An error occurred because SmartTest modules could not be loaded, or they
are incompatible with the TSO components. Ensure that the module
VIACEMT1 reflects the current release for SmartTest and for the CICS
region in which it is running.

Installation Instructions

This section contains a step-by-step description of the tasks you must complete to install
SmartTest-CICS. If your site does not currently have SmartTest-CICS installed, review
the stepsin New Installation of SmartTest-CICS before you proceed to the individual
steps. If you are currently running SmartTest-CICS, review the summary of steps
described in "Upgrading from a Previous Release of SmartTest-CICS' on page 43, then
complete the steps that correspond to the upgrade process.

New Installation of SmartTest-CICS

If you areinstalling SmartTest-CICS for the first time, or if you areinstallingin a
different release of CICS, perform these steps:

Steps

"Step 1 - Completing the Installation Worksheet" on page 44.

"Step 2 - Installing VTAM Definitions' on page 48.

"Step 3 - Installing CICS Terminal Definitions' on page 51.
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Steps

"Step 4 - Specifying Your CICS Signon/Logoff" on page 51.

"Step 5 - Specifying Security" on page 54.

"Step 6 - Specifying SmartTest-CICS Initialization Options' on page 57.

"Step 7 - Specifying SmartTest-CICS Support for Multiple CICS Releases' on page 67.

"Step 8 - Running VIACASMJ' on page 68.

"Step 9 - Defining the SmartTest-CICS File, Programs, and Transactions' on page 69.

"Step 10 - Linking to VIACTSCL at Disconnect” on page 76.

"Step 11 - Customizing Optional SmartTest-CICS Features' on page 77.

"Step 12 - Validating and Enabling Global Remote Monitoring (Optional)" on page 81

"Step 13 - Specifying MRO Transaction Definitions (Optional)" on page 83.

"Step 14 - Specifying Optional Program List Tables - Initialization and Shutdown" on
page 88.

"Step 15 - Editing your CICS Startup JCL" on page 88.

"Step 16 - Preparing the SmartTest-CICS Demonstration Programs' on page 89.

"Step 17 — Validating SmartTest-CICS Installation through Native CICS' on page 90.

"Step 18 - Validating SmartTest-CICS" on page 94.

Note:

If you use the optional SmartTest-CICS features PL/I, file services, or perform the
necessary customization, the load modulesfor VIACVTAM, VIACEMT1, and the
optional VIACCPU must be available to the TSO connection.
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Upgrading from a Previous Release of SmartTest-CICS

If you have previously installed SmartTest-CICS, perform these tasks for the

corresponding steps..

1 Complete the Installation worksheet, using information from your prior
installation. See "Step 1 - Completing the Installation Worksheet" on page 44.

2 Verify VIACVTAM in SYSLVTAMLST and VIACCPU. See"Step 2 -
Installing VTAM Definitions' on page 48.

3 Copy the existing TY PE=APPL entries from your current VIACAPPL table
into the new VIACAPPL member. See "Step 4 - Specifying Your CICS
Signon/L ogoff" on page 51.

4 Copy the existing TY PE=OPERATOR entries from your current VIACAUTH
member into the new VIACAUTH member. See"Step 5 - Specifying Security"
on page 54.

5 Review the SmartTest-CICS initialization options. See"Step 6 - Specifying
SmartTest-CICS Initialization Options" on page 57.

6 Run the VIACASMJ job. See"Step 8 - Running VIACASMJ' on page 68.

7 Review the SmartTest-CICSfile, programs, and transactions for additional
changes. Remember to add PPT definitions for any VIACEMXxX installation
tables you have created. See "Step 9 - Defining the SmartTest-CICS File,
Programs, and Transactions' on page 69.

8 Addthelink to VIACTSCL to your Autoinstall delete processing program. See
"Step 10 - Linking to VIACTSCL at Disconnect” on page 76.

9 Customize the optional SmartTest-CICS features. See"Step 11 - Customizing
Optional SmartTest-CICS Features' on page 77.

10 Edit your CICS startup JCL.. See"Step 15 - Editing your CICS Startup JCL" on
page 88.

11 Prepare the SmartTest-ClI CS demonstration programs. See" Step 16 - Preparing
the SmartTest-CICS Demonstration Programs” on page 89.

12 Validate the installation through native CICS. See"Step 17 — Validating
SmartTest-CICS Installation through Native CICS' on page 90.

13 Vdidate the install ation through the SmartTest-CICS TSO connection. See

"Step 18 - Validating SmartTest-CICS" on page 94.
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Step Description

14 If you use the optional SmartTest-CICS features PL/I, file services, or
temporary storage cleanup perform the necessary customization.

15 Theload modulesfor VIACVTAM, VIACEMT1, and the optional VIACCPU
must be available to the TSO connection.

Step 1 - Completing the Installation Worksheet

This worksheet describes the parameters and values that are used in the installation
procedures. Determine the appropriate values for your installation and record them for
later reference. Spaceis provided to record different parameter values, if two rel eases of
CICSareinuse.

CICS Information

Parameter
(default) Install Value Description
for CICSrelease for CICSrelease
CICS High-level qualifier for CICSlibraries. (Usedin
cIcS VIACASMJ, VIACIMAP, VIACJASM,
VIACJICII, and VIAC------ )
MACLIB CICS MACLIB name. (Usually SDFHMAC)
MACLIB (Usedin VIACASMJ, VIACIMAP, VIACJASM,
VIACJICII, and VIAC------ )
MTSLIB CICSMTS (Macro Temporary Store) library.
MTS Used in VIACASMJto ensure that the
Installation/Environment table (VIACEMT1 and
VIACEMXxX) and any user exits are assembled
with any CICS SMP maintenance in the APPLY
state, if the CICSregion isrunning withthe MTS.
SRCLIB CICS SOURCE library. (Usually SDFHSRC for
SOURCE CICS 4.1 and DFHOPTOY/DFHOPTO02 for
CICS/TS 1.1 and above.)
(Used in VIACASMJ, because some releases of
CICS have necessary DSECTS in the SOURCE
library.)
CSDLIB CSD library for RDO definitions. (Used in
USERCSD VIACSDJB).
GROUPLST RDO GROUP LIST specified at CICS startup.
GROUPLST
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TERMINAL Definition Values

Used in "Step 3 - Installing CICS Termina Definitions' on page 51 of installation.

Parameter
(default) Install Value Description
for CICSrelease for CICSrelease

MOD2TERM Model TERMINAL definition for
none Model 2 terminals.

MODS3TERM Model TERMINAL definition for
none Model 3 terminals.

MODATERM Model TERMINAL definition for
none Model 4 terminals.

MODS5STERM Model TERMINAL definition for
none Model 5 terminals.

CPUID1 CPU ID 1 (see member SMFPRMxx in SY S1.PARMLIB for field
none name SID). Usedin VIACCPU toidentify the CPU ID for the TSO

from which SmartTest-CICS will connect to CICS.

CPUID2 CPU ID 2 (Used only if there are two CPUsfrom which TSO users
none will be logging on to SmartTest-CICS.

CICSMOD2 Number of model 2 terminals to be used concurrently for
10 SmartTest-CICS processing.

DLOGMOD2 LUTYPE2 SNA DLOGMOD for Model 2 terminal.
D4A 32782

CICSMOD3 Number of model 3 terminals to be used concurrently for
5 SmartTest-CICS processing.

DLOGMOD3 LUTYPE2 SNA DLOGMOD for Model 3 terminal.
D4A32783

CICSMOD4 Number of model 4 terminals to be used concurrently for
10 SmartTest-CICS processing.

DLOGMOD4 LUTYPE2 SNA DLOGMOD for Model 4 terminal.
D4A32784
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Parameter
(default) Install Value Description
CICSMOD5 Number of model 5 terminals to be used concurrently for
5 SmartTest-CICS processing.
DLOGMOD5 LUTYPE2 SNA DLOGMOD for Model 5 terminal.
D4A32785
TYPETERM RDO TYPETERM definition that meets SmartTest requirements.
(See"Step 3 - Installing CICS Terminal Definitions' on
page 51.)
GROUP RDO GROUPinwhich TYPETERM and TERMINAL definitions
are (will be) placed.
TIOAL Terminal 1/0 Area Length (specify the largest used in user

applications).

COBOL COMPILER Information - COBOL Il and Later

Parameter
(default) Install Value Description
for CICSrelease
COBCOMP COBOL Il and later compiler library. Used in VIACJCII to
SYS1.COB2COMP compile COBOL Il demonstration program.
COBLIB COBOL Il and later run-time subroutine library. Used in
SYSL.COB2LIB VIACKCII.
coB2CIC COBOL Il andlater CICSruntimesubroutinelibrary. Usedin
SYSL.COB2CICS VIACKII.
COMPILR COBOL Il and later compiler program name. Used in
VIACJICII.

IGYCRCTL
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Parameter
(default) Install Value Description
for CICSrelease
VIASOFT High-level quaifier(s) for Center permanent libraries
ASG (non-VSAM).
CICSTRN CICS COBOL Command-level interface module name for
DFHECP1$ translator. (Used in Center member VIASPRMS, and in
SmartTest-CICS CNTL library members VIACJASM and
VIACJICII.)
TRNPARM Run-time parameters for the CICS translator program.
none
ASMBLR IBM Assembler to be used (for installation tables and sample
IEV90 Assembler program).
CENTER Second-level qualifier(s) for the Center permanent libraries
VIACENXxX (non-VSAM).
LOADLIB User load library for demonstration programs. (For
demonstration programs, usually the ESW installation
USER.LOADLIB library.)
PERMUNT Disk unit for permanent SmartTest-CICS libraries.
SYSDA
PERMVOL Disk volume for permanent SmartTest-CICS libraries.
none
SYSDA Disk unit for temporary work space.
SYSDA
SYSOUT SYSOUT class.
1%t
TAPE Unit type for tape devices.
TAPE
VSAMVOL Disk volume for SmartTest-CICS VSAM dataset.
VSAMVOL
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Step 2 - Installing VTAM Definitions

The TSO to CICS communication feature requires that VTAM definitions be added. It is
important that you complete these steps correctly. Otherwise, SmartTest-CICS users can
experience difficulties or problems when using SmartTest-CICS virtual terminals.

The CNTL library members used in this step are VIACVTAM, VIACCPU, and
VIACASMJ. VIACEX04 is optional.

Note:

Many of the values you use in this section have related entries on the Installation
Worksheet.

Step 2a - Specifying Your Installation's CPU IDs

Edit the VIACCPU CNTL library member to specify your installation's CPU 1D(s).
VIACCPU is assembled during the installation (" Step 8 - Running VIACASMJ" on
page 68). If you are unable to complete the instructions in VIACCPU, check with your
MV S systems programmer. If this step isincomplete or incorrect, SmartTest-CICS uses
the last character of the SmartTest-TSO user's CPU 1D by default.

Step 2b - Specifying VTAM Definitions

Edit the VIACVTAM CNTL library member to specify SmartTest-CICS virtual
terminalsto VTAM. Each parameter on the VIACVTAM APPL definitionsis defined in
thistable. If you are not sure of the correct VTAM attributes to specify or are unable to
complete the instructions in VIACVTAM, check with your VTAM systems programmer.

IMPORTANT  SmartTest-CICS looks for and uses the queriable virtual terminal definitions before

using the model-specific terminals (MOD 2, MOD 4, etc.). Because the queriable
terminals are used first, the queriable terminal definitionsin the VIACVTAM member
must have a compatible DLOGMODE.

CAUTION

Review the queriable definitionsin the VIACVTAM member to make sure the
DLOGMODES are compatible.

These are samples of queriable definitions that reflect a standard IBM DLOGMODE.
Use these samples only as a guide. The CICS installation systems programmer and the
VTAM systems programmer must review and edit these definitions before use:

VIAQAOO1 APPL ACBNAME=VIAQAOO1,EAS=1,
VIAQAOO2 APPL ACBNAME=VIAQA002,EAS=1,
VIAQAOO3 APPL ACBNAME=VIAQAO03,EAS=1,
VIAQAOO4 APPL ACBNAME=VIAQAO04,EAS=1,
VIAQAOO5 APPL ACBNAME=VIAQAOO05,EAS=1,
VIAQAOO6 APPL ACBNAME=VIAQAO06,EAS=1,

MODETAB=ISTINCLM,
MODETAB=ISTINCLM,
MODETAB=ISTINCLM,
MODETAB=1STINCLM,
MODETAB=1STINCLM,
MODETAB=1STINCLM,

DLOGMOD=D4A32XX3
DLOGMOD=D4A32XX3
DLOGMOD=D4A32XX3
DLOGMOD=D4A32XX3
DLOGMOD=D4A32XX3
DLOGMOD=D4A32XX3
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LABEL

The LABEL of aVTAM APPL definition isthe NETNAME presented to CICS. As
delivered, the LABEL isthe same asthe ACBNAME. The LABELsin the
SmartTest-CICSVIACVTAM should be changed to reflect the terminal requirements of
your installation. (Typicaly, CICS autoinstall uses the last 4 characters of the LABEL,
and not the ACBNAME, to create the terminal 1D.)

To ensure the uniqueness of terminal |Ds when you are using more than one terminal
model, you might define labels of VIA2V 201, VIA2V 202, VIA3V 301, and so on.

APPL

For each terminal model, define enough APPL statements to support the largest number
of concurrent SmartTest-CICS users. Determine, for instance, the number of
SmartTest-CICS users that will be connecting to ANY CICS from amodel 2 terminal.

ACBNAME

The ACBNAME is developed according to this formula:
Positions 1-3  VIA (required).

Position 4 2,3, 4,5, or Q— determined dynamically from the terminal model of
the TSO user.

Position 5 CPU identifier code.

Specify the user-defined substitution character you coded in
VIACCPU. Otherwise, you must specify the last character of the TSO
user's CPU ID.

Positions6-8 A sequential number.

SmartTest-CICS automatically increments this counter as each
additional user connectsto CICS. A request is presented to VTAM for
the ACBNAME developed in this process. Numbering starts at 001 for
each terminal model.

If you have ACBNAME coding standards or conventions, you can use
SmartTest-CICS's EXIT 4 to customize your SmartTest-CICSVTAM environment.
CNTL library member VIACEX04 contains skeleton code for this member, which can
be assembled using CNTL library member VIACASMJ. VIACEX04 islisted in
Appendix D, "SmartTest-CICS User Exits," on page 141.

EAS

Each APPL statement represents one VTAM session. The required EASvalueis 1.

MODETAB

Thedefault MODETAB isISTINCLM, whichisthe IBM-supplied logon modetablefor
MV S. An aternate mode table can be chosen.

Determinethe MODETABsand DLOGMODs currently in use at your site for terminals
(or sessions of a multi-session manager) used for access to CICS. For each terminal
model that is used to access CICS through SmartTest-CICS, select a DLOGMOD that
conforms to the SmartTest-CICS requirements.

SmartTest-CICS virtual terminals must be described as LUTY PE2 SNA, even if the
TSO user is accessing through a non-SNA terminal.
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DLOGMOD

The DLOGMOD parameter specifies the logon mode table entry (contained in
MODETAB) that describes the terminal capabilities needed for the SmartTest-CICS
virtual terminal. The default entriesfoundinthe ISTINCLM MODETAB arecompatible
with SmartTest-CICS requirements. These default entries describe terminals:

3274 MODEL 1A with MODEL x SCREEN (LOCAL SNA) (LUTYPE2)

These MODEENTS (DLOGMOD definitions) in ISTINCLM are compatible with
SmartTest-CICS:

D329001 and EMU3790
D4A3277x, D4A3278x, DAC3277x, DAC3278x, D632780x, SNx32702
where X is the terminal model number.

Information about queriable devicesis availablein the VIACVTAM CNTL library
member.

Note:

CICS data and attributes are presented to the TSO terminal after passing through these
virtual terminals. The DLOGMODs you choose must support the appropriate attributes.

Step 2c - Activating the SmartTest-CICS VTAM Node

50

Add VIACVTAM to SYSLVTAMLST (or its equivalent). Activate the SmartTest-CICS
definition to VTAM by entering this command from the MV S console:

VARY NET,ACT, ID=VIACVTAM

Note:

If your naming standards preclude the use of VIACVTAM as a major node name, you
can define and activate a node name that conforms to your standards.

Also, add the VIACVTAM major node to the standard list of nodes to be activated during
VTAM startup.
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Step 3 - Installing CICS Terminal Definitions

Depending on your installation procedures and SmartTest Testing needs, you can define
these terminals in one of several ways. Normally, you choose only one of these stepsto
define CICS terminals for SmartTest-CICS.

If necessary, review theinstructions for determining the type of terminal support in use at
your sitein the CICS Terminal Definition Requirements section.

Step 3a - Specifying TERMINAL Definitions Using AUTOINSTALL

Specify the appropriate TY PETERM and MODEL definitions for SmartTest virtual
terminal communication. If you choose to use an existing TY PETERM definition, make
sure that it meets the IOAREALEN requirements for SmartTest-CICS.

If needed, enhance your Autoinstall program to accept SmartTest-CICS virtual terminals.

Step 4 - Specifying Your CICS Signon/Logoff

This step is performed to describe your CICS signon and logoff to SmartTest-CICS. You
should only do this step if one of these conditions applies:

= You haveasignon procedure that differs from the one described in "Installation
Requirements and Considerations' on page 28.

<  Youwant to specify alogoff transaction to be driven upon disconnection from the
SmartTest-CICS session.

The optional CNTL library member used is VIACAPPL.

Edit the VIACAPPL CNTL library member. (This member is automatically copied into
the VIACEMTL1 Installation/Environment table.)

TYPE=APPL Definitions
VIACAPPL consists entirely of TY PE=APPL definitionsin sample form. Edit these
entries to describe your signon procedure.

APPL entriesin the Environment Table are used to specify certain characteristics of the
CICS APPLID(s) referenced in CICS connect (logon) processing. A VIACENV
TYPE=APPL entry isrequired only when one of these conditionsis present:

- An aias nameisused for the CICS.

<  One (or more) of the CICS logon characteristics are non-standard as defined on the
previous page.

e A particular signoff transaction must be driven.

51



ASG-SmartTest Installation Guide

Thisis an example of an APPL entry:

VIACENV TYPE=APPL ,APPLID=CICSTOR1,ALIAS=TEST,SIGNOFF=CSSF,SREQD=NO

Note:
For MRO environments, SmartTest automatically provides access to the AORs if the
necessary remote PCT definitions are created in the TOR. SmartTest-CICS dynamically
builds a Remote Connections screen from your existing Connection definitions and
remote PCT definitions you have added to the TOR for SmartTest.

To make use of the Remote Connections screen, specify the TOR on the SmartTest-CICS
session setup screen. Figure 13 on page 86 is an example of the Remote Connections
screen.

See the Optional PCT Entries for MRO section of "Step 13 - Specifying MRO
Transaction Definitions (Optional)" on page 83 for more MRO information.

These are the available VIACENV TYPE=APPL options:

APPLID Enter avalid CICSVTAM APPLID that can be
connected to by SmartTest-CICS. For MRO, the
APPLID should specify the TOR.

ALIAS Optional. Specify an alternate name by which the
CICS APPLID can bereferenced. If coded, you must
enter the ALIAS on the CICS Session Setup screenin
the LOGON APPLID field or the associated
TYPE=APPL entry will not be used. Y ou can code
user friendly names, or VTAM USSTAB short form
names with this option. ALIAS defaults to the
APPLID.

SREQD=YES|NO Specify whether signonisrequired (using a
CSSN/CESN or equivaent transaction) by the CICS
APPLID before auser can invoke valid transactions.
The default is YES.

GMSG=YESINO Specify whether a good morning message displays
automatically on the terminal by CICS at
logon/connect time. The default is Y ES. Specify this
parameter in accordance with theterminal definitions
used for SmartTest-CICS.
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BMSG=YES|NO

Specify whether broadcast messages are always sent
by CICSto the terminal at logon/connect time. The
default isNO.

If you have a pseudo-conversational menu that
displays automatically at signon, you should specify
GMSG=NO,SREQD=NO,BMSG=NO. This
instructs SmartTest to reject the CICSVTAM BID
until SmartTest has completed itsinitialization. The
message ASG2733 ASG-SmartTest is
Active displays briefly before your
pseudo-conversational menu displays. This means
that transactions VIAR, VIAA, and VIAC might run
before the user has signed on. If necessary, make
entriesin your CICS security packageto permit these
transactions to run before a user is signed on.

SMSG='DFH3504'

Provides the character string in single quotes that
your signon transaction returns after a successful
signon. SMSG is used in conjunction with
SREQD=YESif the standard CICS signon facilities
(CESN/CSSN) are not used.

The maximum length is 16 characters. DFH35041,
DFHCE3549, and ACF2's ACFAE139 are handled
automatically. It isonly necessary to code an SMSG
parameter if your signon acknowledgement message
is not one of these three.

SIGNOFF=CSSF|CESFINONE

Identifies the signoff TRANID used for this CICS.
CICS/ESA and above can require CESF. If the
normal logoff transactionis ACF2's LOGO, it should
be specified here.

If the correct signoff transaction ID is not specified, SmartTest-CI CS does not submit any
transaction to CICS at disconnect time. Asaresult, the CSSL log might show LOSTERM
ERROR CODE 20 messages when the connection from TSO/ISPF to CICS is ended.
Most systems handlethe VTAM LOSTERM error with no negative effects on terminal
processing. If a SmartTest-CICS terminal cannot be used more than once, this parameter
can eliminate error handling problems.

CICS Session Setup
Command==>C

Logon APPLID CICSTOR1

CICS Session Setup
Command==>C

Logon APPLID TEST

CICS Session Setup
Command==>C

Logon APPLID CICSAORL1

#1

#2

#3
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If you defined only one TY PE=APPL definition, for example:

VIACENV TYPE=APPL ,APPLID=CICSTOR2,ALIAS=TEST, SIGNOFF=CSSF,SREQD=NO

then entering Logon APPLIDs asillustrated on the SmartTest-CICS Session Setup
screens would have these results:

#1  Typing CICSTOR2 on the SmartTest-CICS Session Setup screen resultsin a
logon to CICSTOR?2, assuming CICSTOR2 is an existing VTAM APPLID.
Because thereisno TYPE=APPL definition that specifies CICSTOR2 as an
ALIAS, SmartTest uses the default logon settings. SmartTest does not initialize
until one of the three default Signon acknowledgement messages displays (seethe
SMSG parameter), and there is no transaction submitted to CICS when a user
disconnects from the SmartTest-CICS session.

#2  Typing TEST on the Session Setup screen initiates alog on to CICSTORI,
because of the TY PE=APPL entry. SmartTest begins initialization immediately
after the Good Morning M essage displays on the screen (the default for GMSG is
YES and SREQD is set to NO, indicating that users are not required to sign on,
and no signon acknowledgement is to be expected). When users disconnect after
logging on with TEST, SmartTest submits the CSSF transaction to CICS.
(SIGNOFF=CSSF).

#3  Typing CICSAORA on the Session Setup screen attempts a direct logon to
CICSAORL. If CICSAORL1 has the appropriate terminal support, SmartTest
attempts to connect using the default signon values.

Step 5 - Specifying Security

This step specifies operator access security to SmartTest-CI CS features. Y ou should only
complete this step if you want to restrict the use of certain commands, resources, and
features. By default, SmartTest-CICS is delivered with no restrictions active—all
functions are available to everyone.

The optional CNTL library member used isVIACAUTH.

Edit the VIACAUTH CNTL library member. This member is automatically included in
the VIACEMT1 Installation/Environment table.

VIACAUTH consists entirely of TY PE=OPERATOR definitionsin sample form. Add
entries to describe which operator 1Ds are permitted what kind of access. It is
recommended that one or two people be set up with unrestricted access authority for
troubleshooting purposes. Thelast entry should be an OPID=ALL typeentry. It should be
set up with the authorizations you want the majority of your users to have.
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Optional OPERATOR entries in the Environment Table are used to define security
authorizations for certain commands and tables. If no OPERATOR statements are
entered, SmartTest-CICS places no security restrictions on these items; all users have
access to al features. These are examples of OPERATOR entries.

VIACENV TYPE=OPERATOR,OPID=TSOID1, LIMITED SETTING +
ENTRY=(2,3,7,13,17,21,25,29,33,34,35,36)

VIACENV TYPE=OPERATOR,OPID=TSOID2, STD SETTING +
ENTRY=(2,3,8,14,17,18,19,20,21,22,23,24,25,26,27,28,29,3+
0,31,32,33,34,35,36,37,38,39)
VIACENV TYPE=OPERATOR,OPID=TSOID3, STD + GLOBAL TABLES +
ENTRY=(2,3,8,10,12,14,16,17,18,19,20,21,22,23,24,25,26,2+
7,28,29,30,31,32,33,34,35)
VIACENV TYPE=OPERATOR,OPID=ALL,ENTRY=(999) NO RESTRICTIONS

This table contains the syntax for each operand.

OPID Enter avalid Operator ID or ALL. Thetype of operator ID (either
TSO user ID or CICS operator D) to useis specified in the
TYPE=OPTIONS section of VIACEMTZ, under the OPIDTY Pfield.
ALL isused to define security authorizations for all OPIDs not
explicitly entered. If any OPIDsareexplicitly entered, an OPID=ALL
entry should also beincluded. ALL must be the last OPID specified.
(OPIDTY P=TSO isrecommended becauseit isaways availableto a
SmartTest-CICS session.)

ENTRY Enter the security level(s) in parentheses, separated by commas. Y ou
must enter one or more security values from thislist.

FORCE command and command parameters allowed
AUTO STEP feature available

Display memory by absolute address

View the DFHSNT module (sign on table)

View SmartTest-CICS modules

Storage protection can be turned off for the USERID

D o1~ WN P
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Note:

Security levels 7 through 16 apply to the Global Protection tables only.

10
11
12

13
14

15
16
17
18
19
20
21
22
23
24
25
26
27
28
29

Allow ADD on Facility Specification screen

Allow ADD/CHANGE/DELETE on Facility Specification
screen

Allow ADD on Task Specification screen
Allow ADD/CHANGE/DELETE on Task Specification screen
Allow ADD on Program Specification screen

Allow ADD/CHANGE/DELETE on Program Specification
screen

Allow ADD on Storage Specification screen

Allow ADD/CHANGE/DELETE on Storage Specification
screen

Allow ADD on Swap Specification screen

Allow ADD/CHANGE/DELETE on Swap Specification screen
Allow file READ access on File Services

Allow file ADD access on File Services

Allow file UPDATE access on File Services

Allow file DELETE access on File Services

Allow temporary storage READ access on File Services
Allow temporary storage ADD access on File Services
Allow temporary storage UPDATE access on File Services
Allow temporary storage DELETE access on File Services
Allow transient data READ access on File Services

Allow transient data ADD access on File Services

Allow transient data UPDATE access on File Services
Allow transient data DELETE access on File Services
Allow DL/I READ access on File Services
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Operand Description

30 Allow DL/I ADD accesson File Services

31 Allow DL/l UPDATE access on File Services
32 Allow DL/I DELETE access on File Services
33 Allow remote monitoring facility access

34 Allow LIST EIB UPDATE capability

35 Allow the Backtrack facility to be activated
36 Allow DB2 READ access on File Services
37 Allow DB2 ADD access on File Services

38 Allow DB2 UPDATE access on File Services
39 Allow DB2 DELETE access on File Services
999 All above features allowed

Step 6 - Specifying SmartTest-CICS Initialization Options

This step describes the SmartTest-CICS initialization options, which you can use to
modify SmartTest-CICS attributes when you start SmartTest-CICS.

Y ou must assembl e this table with the same level of CICS maintenance that your CICS
region uses. If you apply CICS maintenance, be sure to reassemble your VIACEMXX
table(s).

The CNTL library member used isVIACEMT1.
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Step 6a - Editing VIACEMT1 Environment Options

Edit the VIACEMT1 CNTL library member. This member isassembled in"Step 8 -
Running VIACASMJ' on page 68.

VIACEMTL1 consists of several types of entries. Edit the TY PE=OPTIONS entry to
define SmartTest-CICS system initialization attributes. A description of each
TYPE=OPTIONS parameter is provided in this table:

Note:

See "Step 6b - Using the Type= Entriesin VIACEMT1" on page 66 for a description of
the other valid types of entries.

TYPE=OPTIONS

Setstheseinitial parameters and values:

VIACENV TYPE=OPTIONS, INDICATE GENERATION OF TABLES  +
CICSVER=41, CICS V 41,51,52,53, 61, 62 +
CWA=512, CWA LENGTH (AS CICS S.1.T.) +
DB2CTLG=SYSIBM, SPECIFY DB2 CATLG TABLE PREFIX +
DCSINIT=NO, START DYN CALL SUPPORT AT INIT
DESTID=CSSL, MESSAGE OUTPUT DESTINATION +
DL1SWAP=NO, SPECIFY DL/1 PSB SWAPPING=NO +
DYNMOD#=3, NON CICS LOADED MODULES TO TEST +
EIB=YES, ALLOW APPN. TO UPDATE THE EIB +
EXIT1=NO, INITIALIZATION EXIT +
EX1T2=NO, STORAGE VALIDATION EXIT +
FACSAVE=NO, SAVE FACILITY TBL ON VIACTBLS  +
GBLABND=NO, GLOBAL ABEND INTERCEPT +
HEXPREF=A5, HEX PREFIX FOR T/S KEY PREFIX +
ILBOIGN=NO, IGNORE STOR VIOL BY COBOL ILBOS +
MAXCALL=10000, MAX CICS CALLS (GBL MONITOR) +
MAXFC=512, MAX FILE 1/0 (GBL MONITOR) +
MAXTD=512, MAX TD 170 (GBL MONITOR) +
MAXTS=512, MAX TS 1/0 (GBL MONITOR) +
NUMBEXT=4194304, EXTENDED STG LIMIT FOR TASK +
NUMMAX=204800, TCA CHAINED STORAGE LIMIT +
OPIDTYP=CICS, "CICS™ OR "TSO™ USED W/VIACAUTH +
PLIMAIN=352, 60/112/352 DECIMAL OFFSET TO PLIMAIN ADCON +
RENTPROT=(NO, 206), REENTRANT PROGRAM SUPPORT +
RMFSCOPE=LOCAL, GLOBAL RMF TESTING SCOPE +
SHRTBL=25, SHARED STR GETMAINS BY APPL. +
svc=(1,11,19,20,35,47), WAIT,TIME,OPEN,CLOSE,WTO,STIMER +
SWAPADD=NO, SWAP PROGRAM, AUTOMATIC PPT ADD +
T1CIREL=NO VIACEMT1 SUFFIX = CICS RLSE ##
ZCAPABLE=NO 64 BIT INSTRUCTION SUPPORT

CICSVER=41|51|52|53|61|62 Specifiesthe CICS version and release number (41, 51, 52, 53, 61, or 62).

The default is41. If you need to install SmartTest-CICS in two or more
different releases of CICS, seethe TICIREL parameter in thistable.

CWA=512

Specifies the length of the Common Work Area (CWA) of the CSA. The
length specified must be the same as that specified in the CICS System
Initialization Table (SIT). The default is 512.
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DB2CTLG=SYSIBM

Specifies the default DB2 catalog prefix name for this CICS region. This
option isrequired only if the File Services DB2 support is being installed.
The user can override this value online. The default is SY SIBM.

DCSINIT=NO|YES

Specifies whether to initialize Dynamic Call Support at SmartTest-CICS
initialization. The default is NO.

DESTID=CSSL

Specifies the name of the Transient Data Destination to route SmartTest
print requests and informational messages. The default isthe CSSL, the
CICS Statistics destination.

DL1SWAP=YESNO

Specifies whether DL/1 PSB swapping is to be performed. The default is
NO.

DYNMOD#=3

Specifies the maximum number of modulesto be interactively tested by
SmartTest-CICS. These are modules that do not reside in the CICS PPT
and are OS loaded. The default is 3.

EIB=YESINO

Specifies whether to allow monitored programs to modify the Exec
Interface Block (EIB). If you specify YES, any attempt by a monitored
program to modify the EIB is allowed to take place. No storage violation
warning message displays. The default is YES.

Itis highly recommended that NO be used to protect the EIB, asthe EIB is
normally READ ONLY . However, since many sites do modify the EIB for
various reasons, the default has been set to YES to avoid installation
problems.

EXIT1=YESNO

Specifies whether to invoke the SmartTest-CICS Initialization User Exit
during SmartTest-CICSinitialization. ThedefaultisNO. Thisexit iscoded
and assembled only if your applications execute code or access dataoutside
the application's storage chain. It isused to identify static areas where code
or data have been permanently placed, and the addresses of such areas
remain constant. See Appendix C, "SmartTest User Tables and Exits," on
page 135 for more information.

EXIT2=YESINO

Specifies whether to invoke the SmartTest-CICS Storage Validation User
Exit during SmartTest-CICS initiaization. The default isNO. Thisexit is
coded and assembled only if your site requires special handling of storage
areas acquired outside of the normal CICStask chain. See Appendix C,
"SmartTest User Tables and Exits," on page 135 for more information.

FACSAVE=YESNO

Supports Global Monitoring, although the preferred method for supporting
Global Monitoringistoadd aTYPE=FACILITY entry to the VIACEMXxx
installation table. This option defaultsto NO and is no longer
recommended. Do not set this option to YES. This entry is documented
only for compatibility with older releases. Contact ASG Customer Support
if you are using Global Monitoring.
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GBLABND=YES|NO

Specifies the Global Abend Intercept option, which causes
SmartTest-CICSto trap PCP (Program Control Program) ABEND requests
for non-SmartTest-CICS monitored transactions (see Figure 9 on page 63).
It produces asummary screen to the SmartTest-CICS print destination and
to the terminal that owned the abending transaction.

Abends generated internally by DFHPCP are not intercepted; e.g., APCT,
APCN, APCR, APCP. In general, any other PCP abend request can be
intercepted by SmartTest-CICS.

See TYPE=EXABEND in "Step 6b - Using the Type= Entriesin
VIACEMT1" on page 66 for excluding specific abends from
SmartTest-CICS interception.

The global intercept feature only applies to facilities that are specified in
the Global Facility Protection Table. This option does not enable
monitoring for al events. See the ASG-SmartTest CICS User’s Guide for
more information about Global Facilities.

HEXPREF=A5

Specifiesthe hexadecimal value that you want SmartTest to use asthefirst
position of its temporary storage key to avoid conflictsin your
environment. SmartTest can generically delete temporary storage records
based on this value.

ILBOIGN=YESINO

Indicates use of certain COBOL verbs, such as INSPECT and DEBUG,
that are not recommended by IBM for CICS due to the use of OS
GETMAINSs and possible unreclaimed storage. By default, if
SmartTest-CICS monitors an application that uses these COBOL verbs, it
traps certain storage modifications, by ILBO Routines, as storage violation
errors. If you use these verbs, specify YES for this option.

If you specify YES, SmartTest-CICS does not provide storage protection
for some COBOL subroutines.

MAXCALL=0...10000...
999999

Specifies the number of CICS callsthat can be issued before atest session
stops with a status message of POSSIBLE CICS CALL LOOP inthe
status box. The maximum value you can specify is 999999 and the default
is 10000. Specify 0 (zero) to indicate no limit enforcement.

MAXFC=0...512...999999

Specifiesthe number of Filerequeststhat can beissued before atest session
stopswith amessage of FILE 1/0 REQUESTS EXCEED MAX. The
maximum value you can specify is 999999 and the default is 512. Specify
0 (zero) to indicate no limit enforcement.

MAXTD=0...512...999999

Specifies the number of Transient Data requests that can be issued before
atest session stopswith amessage TRANS DATA REQUESTS EXCEED
MAX. The maximum value you can specify is 999999 and the default is512.
Specify 0 (zero) to indicate no limit enforcement.
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MAXTS=0...512...999999

Specifies the number of Temporary Storage requests that can be issued
before atest session stopswiththemessage TEMP STORAGE REQUESTS
EXCEED MAX. The maximum value you can specify is 999999 and the
default is 512. Specify 0 (zero) to indicate no limit enforcement.

NUMBEXT=0...4194304...

99999999

Specifies the total amount of extended storage (above the 16MB line) that
can be accumulated for the transaction before SmartTest-CICS stops the
transaction with the status message STORAGE ACCUMULATED
EXCEEDS MAX. The value excludes Program Storage, but includes all
task-related storage above the 16MB line. The maximum valueis
99999999 and the default is 4194304. Specify 0 (zero) to indicate no limit
enforcement.

NUMMAX=0...
327680...99999999

Specifies the total storage amount that can be accumulated for the
transaction before SmartTest-CICS stops the transaction with the status
message STORAGE ACCUMULATED EXCEEDS MAX. Thevalue
excludes Program Storage, but includes all TCA chained storage and al
tas-related storage above the 16MB line. The maximum value is 99999999
and the default is 500K. Specify O (zero) to indicate no limit enforcement.
The maximum valuewasincreased to accommodate L E/370's|arge control
blocks.

The above values (MAXCALL, MAXFC, MAXTD, MAXTS,
NUMBEXT, and NUMMAX) can be overridden by a SmartTest-CICS
user connected through TSO. Y ou can change the values from option 1 on
the Session Setup screen (Transaction Limitsand Options) or from the List
Limits display. If your site has chosen to enable Global Monitoring
(documented in the ASG-SmartTest CICS User’ s Guide), you might want
torevisethesevaluesupward. Otherwise, native CICS users (not connected
through TSO) may have their sessions stopped when these limits are
reached.

OPIDTYP=CICS[TSO

Restrictsthe use of SmartTest-CICSfeatures. Enter the type of operator 1D
thatisspecifiedin CNTL library member VIACAUTH. Thesearethevalid
entries:

CICS UseCICSif 3-character CICS operator 1Ds are specified.

TSO UseTSOif 7-character TSO user IDs are specified. Use of TSO
IDsisrecommended. The TSO ID isaways availablein a
SmartTest session, regardless of CICS signon requirements. The
default is TSO.

PLIMAIN=60|112]352

Specifies the decimal offset from aPL/I program load point to the
PLIMAIN CSECT. This number should be verified with alink edit map of
any PL/I program. The default is 352, which corresponds to a hex offset of
160 in the link-edit map.
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RENTPROT=(NOJ|YES,
206|nnn)

Specifies the Re-entrant Program Support option, which causes SmartTest
toissue an SV C 109 Extended Services Routine (ESR) to attain Break on
Entry.

The first option specifies whether to activate Re-entrant Program Support
at SmartTest-CICS initialization. The default is NO.

The second option specifies the value of the SV C 109 function code to be
used by SmartTest-CICS. The default valueis 206. If thisvalueis already
in usein your installation, specify avalue between 200 and 255 that is not
being used in your installation.

See "Re-entrant Program Support” on page 77 for more information.

RMFSCOPE=LOCALIALL

Specifies the testing scope for the Remote Monitoring Facility. LOCAL
indicates that this CICSregion is not participating in globa remote
monitoring. ALL indicates that thisregion is participating with all
connected regionsin global remote monitoring. The default is LOCAL.

SHRTBL=25

Indicates the number of spare entries provided to SmartTest-CICSto track
the usage of CICS shared storage requests by the monitored programs. The
default is 25. For SmartTest-CICS to permit transactions to update shared
storage that they did not acquire, the transaction that made the original
shared storage request must be monitored.

SvC=(1,11,19,20,35,47)

Specifies alist of acceptable SV C numbers to be executed under
SmartTest-CICS control. If an SVC isissued that is not specified here,
SmartTest-CICS stops the transaction and issues the ILLEGAL SVC
CALL status message. These are the default SV Cs:

1 WAIT
11 TIME
19 OPEN
20 CLOSE
35 WTO
47 STIMER

SWAPADD=YESINO

Worksin conjunction with the Swap Program feature. If SWAPADD is set
to NO, an attempt to swap a program to an undefined alternate program
resultsin an APCT abend. If SWAPADD is set to YES, then SmartTest
dynamically defines atemporary PPT entry in the CICS system for the
alternate program.
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T1CIREL=YES|NO

Provides support for multiple releases of CICS under SmartTest-CICS.
Instructs SmartTest-CICS initialization logic to load an alternate
environment table that has a defined PPT module name of VIACEMXX,
where xx is the CICS release number (such as VIACEMA41 or
VIACEMS51). When this option is enabled, SmartTest-CICS uses the
VIACEMT1 modulein CICS only long enough to see that the TLICIREL
option ison. SmartTest then determinesthe rel ease of CICS from the CSA
and attemptsto load a VIACEMxx module. Each suffixed VIACEMxx
module must have been assembled with the correct MTS and/or MACLIB
for the release of CICS and defined to CICS. The SmartTest-CICS CNTL
library has prototype VIACEMXxXx source members, with the CICSVER
option set appropriately.

If you select this option, you must build the additional environment table
modules and add PPT definitions for each new suffixed version. The
module VIACEMT1 must always exist in the product library becauseit is
loaded by both TSO and CICS. If you specify the TLCIREL option, it does
not matter which version of CICS the module named VIACEMT1 is
assembled with. The alternate release dependent module, such as
VIACEMA41, are used within CICS.

ZCAPABLE=NO

Specifies whether 64-bit addressing support is enabled. If
ZCAPABLE=YES, SmartTest loads the modul es necessary to support
64-bit addressing. If ZCAPABLE=NO, SmartTest runsnormally unlessthe
program beng tested contains instructions specific to z/Architecture. The
default isNO.

Figure9e+ ASRA Abend with GBLABND=YES and the Terminal Protected

ASG-SMARTTEST-CICS ERROR INTERCEPT SUMMARY DATE: 27 JAN

TRAN-ID : VCOB TIME: 15.35.304
TERMINAL: LO46 DATA EXCEPTION (OC7) OPID:

PSW : 001386A0 AMODE: 24 INSTRUCTION COUNT: 639
MODULE : VIACCII +0036A0 LINK-EDITED DATE: 13 JAN 02

PROGRAM: VIACCOB +003658
INSTRUCTION: AP 688(4,R8),1296(2,R12)
REGISTERS:
0-7 001383AC 00138696 50138668 00137C40 0039A6A0 00398410 003984D4 003994D4
8-15 0039A4D4 00139E6A 00135048 00137C08 0039AB44 0039A6A0 001384EC

*** PRESS ENTER TO CANCEL THIS TRANSACTION (NO DUMP) **=*
*** PRESS PF1 TO CANCEL THIS TRANSACTION WITH A DUMP ***
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TSO/ISPF Example

VIACEMT1 Installation Module

TYPE=OPTIONS
CICSVER = unimportant
OPIDTYP = TSO or CICS, if you are using TYPE=OPERATOR entries to restrict
the use of SmartTest-CICS features
TI1CIREL = YES other options are picked up  from VIACEMxx modules
TYPE=APPL,
APPLID=CICSTEST,ALIAS=TEST
TYPE=APPL, APPLID=CICSTOR1,ALIAS=CICSTOR1,
SREQD=NO, GMSG=NO
(any TYPE=APPL entry needed for any CICS region, no matter what CICS release)
TYPE=OPERATOR, if required

CICSTEST TS 1.3 Example

64

DFHRPL-ASG LOADLIB
VIACEMT1
VIACEM41
VIACEM53
VIACEM62

PPT-VIACEMT1 (T1CIREL=YES)
does not matter which release of CICS VIACEMT1 is assembled with when
T1CIREL=YES, as long as it assembles successfully and is available
to CICS

VIACEM41 - OK to be present in PPT and DFHRPL, but won’t be used in
this region.

VIACEM53 - MUST be present in PPT and DFHRPL. MUST have been
assembled with the correct MTS/MACLIB

VIACEM62 - OK to be present in PPT and DFHRPL, but won’t be used in
this region.
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4.1 Example

DFHRPL-ASG LOADLIB
VIACEMT1
VIACEM41
VIACEM53
VIACEM62
PPT-VIACEMT1 (T1CIREL=YES)
does not matter which release of CICS VIACEMT1 is assembled with when
T1CIREL=YES, as long as it assembles successfully and is available
to CICS

VIACEM41 - MUST be present in PPT and DFHRPL. MUST have been assembled
with the correct MTS/MACLIB

VIACEM53 and VIACEM62
OK to be present in PPT and DFHRPL, but won”t be used in this region.

CICSAOR1 TS 2.2 Example

DFHRPL-ASG LOADLIB
VIACEMT1
VIACEM41
VIACEM53
VIACEM62

PPT-VIACEMT1 (T1CIREL=YES)
does not matter which release of CICS VIACEMT1 is assembled with when
T1CIREL=YES, as long as it assembles successfully and is available to CICS

VIACEM41 and VIACEM53
OK to be present in PPT and DFHRPL, but won”t be used in this region.
VIACEM62 - MUST be present in PPT and DFHRPL. MUST have been assembled with the
correct MTS/MACLIB

If you need to install SmartTest-CICSin two or more different releases of CICS,
specify YES and complete "Step 7 - Specifying SmartTest-CICS Support for
Multiple CICS Releases" on page 67.
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Step 6b - Using the Type= Entries in VIACEMT1

Edit the VIACEMT1 CNTL library member. This member isassembled in"Step 8 -
Running VIACASMJ' on page 68.
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VIACEMTL1 consists of several types of entries. In addition to the TY PE=OPTIONS
entry described above, you can define these SmartTest-CICS TY PE= monitoring options:

TYPE=APPL

See"Step 4 - Specifying Y our CICS Signon/L ogoff" on page 51
for more information about the TY PE=APPL option.

TYPE=EXABEND

Use the optional Exclude Abend Intercept entriesto prevent
interception. SmartTest-CICS does not intercept any abend that
is specified in this table.

TYPE=EXCLUDE

Use the TY PEEEXCLUDE entry to exclude any modules that
should not be monitored. EXCLUDE entriesin thistable become
effective every time SmartTest isinitialized. If a user should
delete one of these necessary entries using the online facilities,
the entry redisplays the next time SmartTest is started.

TYPE=EXCLSTEP

Specify CSECTs that you want SmartTest to exclude from step
requests. Thisis an application feature only. No values are
preshipped or suggested.

TYPE=EXCSECT

Use the optional EXCSECT entries in the Environment table to
list CSECT names to be excluded from monitoring. The entries
specified represent link-edited CSECTS for any monitored load
module.

Caution! Monitoring for the transaction is suspended until
control returns from the excluded CSECT.

Enter names of CSECTS that are not to be monitored by
SmartTest-CICS in parentheses, separated by commas.

TYPE=EXTASK

Usethe TYPE=EXTASK entry to exclude any transactions that
should not be monitored. EXTASK entriesin this table become
effective every time SmartTest isinitiaized. If you delete one of
these necessary entries using the online facilities, the entry
redisplays the next time SmartTest is started.
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TYPE=OPERATOR See"Step 5 - Specifying Security" on page 54 for more
information about this entry.

TYPE=TASK Use for transaction names that are to be added to the online
Protection Task table with the MONITOR=Y ES attribute. These
transactions are monitored by SmartTest-CICS. Monitoring at
thetransaction level isnot generally recommended except for the
demonstration transactions.

Note:

If you areinstalling SmartTest-CICS for multiple releases of CICS, additional
VIACEMXxx definitions are required. See the TLICIREL environment table option in
"Step 6 - Specifying SmartTest-CICS Initialization Options' on page 57, "Step 7 -
Specifying SmartTest-CICS Support for Multiple CICS Releases' on page 67 and " Step
13 - Specifying MRO Transaction Definitions (Optional)" on page 83 for more
information.

Step 7 - Specifying SmartTest-CICS Support for Multiple CICS Releases

Y ou can modify the SmartTest-CICS attributes for different releases of CICS using
initialization options. Perform only those steps that specify a CICS release in which
SmartTest-CICS will beinstalled. See " Step 6a - Editing VIACEMT1 Environment
Options" on page 58 for a description of the parameters contained in each member.

The optional CNTL library members used are VIACEMA41, VIACEM51, VIACEM52,
VIACEMS53, VIACEM®61, and VIACEM®62.

Note:

These tables must be assembled with the samelevel of CICS maintenance that your CICS
region uses. If you apply CICS maintenance, you must reassemble your VIACEM XX
table(s).

Step 7a - Editing VIACEM62 (CICS/TS 2.2 Only)

Edit the VIACEM61 CNTL library member. Uncomment the step that uses this member
nameinthe VIACASMJjob ("Step 8 - Running VIACASMJ" on page 68).

Step 7b - Editing VIACEMG61 (CICS/TS 2.1 Only)

Edit the VIACEM61 CNTL library member. Uncomment the step that uses this member
namein the VIACASMJjob ("Step 8 - Running VIACASMJ' on page 68).
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Step 7c¢ - Editing VIACEMS53 (CICS/TS 1.3 Only)

Edit the VIACEM53 CNTL library member. Uncomment the step that uses this member
namein the VIACASMJjob (“Step 8 - Running VIACASMJ" ).

Step 7d - Editing VIACEM52 (CICS/TS 1.2 Only)

Edit the VIACEM52 CNTL library member. Uncomment the step that uses this member
namein the VIACASMJjob (“Step 8 - Running VIACASMJ" ).

Step 7e - Editing VIACEM51 (CICS/TS 1.1 Only)

Edit the VIACEM51 CNTL library member. Uncomment the step that uses this member
name in the VIACASMJjob (“Step 8 - Running VIACASMJ" ).

Step 7f - Editing VIACEM41 (CICS 4.1 Only)

Edit the VIACEM41 CNTL library member. Uncomment the step that uses this member
nameinthe VIACASMJjob (“Step 8 - Running VIACASMJ' ).

Step 79 - Edit VIACEMT1 (All Releases)

Edit the VIACEMT1 CNTL library member. Change the value on the TICIREL =
parameter to YES.

Step 8 - Running VIACASMJ

When you have finished editing all required CNTL library membersin"Step 2 -
Installing VTAM Definitions’ on page 48 through "Step 7 - Specifying SmartTest-CICS
Support for Multiple CICS Releases’ on page 67, submit the VIACASMJ job.
VIACASMJ creates |load modules required by SmartTest-TSO and SmartTest-CICS.

The CNTL library member used isVIACASMJ.

Step 8a - Running the VIACASMJ Job

Edit the VIACASMJCNTL library member to customize the default parameters. After
you have edited the VIACASMJ job with the steps to run and the overrides for the
high-level CICS prefixes for your CICS environment, save the edited results.

Step 8b - Checking the Output from the VIACASMJ Job

Check the output from the VIACASMJjob and, if needed, edit and submit VIACASMJ
again.

The VIACASMJjob produces alisting and, if incorrect, an error code. If any error occurs
when running the VIACASMJ job, an error code greater than 4 is returned.
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High-level Assembler may return a condition code 4 and the message ASMA303W
**WARNING** Multiple address resolutions may result from
this USING for the statement USING *,DFHEIBR. Thiserroris
acceptable.

Note:
VIACASMJ has steps for the assembly and link-edit of several load modules. Run only
the steps you need.

Step 9 - Defining the SmartTest-CICS File, Programs, and Transactions

In this step, you add the SmartTest-CICS resources to your CICS region(s). The resources
include Programs, Transactions, and onefile. If you are installing the SmartTest-CICS
File Services optional feature, see "Step 11 - Customizing Optional SmartTest-CICS
Features' on page 77, which documents the additional programs and RCT entry required.
This step also documents the additional entries for the optional PL/I feature.

The CNTL library members used are VIACTBLJ and VIACSDJB. VIACPLT isan
optional member.

Step 9a - Adding SmartTest-CICS VSAM File Definition

Use CNTL library member VIACTBLJto define the small VSAM file that holds the
SmartTest-CICS Global Protection Tables. This file contains a dozen records, at most.
Thisfile records certain program and transaction related entries you create in the
Installation table and in subsequent updates to the Global Protection tables. These entries
apply to all SmartTest-CICS usersin a CICSregion. Thefileis defined with
shareoptions 3,3 so that you can use the same file in several regions. However, itis
recommended that you define a separate file for each CICS region in which
SmartTest-CICS will be used to test applications. Then, if one region has unique Global
reguirements, the entries are not propagated to other regions. VIACTBLJuses CNTL
library member VIACTBLD to load the file with one dummy record.

Step 9b - Adding SmartTest-CICS Resource Definitions

Usethe ESW CNTL library member VIACSDJB (shown in Figure 10 on page 70) to add
resource definitions directly to your CSD file.

Change the CICSload library, VIACTBLS file name (from Step 9a - Adding
SmartTest-CICS VSAM File Definition), and the CSD file names to reflect your site
regquirements. Note or change the group name and startup list name.

If you elect to create the SmartTest definitions manually using RDO, do not change any
of the parameter valuesin VIACSDJB and use the IBM default settings for definitions
that are not specified in VIACSDJB .
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Figure10+« Sample VIACSDJB
//ASG JOB (ASG), "ASG-SMARTTEST CSD DEFS®
//*  INSERT "/*ROUTE PRINT NODE.USER" HERE IF NEEDED.
//*
//*
//*  * ASG, INC. ASG-SMARTTEST
//* *
//* * ADD ASG-SMARTTEST-CICS RESOURCE DEFINITIONS TO YOUR
//* * CICS SYSTEM DEFINITION (CSD) FILE.
//* *
//* * IF YOU ELECT TO ADD THE DEFINITIONS MANUALLY, USING RDO,
//* * PLEASE DO NOT CHANGE ANY IBM DEFAULT PARAMETERS IF THE
//* * CHANGE IS NOT SPECIFIED IN THE DEFINITIONS BELOW.
//* *
//* * RUN THIS JOB AFTER YOU HAVE DEFINED YOUR VIACTBLS FILE
//* * (CNTL LIBRARY MEMBER VIACTBLJ). MODIFY THE CSD DEFINITION
//* * BELOW TO REFLECT THE FILE NAME YOU HAVE CHOSEN.
//-k *
//* * CHANGE THE CICS SDFHLOAD HIGH LEVEL QUALIFIER, THE *'CSDLIB"
//* * CSD FILE NAME, THE GROUP NAME, AND THE GROUP LIST
//* * AT THE END OF THE CSD UPDATE INPUT. CHANGE AS REQUIRED
//* * FOR YOUR INSTALLATION.
//* *
//* * YOU MAY WISH TO DELETE THE LAST STATEMENT THAT ADDS
//* * THE SMART70 GROUP TO YOUR STARTUP LIST, AND ADD THE
//* * GROUP ONLINE USING CEDA FOR YOUR INSTALLATION VERIFICATION.
/7*
/7*

//VIACSDJIB PROC CICS="XXXX",

00010000
00020000
00030000

P I B I R S R N I R R 2R TR N R B

00050000
00060000
00070000
00080000
00090000
00100000
00110000
00120000
00130000
00140000
00150000
00160000
00170000
00180000
00190000
00200000
00210000
00220000
00230000
00240002
00250000

CICS HI LEVEL NODES

// CICSLIB="SDFHLOAD®", CICS LOW LEVEL LOADLIB / SDFHLOAD
// SYSoUT="*",

// CSDL IB="XXXXXXXX*"

/7*

//CSDUPD  EXEC PGM=DFHCSDUP

//STEPLIB DD DISP=SHR,DSN=&CICS..&CICSLIB
//DFHCSD DD  DISP=SHR,DSN=&CSDLIB
//SYSPRINT DD SYSOUT=&SYSOUT

//SYSIN DD DUMMY

/7*

// PEND

/7*

//* CREATE CSD DEFINITIONS

/7*

/7*

//STEP1 EXEC VIACSDJB,

// CSDLIB="CSD.FILENAME",

// CICS="CICSHLQ",

// CICSLIB="CICS.SDFHLOAD"

/7*

//CSDUPD._SYSIN

DD *

DELETE GROUP(SMART70)

DEFINE F(VIACTBLS) GROUP(SMART70)

DSNAME (ASG . VIACENXX . VIACTBLS)
RECORDF(F) A(YES) BR(YES) DEL(YES) UPDATE(YES)

DEFINE PROGRAM(VIACEXEC) GROUP(SMART70)
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LANGUAGE (ASSEMBLER) EXECKEY(CICS)
DATALOC(BELOW)

00270000
00280000
00290000
00300000
00310000
00320000
00330000
00340000
00350000
00360000
00370000
00380000
00390000
00400000
00410000
00420000
00430000
00440000
00450000
00460000
00470000
00480000
00490000
00500002
00510000
00520002
00530000
00540000
00550000
00560002
00570000
00580000



*
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DEFINE PROGRAM(VIACEXRE) GROUP(SMART70)
LANGUAGE (ASSEMBLER) EXECKEY (CICS)
DATALOC(BELOW)

DEFINE PROGRAM(VIACFILE) GROUP(SMART70)
LANGUAGE (ASSEMBLER) EXECKEY (CICS)
DATALOC(BELOW)

DEFINE PROGRAM(VIACLIST) GROUP(SMART70)
LANGUAGE (ASSEMBLER) EXECKEY (CICS)
DATALOC(BELOW)

DEFINE PROGRAM(VIACGLUE) GROUP(SMART70)
LANGUAGE (ASSEMBLER) EXECKEY (CICS)
DATALOC(BELOW)

VIACDB2- DB2 FILE SERVICES

DEFINE PROGRAM(VIACDB2) GROUP(SMART70)
LANGUAGE (ASSEMBLER) EXECKEY(CICS)
DATALOC(ANY)

VIACDLI- DLI FILE SERVICES
DEFINE PROGRAM(VIACDLI) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)
VIACDSET,VIACDYNH, AND THE
ENTRY FOR DFHEPC ARE FOR
DYNAMIC CALL SUPPORT
DEFINE PROGRAM(VIACDSET) GROUP(SMART70)
LANGUAGE (ASSEMBLER) EXECKEY(CICS)
DATALOC(ANY)
DEFINE PROGRAM(VIACDYNH) GROUP(SMART70)
LANGUAGE (ASSEMBLER) EXECKEY(CICS)
DATALOC(ANY)
VIACTSCL IS TEMP STORAGE
CLEANUP
DEFINE PROGRAM(VIACTSCL) GROUP(SMART70)
LANGUAGE (ASSEMBLER) EXECKEY(CICS)
DATALOC (ANY)
VIACRMFT IS THE GLOBAL RMF
PROCESSOR
DEFINE PROGRAM(VIACRMFT) GROUP(SMART70)
LANGUAGE (ASSEMBLER) EXECKEY(CICS)
DATALOC(ANY)
DEFINE PROGRAM(VIACRMFD) GROUP(SMART70)
LANGUAGE (ASSEMBLER) EXECKEY(CICS)
DATALOC(ANY)
VIACSPRO IS THE REENTRANT
PROGRAM SUPPORT MANAGEMENT
DEFINE PROGRAM(VIACSPRO) GROUP(SMART70)
LANGUAGE (ASSEMBLER) EXECKEY(CICS)
DATALOC(ANY)

DEFINE PROGRAM(VIACEMAL) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACEMAN) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC (BELOW)

DEFINE PROGRAM(VIACEMCL) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC (BELOW)

DEFINE PROGRAM(VIACEMFS) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

00590002
00600000
00610000
00620002
00630000
00640000
00650002
00660000
00670000
00680002
00690000
00700000
00710000
00720002
00730000
00740000
00750000
00760000
00770002
00780000
00790000
00800000
00810000
00820000
00830004
00840000
00850000
00860004
00870000
00880000
00890000
00900000
00910002
00920000
00930000
00940000
00950000
00960002
00970000
00980000
00990002
01000000
01010000
01011003
01012003
01013003
01014003
01015003
01020000
01030002
01040000
01050000
01060002
01070000
01080000
01090002
01100000
01110000
01120002
01130000
01140000
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DEFINE PROGRAM(VIACEMGC) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACEMSP) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACEMT1) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACEM41) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACEMS51) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACEMS52) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACEMS3) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACEM61) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACEM62) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACGKEY) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACLPGM) GROUP(SMART70)
LANGUAGE (ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACRUN) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACTBLS) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACUTBL) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACZATT) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIAPBKRP) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DATALOC(BELOW)

DEFINE PROGRAM(VIACPLI) GROUP(SMART70)
LANGUAGE(PLI) RESIDENT(NO)
DEFINE PROGRAM(VIACDEMO) GROUP(SMART70)

LANGUAGE(COBOL) RESIDENT(NO)
DEFINE PROGRAM(VIACASM) GROUP(SMART70)
LANGUAGE(ASSEMBLER) RESIDENT(NO)
DEFINE PROGRAM(VIACCOB) GROUP(SMART70)
LANGUAGE(COBOL) RESIDENT(NO)
DEFINE PROGRAM(VIACCOB2) GROUP(SMART70)
LANGUAGE(COBOL) RESIDENT(NO)
DEFINE PROGRAM(VIACCOB3) GROUP(SMART70)
LANGUAGE(COBOL) RESIDENT(NO)

01150002
01160000
01170000
01180002
01190000
01200000
01210002
01220000
01230000
01240002
01250000
01260000
01270002
01280000
01290000
01300002
01310000
01320000
01330002
01340000
01350000
01360002
01370000
01380000
01390002
01400000
01410000
01420002
01430000
01440000
01450002
01460000
01470000
01480002
01490000
01500000
01510002
01520000
01530000
01540002
01550000
01560000
01570002
01580000
01590000
01600002
01610000
01620000
01630000
01640002
01650000
01660002
01670000
01680002
01690000
01700002
01710000
01720002
01730000
01740002
01750000
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DEFINE PROGRAM(VIACIVP) GROUP(SMART70)
LANGUAGE(COBOL) RESIDENT(NO)

DEFINE MAPSET(VIACMAA) GROUP(SMART70)
RESIDENT(NO)

DEFINE MAPSET(VIACMAP) GROUP(SMART70)
RESIDENT(NO)

01760002
01770000
01780002
01790000
01800002
01810000
01820000

DEFINE TRANSACTION(VIAA) PROGRAM(VIACRUN) GROUP(SMART70) SPURGE(YES)

DTIMOUT(0015) ISOLATE(NO) CMDSEC(NO) RESSEC(NO)
TASKDATALOC(BELOW)

DEFINE TRANSACTION(VIAC) PROGRAM(VIACEXEC) GROUP(SMART70)
ISOLATE(NO) CMDSEC(NO) RESSEC(NO)
TASKDATALOC(BELOW) TASKDATAKEY (CICS)

DEFINE TRANSACTION(VIAI) PROGRAM(VIACEXEC) GROUP(SMART70)
ISOLATE(NO) CMDSEC(NO) RESSEC(NO)
TASKDATALOC(BELOW) TASKDATAKEY (CICS)

DEFINE TRANSACTION(VIAR) PROGRAM(VIACRUN) GROUP(SMART70)
ISOLATE(NO) CMDSEC(NO) RESSEC(NO)
TASKDATALOC(BELOW)

DEFINE TRANSACTION(VIVP) PROGRAM(VIACIVP) GROUP(SMART70)
ISOLATE(NO) TASKDATALOC(ANY)

CMDSEC(NO) RESSEC(NO)

*

* VIAL IS FOR NATIVE CICS MEMORY DISPLAY
*
DEFINE TRANSACTION(VIAL) PROGRAM(VIACLIST) GROUP(SMART70)
ISOLATE(NO) CMDSEC(NO) RESSEC(NO)
TASKDATALOC(BELOW) TASKDATAKEY (CICS)

*

*  VIAH IS FOR DYNAMIC CALL SUPPORT
DEFINE TRANSACTION(VIAH) PROGRAM(VIACDSET) GROUP(SMART70)
ISOLATE(NO) TASKDATALOC(ANY) TASKDATAKEY(CICS)
CMDSEC(NO) RESSEC(NO)

*

*  VIAD IS FOR GLOBAL RMF MANAGEMENT
*
DEFINE TRANSACTION(VIAD) PROGRAM(VIACRMFD) GROUP(SMART70)
ISOLATE(NO) TASKDATALOC(ANY) TASKDATAKEY(CICS)
CMDSEC(NO) RESSEC(NO)

*

*  VIAP IS FOR REENTRANT PROGRAM SUPPORT MANAGEMENT
*
DEFINE TRANSACTION(VIAP) PROGRAM(VIACSPRO) GROUP(SMART70)
ISOLATE(NO) TASKDATALOC(ANY) TASKDATAKEY(CICS)
CMDSEC(NO) RESSEC(NO)

*

THE FOLLOWING TRANSIDS ARE FOR DEMOS

01840000
01850001
01860002
01870000
01880000
01890002
01900000
01910000
01920002
01930000
01940001
01950002
01960001
01970000
01980000
01990003
02000000
02010002
02020000
02030000
02040000
02050003
02060000
02070002
02080000
02090000
02100000
02110003
02120000
02130002
02140000
02150000
02151003
02152003
02153003
02154003
02155003
02156003
02160000
02170000
02180000
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DEFINE TRANSACTION(SMAR) PROGRAM(VIACDEMO) GROUP(SMART70) 02190002
ISOLATE(NO) 02200000

DEFINE TRANSACTION(VCOB) PROGRAM(VIACCOB) GROUP(SMART70) 02210002
ISOLATE(NO) 02220000

DEFINE TRANSACTION(VCO3) PROGRAM(VIACCOB3) GROUP(SMART70) 02230002
ISOLATE(NO) 02240000

DEFINE TRANSACTION(VASM) PROGRAM(VIACASM) GROUP(SMART70) 02250002
ISOLATE(NO) 02260000

DEFINE TRANSACTION(VPLI) PROGRAM(VIACPLI) GROUP(SMART70) 02270002
ISOLATE(NO) 02280000

ADD  GROUP(SMART70) LIST(ST7OLIST) 02300002
/* 02310000
/7% 02320000

Note:
If you are upgrading from a prior release of SmartTest-CICS, review your existing PPT
or CEDA GROUP definitions carefully to ensure that any new programs are defined and
have the correct options.

If you are not installing the CICS File Services option, VIACDLI and VIACDB2 are not
required. If you are not installing the CICS PL/I option, the VIACPLI demonstration
program is not required.

Step 9c - Adding COBOL Dynamic Call Support
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Previous versions of SmartTest-CICS supported testing of programs dynamically
CALLed by COBOL Il programs by monitoring the calling program or the entire
transaction. The Dynamic CALL Support feature improves the performance of
SmartTest-CICS sessions by allowing you to test desired programs without monitoring at
the transaction level and without monitoring the COBOL |1 calling program. Thisalso
reduces resource use, particularly for Temporary Storage Queues.

To install the Dynamic CALL Support feature

1 Install the SmartTest Re-entrant Program Support SV C (see "Re-entrant Program
Support" on page 77), or ensure that this statement isincluded in the SIT override
parameters:

RENTPGM=NOPROTECT

Note:

This statement is required for SmartTest-CI CS regions running without Re-entrant
Program Support and may aready have been added to the SIT override parameters.
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Ensure that these definitions arein the VIACSDJB CNTL library member:

PROGRAM(VIACDSET) with DATALOCATION ANY and EXECKey CICS
PROGRAM(VIACDYNH) with DATALOCATION ANY and EXECKey CICS
TRANSACTION(VIAH) with PROGRAM VIACDSET, TASKDATLoc ANY, TASKDATAKey
CICS

Note:

If you already have a SMARTTEST group defined, these definitions should be
added.

To enable Dynamic CALL Support at SmartTest-CICS initialization, set the
parameter DCSINIT=YESin VIACEMT1. See "Step 6a - Editing VIACEMT1
Environment Options' on page 58 for more information.

Enabling Dynamic Call Support

To enable Dynamic CALL Support

1

Define program DFHEPC to your CSD file to enable SmartTest to obtain the load
point address of DFHEPC.

Ensure that thisstatement isincluded in the SIT override parameters:
PRVMOD=DFHEPC
This parameter specifiesthe names of the module(s) that are not to be used from the

LPA.This enables you to use a private version of a CICS nucleus module in the
CICS address space, and not a version that might be in the LPA.

Note:
Y ou can specify the PRVMOD parameter only in PARM, SY SIN, or CONSOLE.

Y ou can enable Dynamic CALL Support at SmartTest initialization by specifying
DCSINIT=YES asaVIACEMT1 environmental entry option. See "Step 6a -
Editing VIACEMT1 Environment Options' on page 58 for more information.

Start SmartTest in your CICS region and run the VIAH ON transaction in the same
CICSregion to install the Dynamic CALL Support in that CICS region. If you
successfully installed the option, you receive this message on your CICS screen:

ASG-SMARTTEST DYNAMIC CALL SUPPORT 1S NOW ACTIVE

Note:

Y ou should only run this command one time in each CICS region to support al
users.
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Ending Dynamic Call Support

To end Dynamic CALL Support, runthe VIAH OFF transaction. Y ou should receive this
message:

ASG-SMARTTEST DYNAMIC CALL SUPPORT 1S NOW INACTIVE
The VIAH OFF command stops the Dynamic CALL Support for all usersinthe CICS

region. If you added VIACDSET to the PLTSD, the Dynamic CALL Support is removed
when CICS s shut down.

Step 10 - Linking to VIACTSCL at Disconnect
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SmartTest-CICS allocates work areas from CICS Shared Storage that exist for the
duration of the testing session. To free this storage and to clean up the Temporary Storage
Queues created for each user, you must enable the cleanup program from your terminal
autoinstall exit program at Delete. When the SmartTest signon table fills up, subsequent
users are not able to use SmartTest. This program also clears out the termina entry from
the SmartTest signon table.

To link to VIACTSCL

1  Modify your existing autoinstall program or DFHZATDX from the
CICS.SDFHSAMP library for functions DELETE_CODE,
DELETE_SHIPPED_TERM, DELETE_SHIPPED_RSE,
DELETE_VIRTUAL_TERM, and CONSOLE_DELETE_TERM by inserting this
Statement:

EXEC CICS LINK PROGRAM("VIACTSCL") *
COMMAREA(DELETE_EXIT_COMMAREA)

2  Change DELETE_EXIT_COMMAREA to the name of your COMMAREA in your
autoinstall exit. DELETE_EXIT_COMMAREA isthe COMMAREA that is passed
to DFHZATDX by CICS, and is defined by macro DFHTCUDS.

Note:

See the IBM CICS Customization Manual for more information about writing a
terminal autoinstall program.
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Y ou now have a complete installation for asingle CICS region. Figure 11 shows the
components.

Figure 1l Componentsof CICS Standalone Region

TSO/ ISPF VTAM CICSTEST
TSO Terminal definitions Applications
ASG-Center DFHRPL-VIASOFT LOADLIB
ASG-SmartTest base PPT-VIACEMT1
VIACEMT1Installation module .
VIACV‘L?M N:ajor Nodle* VIACZATT
TYPE=APPL, irtual terminals VIACRUN
APPLID=CICSTEST VIAC* programs
' VIA2V201 APPL...
- VIAPBKRP
ALIASSTEST ACBNAME=VIA2A001
TYPE=APPL, VIA2v202 APPL... PCT- VIAC,VIALVIAL
APPLID=CICSTORI, ACBNAME=VIA2A002 VIAA VIAR
ALIAS=CICSTORL, -
SREQD=NO
GMSG=NO VIA4V40L APPL... FCT-VIACTBLS

ACBNAME=VIA4A001
VIA4V402 APPL...

VIACVTAM module ACBNAME=VIA4A002

terminal support

VIACCPU
IPO1,DC C'A' LUTYPE2 terminal support

Step 11 - Customizing Optional SmartTest-CICS Features

Re-entrant Program Support

Installing the Extended SVC

The VIACLPAJ member copies the SVC 109 extended service module into the LPA
library. This step isrequired if you plan to use Re-entrant Program Support at your
installation. The data must be copied into the LPA library.

The name assigned to the extended service module depends on the function code number
assigned in "Step 6a - Editing VIACEMT1 Environment Options' on page 58 (e.g., the
function code becomes the last 3 characters of the module name). For example, if you
specified afunction code of 240, the name to be assigned to the module in this step would
be IGX00240.

Note:

Y ou must also set the RENTPROT parameter in VIACEMT1to YES. See"Step 6a -
Editing VIACEMT1 Environment Options' on page 58.
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To copy ESR to the MLPA/PLPA library

1

2

3

4

Edit VIACLPAJto update the LPALIB, VIASOFT, and CENTER parameters.

Change the user function code of 206, specified inthe SYSIN DD * (IGX00206), to
the user function code provided in the VIACEMT1 member.

To copy the SVC to LPA, supply avalid JOB statement and submit the job.

Verify that the job ends with completion code 0.

To make the extended SV C routine (ESR) available, use the CLPA initialization
parameter to IPL your MV S system. Alternatively, you can use products such as
ASG-TMON to load the SVC routine into the LPA and defineit asESR SVC
dynamically.

If you use OS390, but do not have athird-party product (such as ASG-TMON), you can
use the MV S SETPROG command to manage dynamic LPA content. The SETPROG
command should include this information:

Modules to be added to the LPA following IPL.
Modulesto be deleted from the LPA following IPL.

Threshold values for minimum amounts of CSA storage that still must be available
after an ADD operation. For example:

SETPROG LPA,{ADD, [MODNAME=(modname. . .,modname) | MASK=mask}
{ ,DSNAME=[dsname | LNKLST] }

{ [,FIXED] [,PAGEPRTPAGE] }

{}

{DELETE,MODNAME=(modname. . . ,modname) }

{ FORCE=YES [CURRENT | OLDEST] }

{}
{CSAMIN=(below,above) }

Using the VIAP Transaction to Start/Stop Re-entrant Program Support
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To dynamically start and stop the Re-entrant Program Support using the VIAP
transaction

1

Start SmartTest in your CICS region.
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2  RuntheVIAP START [nnn] transaction to install Re-entrant Program Support in
that CICS region, where nnn= ESR function code. If you successfully installed the
option, the message ASG27681 ASG-SMARTTEST-CICS REENTRANT
PROGRAM SUPPORT HAS BEEN STARTED displays on your CICS screen.

Note:
Y ou must specify RENTPROT=(Y ES,nnn) asaVIACEMT1 environmental entry
option to run this transaction. See " Step 6a - Editing VIACEMT1 Environment
Options' on page 58 for more specific information.

3  RuntheVIAP STOPtransaction to end the Re-entrant Program Support. Y ou should
receive the message ASG27681 ASG-SMARTTEST-CICS REENTRANT
PROGRAM SUPPORT HAS BEEN STOPPED.

Running the VIAP transaction without operands gives you the status of Re-entrant
Program Support in the CICS region. Y ou receive one of these messages:

ASG27681 ASG-SMARTTEST-CICS REENTRANT PROGRAM SUPPORT IS ACTIVE.
ASG27681 ASG-SMARTTEST-CICS REENTRANT PROGRAM SUPPORT IS NOT ACTIVE.

PL/l Testing Support

The magjority of the PL/I support is contained in Center and SmartTest product modules.
For CICS, the only additions are CICS resource definitions for the demonstration
transaction VPLI and program VIACPLI. VPLI uses the same map as the COBOL and
Assembler demonstration programs - VIACMARP, which is assembled in "Step 16 -
Preparing the SmartTest-CICS Demonstration Programs' on page 89.

Extended File Services for DB2 and DLI

SmartTest-CICS does not circumvent your existing file security. Y ou can permit or deny
the use of any of the File Services features by coding TY PE=OPERATOR entries, as
described in "Step 5 - Specifying Security" on page 54.

The programs VIACDLI (for DL/1 File Services) and VIACDB2 (for DB2 File Services)
must be added to your PPT definitionsin CICS. For DL/1, program VIACDLI isal that
isrequired to implement file services.

For DB2, modify and execute the VIACIBND member before you use the DB2 file
utility. This member is used to bind the appropriate DBRM member to the associated
plan. Y ou must also complete the steps described in “VIACIBND” , "VIACIBND
performsthe BIND and grants PUBLIC accessto the plan.” on page 80, and "VIACRCT"

on page 81.

Note:

Y ou must run VIASBIND prior to running VIACIBND. See the ASG-Center Installation
Guide for more information about VIASBIND.
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VIACIBND

80

The JCL to bind the appropriate DBRM member (VIACDB13, VIACDB21, VIACDB22,
VIACDB23 CNTL members) to the plan defined to the DB2 utility.

Note:

To submit this JCL, you must have EXECUTE BIND authority. Also, do not use the
same plan name specified in the Center installation option DB2-Plan.

Be sure to specify these parameters correctly.

Parameter Instruction

DB2LIB='DB2.LOADLIB' Specifiesthe DSN associated with the PROC variable
DB2LIB.

DBRM="23 Specifies the suffix associated with the PROC variable
DBRM. Thevalid suffixes are 13, 21, 22, and 23, and the
default valueis 23. Specify this same value on the
MEMBER(VIACDB??) parameter in VIACIBND.

VIASOFT='ASG' Specify the high-level node for ESW product datasets.

CENTER="VIACENxx' Specify the middle node for ESW product datasets.

These parameters are under //BIND.SYSTSIN DD * and //BIND SYSIN DD *
statements at the bottom of the JCL.

Par emeter Instruction

DSN SYSTEM(??7?7?) Specify the correct DB2 system ID.

BIND PLAN(xxxxxxxx)  Specify the correct plan name. The BIND PLAN name
must match the PLAN parameter in the RCT.

MEMBER(VIACDB??) Replace ?7? with the suffix that matches your DBRM
CNTL member (VIACDB13, VIACDB21, VIACDB22,
or VIACDB23). Valid suffixes for xx are 13, 21, 22, and
23. This suffix must also match the suffix on your
DBRM= parameter.

LIB('???7?") Specifies the name of the DB2 Load library where
DSNTIAD islocated.

Note:
VIACIBND performs the BIND and grants PUBLIC access to the plan.
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VIACRCT

The RCT entry is used to communicate with the attachment facility. Modify the PLAN=
parameter to match the BIND PLAN parameter in the CNTL member VIACIBND. Add
this entry to your existing RCT for CICS.

Note:

Y our DB2 administrator should review the security on any DB2 Plans or Tables that you
want to access through SmartTest-CICS File Services. SmartTest does not override DB2
security.

| Step 12 -Validating and Enabling Global Remote Monitoring (Optional)

The SmartTest-CICS remote monitoring has been extended to monitor remote and
asynchronous transactions that run in any CICS region that is connected to the current
SmartTest region and has Monitor set to Y ES on the Remote Connections screen. This
feature uses a SmartTest Global remote monitoring facility (RMF) table (which is
allocated and enabled in MVS CSA) and Global RMF testing to be activated in each
participating CICS region.

To validate the SmartTest-CI CS Global Monitoring Facility

Note:

See the ASG-SmartTest CICS User's Guide for additional information on setting up
Remote Monitoring Facility (RMF).

1  TypeENV inthe command input area and press Enter to display the Environment
Setup Menu.

2 TypeZ2inthecommand input areaand press Enter to display the CICS Session Setup
screen.

3 Connect (log on) to the CICS region specified in the CICS Logon Region APPLID
field by typing C in the command input area and pressing Enter. If applicable, a
standard CICS Logon screen displays for entry of the standard CICS Logon
information.

4  Pressthetoggle key (PF12). The connection process is complete when you receive
the message ASG27331 ASG-SmartTest-CICS i1s active.

5  Toggle back to the CICS Session Setup screen by pressing the toggle key (PF12).
6  Type REMOTE or chose option 4 to display the Remote Test Setup screen.

7 Using another terminal, logon to the CICS Region specified in the CICS Logon
Region APPLID field.
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10

11

On the Remote Test Setup screen, type the facility 1D in the Remote Facility CICS
Userid field. If you are not certain which facility to use, see the Remote Monitoring
Facility chapter in the ASG-SmartTest-CICS User’ s Guide for more information
about determining the RMF facility ID.

Type T in the command input area on your SmartTest terminal to toggle to CICS.

Using the terminal in step 7 on page 81, type VCOB to initiate the SmartTest-CICS
VCOB demonstration transaction. Y our SmartTest session displays the Program
View screen and the status box displaysa BREAK AT START OF TEST
SESSION status message.

Type RUN (or press PF4/PF16) on the command input area of your SmartTest-CICS
terminal to continue testing.

Thetest is complete when you receive the message ASG27511 The Remote
Monitor Facility (RMF) transaction has completed onyour
SmartTest session.

To enable global RMF

1

Allocate aglobal RMF table.

Run the VIAPRMFT CNTL member, which contains JCL to allocate the global
storage for the RMF table. Y ou must run this JCL before global monitoring can be
used. VIAPRMFT only needs to be run once after each IPL.

Before running this job for the first time, copy program VIAPRMFT from the
installation load library to an APF authorized library. Update the JCL AUTHLIB
parameter to reference the selected library or, if the library isin your system
LINKLIST, remove (comment out) the STEPLIB in the JCL .

Change RMFSCOPE=inthe VIACEMT1 CNTL member to activate global RMFin
the participating CICSregions. Specifying RMFSCOPE=AL L activatesglobal RMF
in the CICS region. RMFSCOPE=LOCAL indicates that the region is not a
participant in global remote monitoring. See "Step 6 - Specifying SmartTest-CICS
Initialization Options" on page 57 for more information about VIACEMT1
parameters.
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Managing Global Remote Monitoring with the VIAD Transaction

Use the VIAD transaction in a native CICS session to start and stop global remote
monitoring in the local CICS region and at the global level. These are the valid

transactions:

VIAD START Initializes and activates global remote monitoring in the
local CICS region. SmartTest-CICS must be initialized
before running this transaction.

VIAD STOP Deactivates global remote monitoring in the local CICS

region.

VIAD RESET ENABLE Initializethe global RMF table entries and setsthe status of
the table to active.

VIAD RESET DISABLE Clearsal entriesintheglobal RMF table and setsthe status
of the table to inactive.

VIAD STATUS Displays the current status of global remote monitoring.

Step 13 - Specifying MRO Transaction Definitions (Optional)

SmartTest-CICS provides a ssimple method to establish a testing environment in your
existing AORs. Remote PCT definitions are added to the TOR for each AOR in which
SmartTest-CICSisto be used. For example, using the sample region namesin "Region
Names and Configurations Used in Installation Examples' on page 38 assumes that these
definitions have been created.

These examples areillustrated in Figure 12 on page 85.

CICSTOR1-aCICS 4.1 TOR

Connection Definitions:ACS1, associated with NETNAME CICSAOR1
ACS2, associated with NETNAME CICSAOR2
ACS3, associated with NETNAME CICSARO3

PPT Definitions:VIACEM41 (installation table configured for CICS 4.1)
VIACEMT1 (installation table with T1CIREL=YES)
VIACZATT attach exit
VIACRUN connection and RUN TRANSID support program
VIAC* and VIAPBKRP load modules

PCT Definitions:VIAA and VIAR transactions associated with VIACRUN
VIAC test function support transaction, associated with
VIACEXEC
V1Al internal operations support transaction associated with
VIACEXEC
VIAL diagnostic transaction, associated with VIACLIST
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REMOTE PCT Definitions:VI1C, REMOTESystem=AOR1, REMOTEname=VIAC
VI12C, REMOTESystem=AOR2, REMOTEname=VIAC

FCT Definition:VIACTBLS - Global protection table entries

LUTYPE2 SNA terminal support

CICSAOR1-aCICS TS 2.2 AOR

Connection Definition: TCS1, associated with NETNAME CICSTOR1

PPT Definitions:VIACEM62 (installation table configured for CICS TS 2.2)
VIACEMT1 (installation table with T1CIREL=YES)
VIACZATT attach exit
VIACRUN connection and RUN TRANSID support program
VIAC* and VIAPBKRP load modules

PCT Definitions:VIAA and VIAR transactions associated with VIACRUN
VIAC test function support transaction, associated with
VIACEXEC
VIAIl internal operations support transaction, associated with
VIACEXEC
VIAL diagnostic transaction, associated with VIACLIST

FCT Definition:VIACTBLS - Global protection table entries

CICSAOR2 -aCICS TS 1.3 AOR

Connection Definition: TCS1, associated with NETNAME CICSTOR1

PPT Definitions:VIACEM53 (installation table configured for CICS TS 1.3)
VIACEMT1 (installation table with T1CIREL=YES)
VIACZATT attach exit
VIACRUN connection and RUN TRANSID support program
VIAC* and VIAPBKRP load modules

PCT Definitions:same as in AOR1l

FCT Definition:same as in AOR1l

CICSAOR3-aCICS TS 1.3 AOR

Connection Definition: TCS1, associated with NETNAME CICSTOR1

ASG-SmartTest-CICS is not installed in this region
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Figure 12 shows the components required to support all of these CICS regions

simultaneoudly, plus CICSTEST, which is defined as a standalone TS 1.2 region. The

only additions required for SmartTest-CICS's Remote Connection support for MRO are

the Remote PCT definitionsin CICSTORLI.

Figure12+« MRO Components|llustration

TSO/ ISPF

ASG-Center
ASG-SmartTest base
VIACEMTllInstallation module

TYPE=APPL,
APPLID=CICSTEST,
ALIAS=TEST

TYPE=APPL,
APPLID=CICSTOR1,
ALIAS=CICSTOR1,
SREQD=NO
GMSG=NO

VIACVTAM module

VIACCPU
IPO1,DC C'A'

VTAM
TSO Terminal definitions

CICSTOR1 TS1.3

VIACVTAM Major Node
*virtual terminals*

VIA2V201 APPL...
ACBNAME=VIA2A001

VIA2V202 APPL...
ACBNAME=VIA2A002

VIA4V401 APPL...
ACBNAME=VIA4A001

VIA4V402 APPL...
ACBNAME=VIA4A002

DFHRPL-ASG LOADLIB

PPT-VIACEMT1(TICIREL=YES)
VIACEM41
VIACEM52
VIACEMS3
VIACZATT VIACRUN
VIAC* VIAPBKRP

PCT-Local

VIAC,VIAILVIAL
VIAAVIAR

FCT-VIACTBLS

terminal support

CICSAOR2 TS1.3

CICSTOR1 4.1

LUTYPE2 support

Connections
ACS1-CICSAOR1
ACS2-CICSAOR2
ACS3-CICSAOR3

DFHRPL-ASG LOADLIB

PPT-VIACEMTL(TICIREL=YES)
VIACEM41
VIACEM52
VIACEM53
VIACZATT,VIACRUN
VIAC*VIAPBKRP

PCT-Local

VIAC,VIAIVIAL
VIAA,VIAR

FCT-VIACTBLS

terminal support

DFHRPL-ASG LOADLIB

PPT-VIACEMTL(TICIREL=YES)
VIACEM41
VIACEMS52
VIACEMS53
VIACZATT,VIACRUN
VIAC* VIAPBKRP

PCT-Local
VIAC,VIAILVIAL
VIAAVIAR

PCT-Remote

V11C,Remotesystem=ACS1,

Remotesystem=VIAC

V12C,Remotesystem=ACS2,

Remotesystem=VIAC
FCT-VIACTBLS

terminal support

CICSAOR1 TS 2.2

DFHRPL-ASG LOADLIB

PPT-VIACEMT1(TICIREL=YES)
VIACEMA41
VIACEMS52
VIACEMS3
VIACZATT,VIACRUN
VIAC* VIAPBKRP

PCT-Local

VIAC,VIAILVIAL
VIAA,VIAR

FCT-VIACTBLS

terminal support

These definitions also illustrate the use of the Installation table parameter T1CIREL to
support multiple releases of CICS.
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When a user connects to CICS through SmartTest-CICS, the program VIACRUN
inquires against the TOR's connection definitions and remote PCT definitions. The first
connection from SmartTest-CICS to CICSTORL results in the Remote Connections
screen (accessed from Option 3 on the SmartTest Session Setup screen) shown in
Figure 13.

Figure 13+« SmartTest-ClICS Remote Connections Screen

Remote Connections
Command ===> Scroll ===> CSR

Specify SYSIDs which are to be used for ASG-SmartTest
monitoring.

Current SYSID CET1

SYSID Monitor NETNAME Type CICS Status SmartTest-CICS Status TRANID

TOR1 YES CICSTOR1 TOR  AVAILABLE ACTIVE VIAC
AORD NO CICSAORD LU61 NOT AVAILABLE NOT DEFINED

AOR1 YES CICSAOR1 LU61 AVAILABLE ACTIVE VI1C
AOR2 YES CICSAOR2 LU61 AVAILABLE ACTIVE vi2Cc
AOR3 NO CICSAOR3 LU61 AVAILABLE DEFINED VI3C

TOR2 NO CICSTOR2 LU61 NOT AVAILABLE NOT DEFINED

When all necessary definitions are in place, you can set the Monitor columnto YES for
any AOR that indicates SmartTest DEFINED. Thisisgenerally all that isrequired if your

application transactions are transaction routed from the TOR (automatically routed to a
specified AOR).

The Current SY SID at the top of the Remote Connections screen indicates the region
from which SmartTest-CICS obtains resources when not in an active test session. This
SY SID is aso shown on the Session Setup screen as Active SY SID. SmartTest
commands, such as NEWCOPY, LIst MEmory, and File Services (LIst Flles), always
obtain their resources from the region indicated as the Active/Current SY SID. See
Figure 14 on page 87.

For the VIAR transaction to perform properly in the TOR, these conditions must be met:

e ThelBM group (DFHINQUI) must be installed. DFHINQUI is contained in the
standard DFHLIST and DFHLIST2 lists.

e  The SmartTest load library must be added to the TOR DFHRPL concatenation.
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If you do not want to fully install SmartTest-CICSin your TOR, it is still necessary to
define two programs and two transactions in the TOR.

Figure 14 « Example TOR Definition

CICSTOR1 4.1

LUTYPE2 support

Connections
ACS1-CICSAOR1
ACS2-CICSAOR2
ACS3-CICSAOR3

DFHRPL-ASG LOADLIB

PPT-VIACEMTL(TICIREL=YES)
VIACEM41
VIACZATT,VIACRUN
VIAC* VIAPBKRP

PCT-Local
VIAC,VIALVIAL
VIAA VIAR

PCT-Remote

V11C,Remotesystem=ACS1,

Remotesystem=VIAC

V12C,Remotesystem=ACS2,

Remotesystem=VIAC
FCT-VIACTBLS

terminal support

PCT

PCT

PPT

PPT

Transaction
Program
Remotename

Transaction
Program
Remotename

Program
Language

Program
Language

VIAA
VIACRUN
: none
(Local definition)

VIAR
VIACRUN
: none
(Local definition)

VIACZATT
Assembler

VIACRUN
Assembler

The only reason to do apartial install in the TOR isif no user wants to test a program that

executesin the TOR.

Note:

Program VIACLIST and TRANSID VIAL could aso be added for troubleshooting. No
other SmartTest-CI CS transactions or programs should be defined to the TOR if you are

attempting a partial installation.
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Step 14 - Specifying Optional Program List Tables - Initialization and

Shutdown

Optionally, add the PLT entry contained in the CNTL member VIACPLT to your
Post-Initialization Program List Table and assemble the PLT using your standard
procedures. A PLTPI entry for SmartTest-CICS might be required for co-existence with
other vendor products or abend-handling exits. It is recommended that SmartTest-CICS
not be added to the PLTPI until you complete "Step 17 — Validating SmartTest-CICS
Installation through Native CICS" on page 90.

Note:

If initialization of SmartTest-CICSis not performed with a PLT Post-Initialization entry,
processing for the first SmartTest-CICS user causes initialization of the product to be
performed.

Seethe CNTL JCL member comments for instructions on where to place the SmartTest
PLT entry inyour PLT.

Optionally, add the PLT entry contained in the CNTL member VIACPLTX to your
Shutdown Program List Table, and assemble the PLT using your standard procedures.

You can asoinitialize SmartTest-CICS with asequential input device (card reader input)
by including:

VIAI START\

Step 15 - Editing your CICS Startup JCL

88

Modify and add these JCL statements to the CICS startup JCL :

//DFHRPL DD DSN=your CICS application libraries,DCB=BLKSI1ZE=largest
// DD DSN=ASG.VIACENXxx.LOADLIB,DISP=SHR
//VIACTBLS DD DSN=ASG.VIACENXxx.VIACTBLS,DISP=SHR

Note:

Ensure that the dataset with the largest blocksize is specified first for the DFHRPL
libraries, or enter the DCB=BLKSIZE=nnnn parameter. Failure to do this causes
unpredictable results during the execution of CICS.

SIT overrides might also be required. See "Step 9 - Defining the SmartTest-CICS File,
Programs, and Transactions' on page 69.
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Step 16 - Preparing the SmartTest-CICS Demonstration Programs

Customize JCL, compile and assemble programs, and assemble maps for the
SmartTest-CICS demonstration programs. The demonstration programs and maps must
execute successfully in anative CICS session before you can use them to demonstrate the
testing and debugging capabilities under SmartTest-CICS.

CNTL library members used: VIACIMAP, VIACJICII, VIACIASM and VIACJIPLI

The SmartTest-CICS demonstration programs are conventional CICS programs. They
should be compiled/assembled asif they were developed at your site. The
SmartTest-CICS CNTL library provides several JCL members that can be customized to
reflect the compilers and assemblersin use at your site, or you can use your own
procedures to compile and assembl e the demonstration programs.

Note:
COBOL optimization rearranges and sometimes eliminates the object code that is
generated for each COBOL statement. For this reason, the use of any type of COBOL
optimization is not recommended.

VIACIMAP JCL to assemble the demonstration program mapsets. The COBOL
and PL/I demonstration programs use mapset VIACMAP. The
Assembler demonstration uses mapset VIACMAA. Customize the
JCL to reflect the correct CICS and Assembler versions. ASG
recommends that the demonstration programs be link-edited into the
ESW LOADLIB that was concatenated into the CICS DFHRPL list
in"Step 15 - Editing your CICS Startup JCL" on page 88.

VIACJICII JCL to compile the demonstration programsin their COBOL Il and
later format. This JCL uses CNTL library members VIACDEM?2,
VIACCII, VIACCII2, VIACCII3, and VIACPY 1. The link-edit
requires the ESW LOADLIB for theinclusion of VIACBR14.
Customizethe JCL to referencethe COBOL |1 and CICSreleasesyou
normally specify. Run the job.

Note:

Choose the JCL for the version of COBOL that is used most often for
testing at your site. No matter which JCL member you choose, the
program names are still VIACDEMO, VIACCOB, VIACCOBZ2, and
VIACCOB3. These program names should have been defined to
CICS as COBOL programs when you created the SmartTest-CICS
PPT definitionsin "Step 9 - Defining the SmartTest-CICS File,
Programs, and Transactions" on page 69.
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JCL Description

VIACJASM JCL to assemble the SmartTest-CICS command-level Assembler
program. This program can be invoked from an option on the VCOB
demonstration program menu, or as a separate transaction. Even if
your site did not install the SmartTest-Assembler option, you can
choose to assemble the VIACASM program so that it can be invoked
from VCOB. Customize the JCL to reflect your usual Assembler and
CICSreleases and run the job.

VIACJIPLI JCL to compile and link the VIACPLI demonstration program.
VIACPLI must be compiled, analyzed, and linked into a user load
library that is part of the DFHRPL concatenation.

Step 17 — Validating SmartTest-CICS Installation through Native CICS
These tasks must be complete before the SmartTest validation process begins.

Task Description

1. All relevant CNTL members must be updated and processed.

Note:
Ensure that the VIACASMJ CNTL member is updated and processed.

2. CICS PPT, PCT, FCT, and TCT entries must be updated and installed.

DFHRPL and VIACTBLS must be updated for CICS startup JCL.

3. The VTAM environment must be updated and varied active.

VIACCPU and VIACVTAM must be updated for all CPUs.

Supplied VTAM DLOGMODs must be compatible for CICS.

The system must be updated to enablethe next IPL to pick up VTAM
entries.

4, Shipped PTFs must be applied (if any).

Validating CICS

Log onto CICS (using your normal procedures) and perform these transactions to ensure
that SmartTest-CICS operates in the CICS region.
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Toverify that all therequired installation steps have been completed successfully

1

2

Log on to CICS (using your normal procedures).

Run the VIV P installation verification transaction. See "Using the VIVP
Transaction" on page 93 for more information.

Or

Perform these steps:

a CEMT | DATASET(VIACTBLS) or CEMT | FILE(VIACTBLYS)
Change the status from closed to open. If you are unable to open thisfile, do
not continue until this file can be opened.

b CEMTI TRAN(VIA*)
Ensure that the SmartTest-CICS Transactions (VIAC, VIAI, and so forth) are
defined.

¢ CEMT I PROGRAM(VIA*)

Ensure that the SmartTest-CICS programs (VIACEXEC, VIACEMAL, and
so forth) are defined. Make sure that each program definition shows the
correct program language. Make sure that the programs specified in " Step 9b -
Adding SmartTest-CICS Resource Definitions' on page 69 have
EXECKEY=CICS (CEX on aCEMT display). Also, check for the
demonstration programs.

VCOB (optionally VASM and VPLI)

Select menu option 12 (Too Much Storage) to ensure that the programs VIACCOB
and VIACOB2 were compiled successfully. Type X to exit.

Initialize SmartTest-CICS.
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Initializing SmartTest-CICS

Enter these terminal transaction from a clear screen:

VIAI START

These are the expected messages:

ASG27601 ASG-SmartTest is Initializing
ASG27601 ASG-SmartTest Rx.y is active for CICS x.y

If these messages are not received, make a note of the complete text of any message that
displays on the screen. It might be necessary to close and open the CSSL log in the CICS
region, and check it for any messages regarding the SmartTest-CICS initialization
attempt. If the message does not indicate that a VIAI STOP/PF1 isrequired, type this
terminal transaction from a clear screen:

VIAI STOP

If the error message produced on theinitialization attempt indicates that VIAI STOP/PF1
isrequired, or if SmartTest-CICS programs show a RES count after an attempt at aVIAI
STOP, press PF1 instead of Enter after typing V1Al STOP. This should result in the
message SmartTest-CICS Has Been Stopped, with perhaps afew additional
messages about NEWCOPIES on SmartTest-CICS modules. Always check the RES
counts for the SmartTest-CICS programs to make certain they are zero before attempting
arestart. If you have any questions about what you are seeing when you attempt a native
VIAI START, call ASG Customer Support.

Terminating SmartTest-CICS

92

Normal product usage involves automatic termination of SmartTest-CICSwhen CICSis
terminated. If necessary, you can terminate the SmartTest-CI CS product by typing VIAI
STOP on any blank screen.

This command is often necessary to facilitate new copy processing after applying
SmartTest-CICS maintenance.

Note:

See Appendix B, "Interim Modifications" on page 133 for more information. If a stop
request fails due to the message ASG27641 ASG-SMARTTEST 1S NOT ACTIVE,
and aVIAI START failswith the message ASG27611 ASG-SMARTTEST IS
ALREADY ACTIVE, you cantype VIAI STOP and press PF1 to force a stop.

To complete the installation process, modify other installation facilities such as IBM
maintenance levels, security packages, and shared DASD handlers, if necessary.

Note:
Particular attention should be paid to the restrictions on DFHPCP and security software.
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Using the VIVP Transaction

The VIVP installation verification transaction provides an on-screen exception report of
specific SmartTest-CICS resources when the status or definition deviates from the
installation option. The program does not initialize SmartTest-CICS and does not make
any changes to the environment. Its basic intent is to report obvious errors and/or
potential errors. The program verifies only basic installation and is not comprehensive. It
runsin native CICS and does not require SmartTest for operation.

VIVP performs these functions:

Reports the release of CICS.

Verifies the existence of VIACEMT1 and displays the assembly date for
VIACEMTL.

Reports the existence (or absence) of a suffixed table (VIACEMXX) and the
CICSVER that was used when it was assembled.

Reports the absence of a SmartTest-CICS program (e.g., VIACEMAN).
Reports the absence of a SmartTest-CICS PPT definition (e.g., VIACEMAN).
Reports any SmartTest-CICS program that is NOT defined as ASSEMBLER.
Reports any SmartTest-CICS program that is DISABLED.

Reports the absence of a SmartTest-CICS transaction (e.g., VIAR, VIAA, VIAC,
VIAI).

Reports when a SmartTest-CICS transaction (e.g., VIAR, VIAA, VIAC, VIAI) is
DISABLED.

Reports when VIACTBLS does not exist or when the FCT DCB attributes are not
defined correctly.

Reports when a SmartTest-CICS transaction (e.g., VIAR, VIAA, VIAC, VIAI) is
defined as ISOLATE=Y ES. Transaction isolation must be enabled in the CICS
region.

Reports when SIT parameter RENTPGM s set to PROTECT.

93



ASG-SmartTest Installation Guide

Step 18 - Validating SmartTest-CICS

94

Note:

The dataset names mentioned in these validation steps are the default installed names. If
you have changed them, use the changed names where the default names have been
specified.

To validate the SmartTest-ClI CSinstallation

1

Start SmartTest-CICS by selecting the correct option for your site.

- If you installed SmartTest as described in "Step 4 - Preparing | SPF to Invoke
SmartTest" on page 16, use the appropriate | SPF menu selection or the CLIST
to start SmartTest.

- If you installed the ESW product menu as described in the ASG-Center
Installation Guide, use the appropriate | SPF menu selection or the CLIST to
display the ESW product primary screen.

Select Test » Module/Transaction to display the SmartTest primary screen.

If you start SmartTest using the ESW primary screen, the product name
displays as ESW - Testing/Debugging.

Select Help » About to verify the product releases and level s of SmartTest-CICSand
Center that are installed. The product names, rel ease numbers, maintenance levels,
and the operating system are indicated.

If SmartTest-CICS does not display in the Product namefield, type ENVIRONMENT
and choose the CICS environment (option 2).

Review and/or modify the SmartTest-CICS options by selecting Options on the
action bar.

a  Select Options » Product Parameters. The Options - Product Parameters
pop-up displays. Review and/or modify the parameter definitions and press
PF3/PF15.

b  Select Options» Log/list/punch. The Options - Log/List/Punch Definition
pop-up displays. Review and/or modify the Log, List, and Punch file defaults.
Enter the job statement information and press PF3/PF15.

This step is recommended before proceeding to ensure a valid operating
environment for your user ID.

See the ASG-SmartTest Reference Guide or the online help facility for descriptions
of these options.
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Allocate an AKR by selecting File » AKR utility. The File - AKR Utility pop-up
displays.

Note:
If you have already created an AKR when validating another ESW product, proceed
to step 5 on page 96.

a  CompletetheFile- AKR Utility pop-up by typing the name of aESW AKR to
be allocated. Type A in the command input area and press Enter.

b OntheFile- AKR Allocate/Expand pop-up, the AKR name displays. Verify
that it is correct, then:
—  Enter the SM S values or the Volume and space parameters for the AKR.
—  Enter an appropriate Unique parameter if thisisaVSAM AKR.

— If thisdataset must be cataloged in auser catal og, type C in the command
areatodisplay theAKR Catal og | nformation pop-up and enter the Catal og
dataset name and password.

— Enter the job statement information for your site and submit the job by
typing S in the command input area.

— Wait for the job to finish and verify that the AKR was successfully
allocated and initialized.

Figure 15 showsthe File - AKR Allocate/Expand pop-up using SMS and aVSAM
AKR.

Figure15e« File- AKR Allocate/Expand Pop-up

File - AKR Allocate<ExHpand
CoHHand ===

% - SubHit JCL E - Edit TCL C - Epecify Catalog
Expand edisting AKR . . . NO [ves ar Mol
AKR data =&t nade . . . . "UZER]1:.GEMERAL.AKR’
PolUHE & & & v 4 e e e o
Unit o w w  n n m 12 [Generic unit nade]
Zpace units . . . . . RECORDE [Records, Tracks or Cylinders)
PriHary Space . . . . « 4088 [PriHary anount in abowve units)
Zecondary Space . . . . B [#econdary anount in abouve units)

Job statedent infordations
<#USER1Z_ TOE [DEUTRS,253200],
e HEGCLAZE=A
<~k IWNZERT '-~ROUTE PRINT NODE.UZER' HERE IF MEEDED.
<ok
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5

Analyze the programs by selecting File » Compile/Analyze. Enter the appropriate
information on the File - Analyze Submit pop-up.

a  Usethisstatement for the compile and link JCL dataset:
ASG.VIACENXX.CNTL(VIACJCII1) for COBOL 11
b Enter the AKR dataset name that will contain SmartTest-CICS programs.

¢  Verify theJOB card and routing information by typing E in the command input
area on the Analyze Submit screen. Type SUB in the command input area and
press Enter to submit the analyze job. Press PF3 (End) to exit the Edit session.

d  Verify that the analyze job completed successfully.

Note:
See the ASG-SmartTest Reference Guide, the Online Help facility, or the
ASG-Center Installation Guide for information on the File - Analyze Submit
pop-up.

Set up for the V COB demonstration transaction by typing ENV in the command input
area and pressing Enter to display the Environment Setup Menu.

Note:

SmartTest-CICS is shipped with VCOB in the Global Task Table. Make sure
VCOB currently displaysin the Global Task Table.

a  Verify the AKR name shown.

b  Type2inthe command input areaand press Enter to select CICS Session
Setup.

¢  Verify the monitoring requests on the CICS Session Setup screen.
d Break at Start (Y/N) should be YES.

e Verify the CICS Logon Region APPLID on the CICS Session Setup screen.
The Logon Region APPLID isthe CICS Application ID or an aliasdefined in
the VIACEMT1 table at installation time. The Toggle PF key should be PF12.

Connect (log on) to the CICS region specified in the CICS Logon Region APPLID
field by typing C in the command input area and pressing Enter. If applicable, a
standard CICS Logon screen displays for entry of the standard CICS Logon
information. The connection process is compl ete when you receive this message:

ASG27331 ASG-SmartTest-CICS is active
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Thisstep validatesthat the VTAM and CICSTCT entries (if applicable) areinstalled
and compatible.

These are the possible problems you might encounter at this point:

< The CICS region specified is not active.

= You are attempting to connect to aterminal that has not been defined to
VTAM. The SmartTest-CICS Log file can be printed for further information.

=  You are attempting to connect to aterminal that has not been defined to CICS.
The SmartTest-CICS Log file can be printed for further information.

=  SmartTest-CICS under CICS could not initialize. Verify that the FCT, PCT
and PPT, entries are available and enabled. The SmartTest and CICSLog files
can be printed for further information.

Execute the SmartTest-CICS NEWCOPY command for VIACCOB and
VIACCOB2.

a  Select Test » CICS Newcopy or type NEW VIACCOB in the command line
area.

If you have changed the transaction definition for VCOB to route it to an
AOR, be certain that you confirm the ACTIVE SY SID.

For adiscussion of MRO testing using the Remote Connections screen, see
"Step 13 - Specifying MRO Transaction Definitions (Optional)" on page 83.

b  Using the NEWCOPY command:
—  Executea CEMT NEWCOPY without toggling/cross-routing to CICS.
— Delete any old SmartTest-CICS program description control blocks.
— Ensurethat the sourceimage onthe AKR and theload modulearein sync.

Test the VIACCOB demonstration program by typing VCOB. This starts the test
session and displays the Program View screen.

a  Thestatus box displays at the bottom of the screen. This box showsaBREAK
AT START OF TEST SESSION status message. The current statement line
is highlighted and contains chevrons (>>>>>>) in the line prefix area.

b TypeRUN (PF4/PF16) to continue testing. The VCOB (VIACCOB)
Demonstration Program Menu displays.

c  Type?2 (Data Exception - SOC7) on the command line of the Demonstration
Program Menu and press Enter. The Program View screen is redisplayed with
a status box that indicates that aDATA EXCEPTION (S0C7) has occurred.
The chevronsin the line prefix area (>>>>>>) point to statement ADD +1 TO
DATA-PACKED-DEC.
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A screen displays noting that DATA-PACKED-DEC containsinvalid data.

Replace the* INVALID * data message with O (zero), then press PF4/PF16
(RUN) to continue testing. The test should now be complete and the VCOB
Demonstration Program Menu should be redisplayed.

Type X (Exit This Demo) on the command line and press Enter to return to the
Program View. The message SUCCESSFUL MEMORY UPDATE displays.

The VIACCOB demonstration program is actually a detailed tutorial on
SmartTest-CICS features. See the comments on the top of the source code for
instructions.

d  Toviewthecomments, type ISPF UP MAX after you receivethe BREAK AT
START OF TEST SESSION message.

To reanalyze the demonstration programs after a test

1

2

Do not disconnect from CICS.

TypeQ CAN ALL inthe primary command line areato release the AKR members
you have allocated during your test session.

Make the necessary corrections and submit the analyze.

Once the analyze has completed successfully, use the SmartTest-CICS NEWCOPY
primary command for the reanalyzed load modules.
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This chapter describes how to customize SmartTest-IMS and contains these

sections:

Prerequisite 99

Step 1 - Completing the Installation Worksheet 100
Step 2 - Modifying and Executing CNTL Library Members 101
Step 3 - Modifying Installed CLIST Libraries 102
Step 4 - Preparing User Definition Files 103
Step 5 - Establishing Signon Validity Checking 103
Step 6 - Validating SmartTest-IMS 105

Prerequisite

ASG-Center and SmartTest installation and customization must be performed before
customizing SmartTest-IMS. If Center has not been installed, see the ASG-Center
Installation Guide at thistime. For SmartTest product installation, see "Installing and
Customizing SmartTest" on page 5.

These are the steps for customizing SmartTest-IMS:
Steps

"Step 1 - Completing the Installation Worksheet" on page 100.

"Step 2 - Modifying and Executing CNTL Library Members' on page 101 (to customize
for your environment).
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Steps

"Step 3 - Modifying Installed CLIST Libraries' on page 102.

"Step 4 - Preparing User Definition Files' on page 103.

"Step 5 - Establishing Signon Validity Checking” on page 103.

"Step 6 - Validating SmartTest-IMS" on page 105.

Step 1 - Completing the Installation Worksheet

Thistableis an aphabetical list of the symbolic parameters that are used in the
installation JCL procedures and CLISTs. Determine the appropriate values for your
installation and record them for later reference.

Par ameter Default Install Value Description

VIASOFT ASG High-level qualifier(s) for Center permanent
libraries (non-VSAM).

CENTER VIACENXX Second level qualifier(s) for the Center permanent
libraries (non-VSAM).

IMS 'IMS IMS library high-level qualifier.

VPVIDCIP 10PCB Default LTERM name; found in VIAPUIDC
CLIST.

VPVMBLB1 'IMSMODBLKS IMS MODBLKS dataset name; found in
VIAPUIDC CLIST.

VPVMVSUF ‘0 IMS MODBLKS member name suffix; found in
VIAPUIDC CLIST.

SYSDA SYSDA Disk unit for temporary work space.

SYSOUT ! SYSOUT class.

VPVIDCLD 'ASG. VIACENXx.CNTL LTERM and device type codefile; found in

VIAPUIDC CLIST.

VPVIDCLM VIAPLTRM Member in library specified in VPVIDCLD to
contain LTERM and device type codes; defined in
VIAPUIDC CLIST.
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Parameter Default Install Value Description

VPVIDCTD 'ASG. VIACENXX.CNTL’ Transaction ID file; found in VIAPUIDC CLIST.

VPVIDCTM VIAPTRAN Member in library specified in VPVIDCTD to
contain transaction I1Ds; defined in VIAPUIDC
CLIST.

Step 2 - Modifying and Executing CNTL Library Members

Note:

A complete list of all SmartTest CNTL members and their descriptionsis availablein
Appendix F, "SmartTest CNTL and CLIST Members," on page 153.

These members should be reviewed for modification and executed.

M ember Description

VIAPOGMJ  JCL to create SmartTest-IM S environment-specific definitions. Y ou
must execute this member before running SmartTest-IMS.

VIAPOGMJ produces two |M S rel ease-dependent |oad modules.
VIAPOFxx (where xx isthe IM S rel ease number) contains pointersto
IMS data areas that are needed by SmartTest-IMS. VIAPMFxx
containsfield-level and segment-level edit routinesthat are required for
SmartTest-IMS 3270 emulation. These modules must be generated for
each release of IMS used with SmartTest-IMS.

Rerun this job when migrating to a new release of IMS, or when
maintenance is applied to the IM S libraries referenced by VIAPOGMJ.

VIAPIVPJ] JCL to create the demonstration facility.

VIAPMODB JCL tocreatealist of transactions eligible for testing. This member can
optionally be reviewed for modifications and executed.

VIAPCMD Source for the SmartTest-IM S command authorized BMP. This
member is used to install the SmartTest-IM S authorized BMP
transaction. This transaction is optional, but is required by the
SmartTest-IMS commands /START and /DISPLAY .

VIAPCMDJ  JCL to assemble and link the authorized BMP and to build the PSB.
This member is used to install the SmartTest-IM S authorized BMP
transaction. This transaction is optional, but is required by the
SmartTest-IMS commands /START and /DISPLAY .
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VIAPIVC JCL to compile and link the VIAPIVP1 demonstration program.

Note:
This member should be modified, but is not used until the validation
step.

VIAPIMSA JCL to allocate databases for the demonstration program.

Note:
This member should be modified, but is not used until the validation
step.

Step 3 - Modifying Installed CLIST Libraries

102

Review the VIAPUIDC CLIST modifications.

VIAPUIDC Used to restore IMS/DC system variables and parameters to the site
defaults.

There are certain | SPF variablesin the VIAPUIDC CLIST that, if unpopulated, view a
user who enters the SmartTest-IMS/DC environment as a new user. In this case, the
VIAPUIDC CLIST isredriven and default values are popul ated within the user's
environment.

Although these variables are not used in al IMS environments, you can avoid the
redriving of the CLIST by editing the VIAPUIMS CLIST inthe ESW CLIST library.
Populate the variables VPVPSB1 and VPVACBL1 with default PSB or ACBLIB
libraries or with valid PSB or ACBLIB libraries that your applications will be using. If
the CLIST is not updated, you can add a PSB/DBD library panel E.1.3.5 from the
IMS/DC Session Setup screen or alibrary specified for the IMSACB value on panel
E.2.3.5. If these panels are blank, the user is seen asanew user and VIAPUIMS CLIST
resets the system defaullts.

If running IMS/DC with public DBs, these libraries are not referenced. However, if they
are unpopulated, it causes the redriving of the VIAPUIMS CLIST and overlays your
library alocations.
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Step 4 - Preparing User Definition Files

Two sample User Definition members containing transaction (VIAPTRAN) and LTERM
names (VIAPLTRM) are suppliedin ASG.VIACENXX.CNTL. If another dataset nameis
used, the VIAPUIDC CLIST should reflect the dataset name change.

The optional transaction file contains the IMS Transaction IDs eligible for testing with
SmartTest-IMS. When creating this member, list each Transaction ID on a separate line.
For example:

PART
DSPALLI
ADDINV

Note:
In"Step 2 - Modifying and Executing CNTL Library Members' on page 101, the CNTL
member VIAPMODB JCL created a transaction file containing transactions defined in
your MODBLK S dataset. The generated transaction file, or a customized transaction file
as described above, can be used for testing.

The LTERM file containsthe IMS LTERM names and MFS device type codes defined to
SmartTest-IM S for use with 3270 terminal emulation. When creating thisfile, each
LTERM and device type should be listed on the same line. At least one blank must
separate name from the type. If adevice typeis not specified, it defaults to 3270,2. For
example:

|OPCB 3270,2
LTERMO1 3270,4
LTERMO2 3270-A2

Step 5 - Establishing Signon Validity Checking

The IMS command /SIGN is optional in the SmartTest-IMS 3270 emulation
environment. This section suggests away to provide some degree of signon validity
checking and/or security verification within SmartTest-IMS. It is not intended to
facilitate the use of the same DFSCSGNO exit used by your IMS system.
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When the application program receives control, the user ID field of the IOPCB contains
the TSOID if the /SIGN command was not entered by the user. If the /SIGN command
was entered and the IMS exit DFSCSGNO is hot present, the user ID field in the IOPCB
containsthe user 1D from the/SIGN command. If the DFSCSGNO exit is present, the user
ID field of the IOPCB contains the TSOID.

Note:
A specia PTF isavailable to cause signon to be required.

The use of the signon exit routine (DFSCSGNO) is supported by the SmartTest-IMSin
the 3270 emulation environment. However, the exit executesin the user's TSO region and
isquite limited in what IMS internal data structures and service routines it can access.

To be eligible for use with SmartTest, the exit must be link-edited as a separate |oad
module and bein alibrary contained in the concatenation specified on the SmartTest-IMS
environment screen. If the load module is present in the concatenation sequence, it is
given control when the /SIGN command is entered on the emulated IMS terminal screen.

Note:

Because the DFSCSGNO exit resides in the user's TSO region, it does not have access to
most of the IM S data structures and service routines it would normally be able to access
when executing in the IMS Control Region.

The exit routine, DFSCSGNO, can communicate with RACF-type security routines.
However, the LTERM name associated with the IOPCB is meaningful only within the
SmartTest-IM S session. As specified in the IBM reference manuals, the SCD and CTB
are available to the DFSCSGNO exit. However, these data areas are emul ated by
SmartTest-IMS and may not contain information useful to the exit routine.

The DFSCSGNO exit routine isloaded by SmartTest-IM S during initialization of the test
session. The same copy of the load module remains resident for the duration of the test
session, that is, until an /RCL command is entered or until the user exits from the
SmartTest IMS/DC environment. However, processing of the /SIGN command occurs
under the application task. Consequently, any storage obtained using GETMAIN or any
modul es |loaded by the DFSCSGNO exit are not retained across transactions. Because of
this, the exit must not save addresses of these storage areas within itself with the
expectation that they will be valid for reference on subsequent executions of the /SIGN
command.

The exit routine can obtain the user's TSOID from MV S with this Assembler instruction
sequence:

L R1,PSATOLD GET CURRENT TCB ADDRESS
L R1,TCBTIO-TCB(,R1) GET TIOT ADDRESS
LA R1,TIOCNJOB-TIOT(,R1) POINT TO JOBSTEP NAME=TSOID
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Step 6 - Validating SmartTest-IMS

To verify that the installation completed successfully

Note:

The dataset names used in these validation steps are the default installed names. If you
have changed them, use the changed names where the default names are specified.

1  If you have not executed the CNTL members VIAPOGMJ and VIAPIVPJ, then do
SO Now.

2 Enter SmartTest-IM S by selecting the correct option for your site.

- If you installed SmartTest as described in "Step 4 - Preparing | SPF to Invoke
SmartTest" on page 16, use the appropriate | SPF menu selection or the CLIST
to start SmartTest.

- If you installed the ESW product menu as described in the ASG-Center
Installation Guide, use the appropriate | SPF menu selection or the CLIST to
display the ESW product primary screen. Select Test » Module/Transaction to
display the SmartTest primary screen. If you start SmartTest using the ESW
primary screen, the product name displays as ESW - Testing/Debugging.

3  Select Help » About to verify the product releases and levels of SmartTest-IMS and
Center that are installed. The product names, rel ease numbers, maintenance levels,
and the operating system are displayed.

If SmartTest-IMS does not display in the Product name field, press PF3/PF15 to
return to the SmartTest primary screen. Type ENVIRONMENT and press Enter.
Choose the IMS/DC environment option. Y ou might have to press PF3/PF15 to
return to a screen with the action bar containing the Help action.
Press PF3/PF15 to return to the SmartTest primary screen.

4  Review and/or modify the SmartTest options by selecting Options on the action bar.
a  Sdlect Options » Product Parameters. The Options - Product Parameters

pop-up displays. Review and/or modify the parameter definitions and press
PF3/PF15.
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b  Sdect Options» Log/list/punch to display the Options - Log/List/Punch
Definition pop-up. Review and/or modify the Log, List, and Punch file
defaults.

C Enter the job statement information and press PF3/PF15.

Note:

This step is recommended before proceeding to ensure a valid operating
environment for your user ID. See the online help or the ASG-SmartTest Reference
Guide for descriptions of these options.

To dlocate an AKR, select File » AKR utility. The File- AKR Utility pop-up
displays.

Note:

If you have already created an AKR when validating another ESW product, proceed
to step 6 on page 107.

a CompletetheFile- AKR Utility pop-up by entering the name of an AKR to be
alocated. Type A in the command input area and press Enter.

Thefields on the File - AKR Allocate/Expand pop-up vary depending on the
values for AKR-DSORG-VSAM and SMSin the Center installation options
file.

b  OntheFile- AKR Allocate/Expand pop-up:
—  Veify the AKR name that displays.

—  Typethe SMS classes or the VVolume and space information for the
permanent AKR.

— Type an appropriate Unique parameter for the selected volume.

—  If thisdataset must be cataloged in auser catal og, type C on the command
line and press Enter to display the AKR Catal og Information pop-up.
Type the catalog DSN and password, if applicable.

—  Typethejob statement information for your site and submit the job by
typing S in the command input area and pressing Enter.

—  Veify that the AKR was successfully allocated and initialized.
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Figure 16 is asample of how the File - AKR Allocate/Expand pop-up looks using
SMSand aVSAM AKR.

Figure 16« File- AKR Allocate/Expand Pop-up

File - AKR Allocate~Expand
CoHHand ===

% = BubMit JCL E - Edit JCL L - Epecify Catalog
Expand edisting AKR . . . HO [Tes or Hol
AKR data zet nave . . . . 'UZER12.GENERAL.AKR’
L T T T
Uit o w o w a0 a0 0 ono 12 [Generic unit nane)
Fpace umits . . . . . RECORDE [Records, Tracks or Cylinders)
Pridary space . . . . . 4088 [Prinary anount in abouve units)
Zecondary Space . . . . B [#econdary aHount in abouve units)

Jobk statenent infordHation:
S#USERLZ_ TOE [DEUTRE, 253200,
i HEGCLASE=A
<~k  INZERT '~¢ROUTE PRINT NODE.UZER' HERE IF MWEEDED.
sk

Analyze the demonstration program by selecting File » Compile/Anayze. Enter the
appropriate information on the File - Analyze Submit pop-up.

a  Thecompileand link JCL dataset name field should be
ASG.VIACENXX.CNTL(VIAPIVC).

b Enter the AKR dataset name from step 5 on page 106.

¢  Verify thejob statement and routing information by typing E in the command
input area on the Analyze Submit screen and pressing Enter. Type SUB in the
command input area and press Enter to submit the analyze job.

d Verify that the Analyze job completed successfully.
Set up the VIAPIVP1 demonstration program by typing ENV (the abbreviation for
the ENVIRONMENT command) in the command input area and pressing Enter.

This displays the Environment Selection Menu.

a Verify the AKR and load library names shown. Specify the application load
libraries used in the VIAPIV C (compile/link) member.

b  Tosdect IMS/DC Session Setup, type 4 in the command input area and press
Enter.

¢  Tosdect the 3270 Terminal Emulation environment, type E in the command
input area of the IMS/DC Session Setup screen and press Enter.
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Toindicate that the databases will be allocated to the TSO region, type 1 inthe
command input area of the Setup 3270 Terminal Emulation pop-up and press
Enter.

To display the Execution Options pop-up, type 5 in the command input area of
the Setup DBD/PSB pop-up and press Enter.
Verify that thisdatais as indicated:
IOPCB is set to IOPCB
INITIAL FORMAT is set to blanks
TOGGLE PFKEY isset to PF24
Press PF3/PF15 until the IMS/DC Session Setup screen displays.
To display the GSAM/User File screen, type A in the command input area of
the IMS/DC Session Setup screen and press Enter.
Ensure that the CLIST dataset and member name are valid.
To display the Convert Batch JCL screen, type C in the command input area

and press Enter.

Specify the default JCL library on the Convert Batch JCL screen as
ASG.VIACENXX.CNTL. Specify the Batch Execution JCL member name as
VIAPIMSA.

Verify that the CLIST dataset and member name are valid.

To generate a CLIST from the JCL, type C in the command input area of the
Convert Batch JCL screen and press Enter. A short message displays
indicating successful JCL conversion. Press PF3/PF15 until the IMS/DC
Session Setup screen displays.

Type T in the command input area of the IMS/DC Session Setup screen and
press Enter to display the Select Transactions pop-up.

Type 2 in the command input area of the Select Transactions pop-up and
press Enter to display the Transaction pop-up.

Specify the Transaction Definition Dataset name as ASG.VIACENxX.CNTL
and the member name as VIAPTRAN. Ensure that the All MODBLKS
Transactions field contains NO.

Press PF3/PF15 to return to the Select Transactions pop-up.

Type 1 in the command input area of the Select Transactions pop-up and
press Enter to display the Transaction Definitions screen.
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Type I in the line command area on the Transaction Definitions screen and
press Enter to insert a transaction.

Change the TRANCODE of the inserted transaction to VIAPIVPL and press
Enter.

The TRANCODE is highlighted and an S displaysin the line command area
to signify that this transaction has been selected for testing. Press PF3/PF15
until the IMS/DC Session Setup screen displays.

Test the VIAPIVPL demonstration program by pressing PF4/PF16 (RUN).

This executes the CLIST allocations and displays the message ASG26031
SmartTest-IMS is Active.

Type /FOR VIAPIVFL1 to display the demonstration format screen.

a

With theformat screen being displayed, type OC7 at the cursor and press Enter.
This starts the test and displays the Program View screen.

The status box displays at the bottom of the screen. This box shows aBREAK
AT START OF TEST SESSION status message. The current statement line
is highlighted and contains arrows (>>>>>>) in the line prefix area.

Press PF4/PF16 (RUN). A data exception (0OC7) should occur on the ADD +1
TO FORCED-SOC7-ABEND-COMP3 statement. A window is automatically
displayed noting that FORCED-S0C7-ABEND-COMP3 containsinvalid data.

The comments in the program describe four methods of fixing the abend.
Choose method 1 by overtyping avalid number in the display window. Press
PF4/PF16 (RUN) to resume the test.

The test should now be compl ete and the status box should display a BREAK
ON PROGRAM RETURN status. Press PF4/PF16 again to display the original
format screen.

To verify that the database has been installed, enter any product code at the
cursor and press Enter. Thisstartsthetest again and displaysthe Program View
screen. Once again the status box showsaBREAK AT START OF TEST
SESSION status message.

Press PF4/PF16 (RUN) to execute the program. The test should complete and
the status box should display aBREAK ON PROGRAM RETURN status
message. Press PF4/PF16 again to display the new FORMAT that contains
the product information that you requested from the first FORMAT.

Y ou can return to the original FORMAT by pressing Enter, or use the Clear
key to clear the entire screen. If you chose to clear the screen, type /RCL to
terminate the SmartTest-IM S session.
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This chapter describes how to customize SmartTest-ASM and contains these

sections:

Prerequisite 111
User Abend Codes 111
Validating SmartTest-ASM 112

Prerequisite

ASG-Center and SmartTest product installation and customization must be performed
before customizing SmartTest-ASM. If Center has not been installed, see the ASG-Center

Installation Guide at thistime. For SmartTest product installation, see "Installing and
Customizing SmartTest" on page 5.

User Abend Codes

User abends are listed in online help and the Abend Codes appendix of the ASG-Center
Installation Guide. If an abend that is not listed occurs, check the abend codes for the
source manager that was running at the time of the abend.

m



ASG-SmartTest Installation Guide

Validating SmartTest-ASM

112

To verify that the installation completed successfully

Note:

The dataset names used in these validation steps are the default installed names. If you
have changed them, use the changed names where the default names are specified.

1  Enter SmartTest by selecting the correct option from the menu. Thistests the logon
library allocations.

If you installed SmartTest as described in "Step 4 - Preparing | SPF to Invoke
SmartTest" on page 16, use the appropriate | SPF menu selection or the CLIST
to start SmartTest.

If you installed the ESW product menu as described in the ASG-Center
Installation Guide, use the appropriate | SPF menu selection or the CLIST to
display the ESW product primary screen.

Select Test » Module/Transaction to display the SmartTest primary screen.

If you start SmartTest using the ESW primary screen, the product name
displays as ESW - Testing/Debugging.

2 Sdect Help » About to verify the product releases and level s of SmartTest-ASM and
Center that are installed. The product names, rel ease numbers, maintenance levels,
and the operating system are displayed.

Press PF3/PF15 to return to the SmartTest primary screen.

3 Review and/or modify the SmartTest options by selecting Options on the action bar.

a

Select Options » Product Parameters to display the Options - Product
Parameters pop-up. Review and/or modify the parameter definitions and press
PF3/PF15.

Select Options » Log/list/punch to display the Options - Log/List/Punch
Definition pop-up. Review and/or modify the Log, List, and Punch file
defaults.

Enter the job statement information and press PF3/PF15.
Select Options » PF keysto display the Options - PF Key Definition pop-up.

See the online help or the ASG-SmartTest Reference Guide for more
information about these options.
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To allocate an AKR, select File » AKR utility to display the File - AKR Utility

pop-up.

Note:

If you have already created an AKR when validating another ESW product, proceed
to step 5 on page 114.

a  Completethe File- AKR Utility pop-up by entering the name of a AKR to be
allocated. Type A in the command input area and press Enter.

Thefields on the File - AKR Allocate/Expand pop-up vary depending on the
values for AKR-DSORG-VSAM and SMSin the Center installation options

file.

b Complete these steps using the File - AKR Allocate/Expand pop-up:

Verify the AKR name that displays.

Type the SMS classes or the Volume and space information for the
permanent AKR.

Type an appropriate Unique parameter for the selected volume.

If thisdataset must be cataloged in auser catal og, type C on the command
line and press Enter to display the AKR Catalog Information pop-up.
Type the Catalog DSN and password, if applicable.

Type the job statement information for your site and submit the job by
typing S in the command input area and pressing Enter.

Verify that the AKR was successfully allocated and initialized.

Figure 17 showsthe File - AKR Allocate/Expand pop-up using SMS and aVSAM

AKR.

Figure 17« File- AKR Allocate/Expand Pop-up

o
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File - AKR Allocate-EXpand

HEGCLAZE=A
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Analyze the demonstration programs by selecting File» Compile/Analyze. Enter the
appropriate information on the File - Analyze Submit pop-up. Thisis the compile
and link JCL dataset:

c

ASG.VIACENXX.CNTL(VIAPASMA)

Enter the AKR dataset name from step 4 on page 113.

Verify the JOB card and routing information by typing E in the command input
area on the Analyze Submit screen. Type SUB in the command input area and
press Enter to submit the analyze job.

Verify that the analyze job completed successfully.

Set up the VIAPASM demonstration program by typing SETUP in the command
input area and pressing Enter. The TSO Session Setup screen displays.

a

Change the module to VIAPASM and type ALL in the Execution Parameters
field.

Type C in the command input area and press Enter to select the Convert Batch
JCL screen.

Change the Member field in the JCL Library to VIAPASMJ. Also change the
Member field in the CLIST Library to VIAPASMJ.

To generate a CLIST from the JCL, type C in the command input area and
press Enter. A short message displays that indicates a successful JCL
conversion

Note:
Y ou can also select the CR option on the TSO Session Setup screen, an
option which combines the C and R options. See the ASG-SmartTest for
COBOL and Assembler User’s Guide or the ASG-SmartTest for PL/I User’s
Guide for more information on using the CR option.

Press PF3/PF15 to return to the TSO Session Setup screen.
To display the Test Session Tailoring screen, type LIST TAILOR inthe
command input area and press Enter.

Define an entry of VIA*.VIA* with COUNTS turned on. Define an entry of
IEFBR14.IEFBR14 and set BREAK ON ENTRY to YES.

Press PF3/PF15 to return to the TSO Session Setup screen.

Todisplay the Load Module Intercept List pop-up, type LIST INTERCEPTS
in the command input area and press Enter.
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f Insert an entry for IEFBR14.
g  Press PF3/PF15 to return to the TSO Session Setup screen.

Test VIAPASM by pressing PF4/16 (RUN). This starts the test and displays the
Program View screen.

The status box displays at the bottom of the screen. This box shows a status
message of BREAK AT START OF TEST SESSION. The current statement line
is highlighted and contains chevrons (>>>>>>) in the line prefix area.

Follow the instructions for the validation as documented in the program source.
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6 Customizing APS

This chapter describes how to customize SmartTest-APS and contains these

sections:
Prerequisite 117
Overview 117
Invoking the SmartTest Analyze 118

Prerequisite

ASG-Center and SmartTest product installation and customization must be performed
before customizing SmartTest-APS. If Center has not been installed, see the ASG-Center

Installation Guide at thistime. For SmartTest product installation, see "Installing and
Customizing SmartTest" on page 5.

Overview

Before generating an APS program that is to be debugged using SmartTest, set the APS
DEBUG option on the APS Generator Options panel to Y ES. When you specify YES,

APS can generate the proper macro-like statements in the COBOL source so that
SmartTest can function properly.

117



ASG-SmartTest Installation Guide

Invoking the SmartTest Analyze

118

To invoke the proper SmartTest processing during the compile process, follow this step:

» Submit the final jobstream using the job submit utility VIASUBDS.

To integrate the SmartTest analyze submit facility into the APS product

1

Usethe APS DEBUG field on the APS Generator Options screen (see Figure 18) is
used to invoke the analyze submit facility. The APS Generator Options screenis

provided by INTERSOLV, Inc.

Figure18+« APS Generator Options Screen

OPTION ===>

TARGET 0S

===>

DC ===>

DB
SQL

JOB CLASS
MSG CLASS

LISTGEN
COBOL
OBJECT
MES/BMS
GENSRC

APS DEBUG

APS Parm
COBOL Parm

===>

===>

===>

===>

===>
===>
=_==>
===>
===>

=_==>

===>

=_==>

JOB DEST ===>
CARDIN MEMBER ===>

(Yes or No) COBOL-II ===>
CICS RELEASE ===>
IMS RELEASE ===>

SUPRA ===>
EBCDIC ===>
PC CICS ===>

(MvVS, 0S2, PCDOS, 0S400, VSE)

(IMS, CICS, DLG, DDS, MVS, or ISPF (prototyper))
(IMS, DLI, VSAM, or IDMS)
(0s2DM, XDB, SQLDS, DB2)

(Yes or No)

(1.7, 2.1 or 3.1)
(2 or 3)

(Yes or No)

(Yes or No)

(1BM, MFOCUS)

TypeYES inthe APSDEBUG field and press Enter to processthe APS compile JCL.
If you enter NO in the APS DEBUG field, the compile JCL is submitted without

performing the SmartTest analyze.
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Modify the APS18SUB CLIST. The APS CLIST (APS18SUB) should be modified
as indicated below to process the APS compile JCL. Figure 19 shows this CLIST.

Figure 19+ APSCLIST (APS18SUB)

PROC O
CONTROL NOMSG
/* CLIST(APS18SUB) - APS1802 - 1/15/89 - INTERSOLV
ISPEXEC VGET (SSMMDB SSMIENV SSMIJRVL) ASIS
IF &SSMMDB = IDMS AND &SSMIENV = LOCAL THEN +
DO

IF &SSMIJRVL = DUMMY THEN +
DO

ISPEXEC VGET(SSMIVNO) PROFILE
SET &SSMIVNO = &SSMIVNO +1
ISPEXEC VPUT(SSMIVNO) PROFILE
END
END
ISPEXEC VGET (ZTEMPF ) ASIS
CONTROL MSG
ISPEXEC VGET(SSMEXIT SSMEXPGM SSMEXTYP) PROFILE

IF &SSMEXIT = YES THEN ISPEXEC SELECT &SSMEXTYP(&SSMEXPGM)
SUBMIT "&ZTEMPF*

Thelast line of the APS CLIST, SUBMIT '& ZTEMPF', should be modified as

shown in this example:

ISPEXEC VGET (APANIM) PROFILE
IF "&APANIM®™ = "YES" THEN +
VIASUBDS "&ZTEMPF*
ELSE +
SUBMIT "&ZTEMPF*
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7 Validating PLI

This chapter describes how to validate SmartTest-PLI and contains these sections:

Prerequisite 121
User Abend Codes 121
Validating SmartTest-PL | 122

Prerequisite

ASG-Center, SmartTest, and SmartTest-PLI must be installed and customized before
attempting to validate SmartTest-PLI. If Center has not been installed, see the
ASG-Center Installation Guide at thistime. For SmartTest product installation, see
"Installing and Customizing SmartTest" on page 5.

User Abend Codes

User abends are listed in the Abend Codes appendix in the ASG-Center Installation
Guide. If an abend that is not listed occurs, check the abend codes for the source manager
that was running at the time of the abend.
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To verify that the installation completed successfully

Note:

The dataset names mentioned in these validation steps are the default installed names. If
you have changed them, use the changed names where the default names are specified.

1  Anayzethedemonstration programsby selecting File » Compile/Anayze. Enter the
appropriate information on the File - Analyze Submit pop-up.

a

d

The dataset that contains the compile and link JCL should be
ASG.VIACENXX.CNTL(VIAPPLIC).

Enter the AKR dataset name from "Step 5 - Validating SmartTest
(SmartTest-TSO Only)" on page 17.

Verify the JOB card and routing information by typing E in the command input
areaon the Analyze Submit screen and press Enter. Type SUB in the command
input area and press Enter to submit the analyze job.

Verify that the analyze job completed successfully.

2  SetuptheVIAPPLI demonstration program by typing SETUP inthe command input
area and pressing Enter. The TSO Session Setup screen displays.

a

Change the module to VIAPPLI and type ALL in the Execution Parameters
field. To select the Convert Batch JCL screen, type C in the command input
area and press Enter.

Note:
Y ou can also select the CR option on the TSO Session Setup screen, an
option which combines the C and R options. See the ASG-SmartTest for
COBOL and Assembler User’s Guide or the ASG-SmartTest for PL/I User’s
Guide for more information on using the CR option.

Change the Member field in the JCL Library to VIAPPLIJ. Also change the
Member field in the CLIST Library to VIAPPLIJ.

To generate a CLIST from the JCL, type C in the command input area and
press Enter. A short message displays that indicates a successful JCL
conversion. Press PF3/PF15 to return to the TSO Session Setup screen.

To display the Test Session Tailoring screen, type LIST TAILOR inthe
command input area and press Enter.
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Define an entry of VIA*.VIA* with COUNTS turned on. Define an entry of
IEFBR14.|IEFBR14 and set BREAK ON ENTRY to YES.

Press PF3/PF15 to return to the TSO Session Setup screen.
Todisplay the Load Module Intercept List pop-up, type LIST INTERCEPTS

in the command area and press Enter. Insert an entry for IEFBR14 and press
PF3/PF15 to return to the TSO Session Setup screen.

3  Test VIAPPLI by pressing PF4/16 (RUN). This starts the test and displays the
Program View screen.

a

The status box displays at the bottom of the screen. This box shows a status
message of BREAK AT START OF TEST SESSION. Thecurrent statement
line is highlighted and contains chevrons (>>>>>>) in the line prefix area.

Follow the instructions for the validation as documented in the program
source.
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8 Customizing Stored Procedures

This chapter describes how to use SmartTest profiles and contains these sections:

Prerequisite 125
Step 1 - Modifying CNTL Library Member 126
Step 2 - Updating the DB2 Environment for Multiple DB2 Subsystem 127
Support

Step 3 - Executing VIAPBIND 127

Prerequisite

ASG-Center and SmartTest product installation and customization must be performed
before customizing the SmartTest Stored Procedure option. If Center has not been
installed, see the ASG-Center Installation Guide at thistime. For SmartTest product
installation, see "Installing and Customizing SmartTest" on page 5.
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To modify VIAPBIND

Note:

A complete list of all SmartTest CNTL members and their descriptionsis availablein
Appendix F, "SmartTest CNTL and CLIST Members," on page 153.

1  Editthe CNTL member VIAPBIND and verify or change these fields:

VIASOFT='ASG' Specify the high-level node for the ESW
libraries.
CENTER="VIACENXxX' Specify the middle-level node for the ESW

libraries, where xx isthe ESW version number.

DB2LI1B=DSN410.DSNLOAD  Specify the name of the DB2 |oad library.

2  Veify or change the parameters following this statement:

//BIND_SYSTSIN DD *

DSN SYSTEM Specify the name of the DB2 subsystem for the bind.
PLAN Specify the name of the Plan to be used for ESW access
of the DB2 catalog.
Note:

The PLAN name entered for this parameter is also entered in the VIASPRMP
member in the CNTL library for the installation option DB2-Procedure-Plan.

3 Veify or change the parameters following this statement:

//BIND.SYSIN DD *

PLAN Specify the name of the plan to be used by DSNTIAD (i.e., modify
DSNTIAXX, where xx isthe DB2 release number).

LIB Specify the name of the DB2 Load library where DSNTIAD is
located.
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Step 2 - Updating the DB2 Environment for Multiple DB2
Subsystem Support

To accommodate multiple DB2 subsystems

If your site has more than one DB2 subsystem, make these additional modifications to
VIAPBIND:

1  Locatethe BIND step in the instream PROC. Repeat the BIND step for each DB2
subsystem at your site. In each repeated BIND step, change BIND to BIND1,
BIND2, and so forth. For example, if you have four subsystems, you should have
four BIND steps: BIND, BIND1, BIND2, and BIND3.

2 Locate the //BIND.SY STSIN DD and //BIND.SY SIN DD statements. For each
BIND step added in "Step 1 - Modifying CNTL Library Member" on page 126,
repeat the //BIND.SY STSIN DD and //BIND.SY SIN DD statements. In each
repeated set of control statements, change BIND to BIND1, BINDZ2, and so forth. In
the SY STEM(????) parameter for each step, change ???? to represent the
appropriate DB2 subsystem.

Step 3 - Executing VIAPBIND

After making the necessary changes to the JCL parametersin VIAPBIND, execute the
job to create the necessary plan(s).

Note:
VIAPBIND performs the BIND and grants PUBLIC access to the plan.
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Appendix A
COBOL Compiler Options

Introduction

Thetablesin this appendix list the COBOL compiler options used by SmartTest. Each
table contains the options that apply to a particular type of compiler.

Note:
A SmartTest analyze automatically forces these optionsto their required settings, so your
standard compile/link JCL is usually acceptable. For the SY SPRINT listing, the
SmartTest analyze tries to approximate the options provided by your site defaults and
JCL. For example, if you specify NOSOURCE, the SmartTest analyze forces SOURCE
for the compile, then strips the source statements out of the output listing before printing.

COBOL Il Compiler Option
This table describes the COBOL Il (and later) compiler options:

Required Related

Compiler Option Option Comments

LIST NOOFFSET Required to establish the location of verbs and
paragraph/section names.

MAP Required to establish the location of dataitemsin the
user’s load module.

NONUM Required for compiler generated line numbers.

NOOFFSET LIST Required because OFFSET overrides LIST.

SOURCE Required.

NOOPTIMIZER Highly recommended for testing.
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CA-OPTIMIZER Il Compiler Option
This table describes the CA-OPTIMIZER compiler options:

Comments
LIST NOOFFSET  Required to establish the location of verbs and
paragraph/section names.
MDMAP Required to establish the location of dataitemsin the
user’s load module.
NONUM Required for compiler generated sequence numbers.
NOOFFSET  LIST Required because OFFSET overrides LIST.
SOURCE Required.

Compiler Limitations

COPYLIBs With Debug Limitations

Currently, Analyze ignores (i.e., does not expand) copybooks that are flagged as DEBUG
statements when the DEBUG option is not active. The COBOL compiler expands these
entries, flagging each expansion line as DEBUG (i.e., acomment line since DEBUG is
not active). The result is that the line numbers between the COBOL source and the
Analyze source are different after the point of the COPY LIB insertion. Such programs
produce sequence errors. These programs can be viewed by SmartTest; however,
STEPping, BREAKIng, and viewing disassembled code can produce unpredictable
results.

Compiler Optimization Limitations

130

SmartTest processes COBOL Il and later programs compiled with the OPTIMIZE
compiler option, with these limitations:

. When testing with the ASM option ON, the disassembled code that displays for
repeated code segments (i.e., embedded PERFORMS or subprograms) is shown
only for the first occurrence of such code (i.e., the lowest address).

. When inserting pseudo code into repeated code segments (i.e., embedded
PERFORMSs or subprograms), you cannot insert user labels. Thisis because all
pseudo code variables and labels are global, and insertion of multiple labels (one for
each occurrence of the code) causes duplicate |abels.
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When inserting pseudo code into repeated code segments (i.e., embedded
PERFORM S or subprograms), avoid the use of the & COUNT interna variable.

& COUNT maintains a separate instruction count for each separate occurrence of
the repeated code. Instead, create a pseudo code variable, increment it on each pass
through the pseudo code, and test the pseudo code variable rather than the

& COUNT variable.

When issuing the LIST COUNTS command, the default ordering is by execution
address, not line number as stated on the screen. The result is that the same
sequence of line numbers displays multiple times, once for each occurrence of
repeated code segments. Each repeated line has its own independent execution
count.

Certain source lines might appear to be unexecutable from the Program View
screen, and cause unexpected results for commands such as STEP, BREAK, and
ZA (Zoom Assembler).

Compiler optimization aso affects the reliability of certain SmartTest data display
functions. These are some limitations that result from compiling with the OPTIMIZE
compiler option:

A variable value can reside in aregister rather than in the storage where the variable
has been assigned. SmartTest displays the contents of the storage to which the
variable has been assigned.

In the object code, code associated with one statement can appear to be part of a
different statement.

After optimization, code generated for a statement is dependent on register values
loaded by code for preceding statements. Changing the path of flow in a program
with the GO command can therefore deprive statements of necessary inpuit.

A breakpoint may not actually occur at the beginning of the code generated for the
statement at which it was set.

For additional information about the effects of compiler optimization, see the COBOL 11
Application Programming Guide.

Any compiler optimization can result in relocation, combination, or elimination of
underlying code generated for any COBOL statement. The STEP function and insertion
of pseudo code in SmartTest can therefore be affected.
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Appendix B
Interim Modifications

This appendix describes the procedures for requesting help and for applying PTFs.

Problems or Questions

If you have questions or problems:

1 Gather al applicable JCL listings, output listings, online log file listings, screen
messages or screen prints, and diagnostic information.

2  Cadl ASG Customer Support.

Applying Interim Modifications

Periodic product updates are provided between major releases. Modifications are
supplied in AMASPZAP format.

Place modificationsin the ASG.VIACENXX.PTF dataset that was included on the
installation tape. This PDS contains these two members when installed:

. SPZAPICL, which contains the JCL to apply AMASPZAP modifications.
. SAMPLPTF, which contains adummy PTF.

Y ou can add PTFsto the ASG.VIACENXX.PTF dataset as needed.
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If you decide to apply SmartTest-CICS maintenance while your CICS test region is
running, execute this sequence.

To activate the new product level in the CICSregion

1

When no SmartTest sessions are active in the region, access the region as you
normally would (not through SmartTest) and on a clear screen type:

VIAl STOP

If there are no users in session, you receive the message ASG27621
ASG-SMARTTEST HAS BEEN STOPPED.

Perform a CEMT NEWCOPY on al the PPT modules for SmartTest by issuing this
command:

CEMT SET PR(VIA*) NEWCOPY
On aclear screen type this command:
VIAI START

After you receive the message, ASG27601 ASG-SMARTTEST Rx.y IS
ACTIVE FOR CICS Xx.y., SmartTest isfully updated in the CICS region.

Note:

If there are usersin session, the message ASG27661 SMARTTEST 1S IN AN
ACTIVE SESSION, THE ““STOP” REQUEST WAS IGNORED displays. You
cannot continue with the NEWCOPY of the SmartTest modulesin the CICSregion
at thistime.
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SmartTest User Tables and Exits

Introduction

This section describes the Step Exclusion table, Module Exclusion table, Backtrack
Control table, and the Batch Submit Exit. These tables and exits are used to identify the
modules and CSECTsto be:

. Excluded from the STEPping feature.
. Excluded from monitoring during atest session.

. Checked for authorization to do a SUBMIT command (SmartTest-TSO only).

These tables are located in the ASG.VIACENXX.CNTL dataset.

Step Exclusion Table

The Step Exclusion table (VIAPEMXS) is used to identify the modules and CSECTs that
are not to be STEPped through during execution time. These modules and CSECTs are
ignored unless explicitly requested from the Session Tailoring screen.

Use the VIAPNOST macro to enter each exclude entry. This macro has two operands,
MOD and PGM. If you omit either operand, the default value of * (asterisk) isused. The
* indicates that the definition is generically specified. Y ou can only specify an* asa
suffix for a program or module name.
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Examples

VIAPNOST MOD=ACME,PGM=TEST Skipsthe TEST CSECT for only the ACME

load module.

VIAPNOST PGM=ACME Skipsall CSECTS named ACME for any load
module.

VIAPNOST MOD=PROD* Skips all CSECTsfound in load modules that
begin with PROD.

VIAPNOST MOD=*,PGM=* Thistype of entry is not permitted.

Caution! Use of generic names can cause conflicts with SmartTest if the entry istoo
genericinnature. For example, if you enter *.* , STEPping doesnot occur unless
overridden by the user.

The JCL to assemble and link-edit the Step Exclusion table is contained in the
VIAPEXIT member of ASG.VIACENXX.CNTL.

Module Exclusion Table

136

Use the Module Exclusion table (VIAPEMEX) to identify modules that are to be
excluded from monitoring during atest session. Control is passed to these modules and
SmartTest isleft in a suspended state. Pseudo code and other monitoring features are not
available for excluded modules. Program checks and abends are still intercepted and
reported; however, continuation from the point of the abend is not possible.

Modules to be excluded must follow these standard MV S linkage conventions:

. External modules are called through BALR, BAL, BAS, or BASSM.

. CSECTs within the monitored module are called through BALR 14,15.

. RETURN isthe next instruction after the BRANCH.

Do not add generics for COBOL subroutines, such as ILBO or IGZ. Names entered in
this table apply to load modules and CSECTSs.
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Module Exclusion Table Examples

DC CL8DATABASE'  Specific module name 'DATABASE'
DC CL84DATA' Any module beginning with 'DATA'
DC 8X'FF End of table delimiter

Generic entries must have the length included with the module name. Thislist of
excluded module names are provided as defaults by SmartTest:

3DSN DB2 modules
3IKJ TSO modules
3IST VTAM Modules
CPXCEM Optimizer

Users of Datacom, IDMS, Supra, etc., should review the commented entries.

JCL to assemble and link-edit the Module Exclusion tableis contained in the VIAPEXIT
member of ASG.VIACENXX.CNTL.

Excluded modules that issue the MVS STAE and SPIE macros interfere with the
operation of SmartTest. Unpredictable results can occur.

Backtrack Control Table

Use the SET BACK size command to specify the size of the Backtrack execution history
to be allocated. The size becomes the default buffer size for the current environment.
SmartTest maintains two default buffer sizes, one for the CICS environment and one for
al other environments.

The Backtrack execution history resides above the linein al environments. In the CICS
environment, the Backtrack execution history isin the CICS address space for each user.

The current Backtrack buffer size is shown on the Test Session Options panel, which
displays by typing SET with no operands.

A default sizeis determined from the user modifiable Backtrack Control table
(VIAPBTTB).

The default size is used:
. If the SET BACK size command has never been executed.
. After the SET DEFAULTS command.

. After the SET BACK 0 command.
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A tableis supplied that sets default values for every user:
CICS- 100K  Other environments - IMB

If thetable VIAPBTTB is not found or an entry for a USERID is not found, then the
defaults of 100K for CICS and 1IMB for other environments are used.

In addition to setting default sizes, the tableis also used to establish maximum allowable
Sizes to be used for the Backtrack execution history.

For CICS, the table resides in the TSO/I SPF user's address space.

Thistable is assembled and link-edited as a part of module VIAPBTTB. It providesthe
ability to set default and maximum size values for the Backtrack execution history, for
the TSO and CICS environments, by individual USERID.

A sampletableis provided that sets default and maximum allowable values for a generic
USERID. The table allows for wildcard charactersto define patterns for the USERID.
Thefirst table entry that is found to match the USERID is used.

A default Backtrack execution history tableis supplied asload module VIAPBTTB. The
default sizeis IMB for TSO and 100K for CICS. The maximum values alowed are BM B
for TSO and 1MB for the CICS environment. Reassemble and relink VIAPBTTB to
change these values.

The sampletable shown in Figure 20, as provided in control library member VIAPBTTB,
contains:

Figure20« VIAPBTTB Sample Table

SAMPLE ENTRY FOR TSO USERID *"'SYSPROG"

VIABKTRK USERID=SYSPROG, TSODEF=8M, TSOMAX=8M,CICSDEF=4M, CICSMAX=4M

SAMPLE ENTRIES THAT USE A PATTERN FOR USERID
VIABKTRK USERID=USERID*, TSODEF=4M, TSOMAX=8M, CICSDEF=100K, CICSMAX=500K
VIABKTRK USERID=???PAY , TSODEF=4M, TSOMAX=8M

ENTRY THAT PROVIDES VALUES FOR ALL USERIDS THAT WERE NOT
COVERED BY A PRIOR ENTRY IN THE TABLE.

ook X o 3k X ok X % ok X F %

VIABKTRK *
USERID=*, USERID PATTERN *
TSODEF=1M, TSO DEFAULT SIZE *
TSOMAX=8M, TSO MAXIMUM SIZE *
CICSDEF=100K, CICS DEFAULT SIZE *
CICSMAX=1M CICS MAXIMUM SIZE
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Thefirst pattern in the table that matches the TSO USERID is used to set the default
values and maximum allowable values for that USERID.

The question mark (?) character in a pattern matches exactly one character in that
position. The asterisk (*) character matches zero or more characters. The* character and
the ? character can both be used in the same pattern.

Note:

Specifying a maximum buffer size of zero for TSOMAX or CICSMAX disables
Backtrack for that environment.

To update the Backtrack Control table
1 Modify member VIAPBTTB in the control library

2 Submit the assemble and link job VIAPBTT.J.

Batch Submit Exit (SmartTest-TSO Only)

Use the Batch Submit Exit (VIAPEXSB) to check the TSO user’ s authority to perform a
SUBMIT command. If the TSO user is not allowed to issue the SUBMIT command, a
non-zero return code is passed back to the calling program. The calling program then
displays a message indicating the SUBMIT was rejected by the user exit. Seethe
SUBTABLE label in the user exit to add user IDs. The JCL to assemble and link-edit the
Batch Submit Exit is contained in the VIAPEXIT member of ASG.VIACENXX.CNTL.
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Appendix D
SmartTest-CICS User Exits

User Exit 1 - Initialization Exit

User Exit 1, shown in Figure 21, isthe Initialization Exit. Thisexit is optional and is used
to define static storage areas to SmartTest-CICS that can be modified by monitored
programs. To use this exit, specify EXIT1=YES on the Environment Table. For more
information, see "Installing and Customizing SmartTest" on page 5.

Figure2le User Exit 1 - Initialization Exit

MACRO 00010000
VIACEXO1 , 00020000

* ASG, INC. ASG-SMARTTEST RX.X MMM YYYY * 00040000
* * 00050000
* OPTIONAL USER EXIT #1. INITIALIZATION EXIT. * 00060000

THIS IS A SAMPLE USER WRITTEN INITIALIZATION EXITO1 FOR SMARTTEST. * 00080000
00090000
00100000
00110000
00120000
00130000
00140000
00150000
00160000
00170000
00180000

*
*
IF USED, IT IS INVOKED FROM PROGRAM VIACEMAL DURING SMARTTEST *
*

*

*

*

*

*

*

*

1) FIXED MEMORY LOCATIONS THAT WILL BE USED AS READ/WRITE AREA * 00190000

*

*

*

*

*

*

*

*

*

*

INITIALIZATION.

ITS PURPOSE IS TO PROVIDE A MEANS OF SPECIFYING USER DEFINED AREAS
FOR USE AS READ/WRITE STORAGE (OR EXECUTABLE CODE) THROUGHOUT THE
LIFE OF THE CICS SESSION.

THAT IS -

(FOR EXAMPLE AN MVS GETMAINED AREA) 00200000
00210000
00220000
00230000
00240000
00250000
00260000

2) PROGRAM CODE BRANCHED TO DIRECTLY FROM APPLICATION PROGRAMS
(OTHER THAN CODE LOADED BY DFHPCP AS APPLICATION PROGRAM)

ONLY AREAS THAT REMAIN STATIC AFTER INITIALIZATION SHOULD BE
HANDLED BY THIS EXIT. AREAS THAT ARE OBTAINED, RELEASED AND

ok % % ok o b b X % 3k ok b o % X X 3k ok ok F X X X

RE-OBTAINED DURING THE CICS SESSION SHOULD BE HANDLED BY THE 00270000
DYNAMIC STORAGE VALIDATION EXIT (VIACEX02). 00280000
00290000

THE AREAS SPECIFIED TO ASG-SMARTTEST MUST HAVE ASSOCIATED DUMMY PPT* 00300000
ENTRIES IN BOTH CASES.... * 00310000
* 00320000

DFHPPT TYPE=ENTRY , PROGRAM=XXXXXXXX,RES=NO * 00330000
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ok % ok ok b b %k 3k b o o X X 3k b b o % X X ok

IF SPECIFYING AN ALLOWABLE AREA, THE ONLINE PROTECTION FACILITIES
SHOULD BE USED TO ADD AN "ALLOW"™ FOR THIS PROGRAM.
EXAMPLE -

AREA NAME OFFSET  LENGTH  PROTECT

PGM XXXXXXXX 0 9999 NO

SHOULD BE USED TO ADD AN "ALLOW"™ FOR THIS PROGRAM.
EXAMPLE -

AREA NAME OFFSET  LENGTH  PROTECT

PGM XXXXXXXX 0 9999 NO

TO USE THIS EXIT, SPECIFY "EXITO1 = YES® IN THE OPTIONS SECTION OF
THE ENVIRONMENT TABLE GENERATION CARD (VIACEMT1).

*
*
*
*
*
*
*
IF SPECIFYING AN ALLOWABLE AREA, THE ONLINE PROTECTION FACILITIES *
*
*
*
*
*
*
*

A) SET THE NAME OF THE CODE/MEMORY (INTO *"NAME™)
B) LOAD THE ADDRESS OF THE CODE/MEMORY (INTO REG 1)
C) LOAD THE LENGTH OF THE CODE/MEMORY (INTO REG 0)
D) LINK TO LABEL "STOW® AND RETURN

E) REPEAT A-D UNTIL ALL SEPARATE AREAS ARE SPECIFIED

*
*
*
*
*
*
*
*
NOTES *
* ===== *
* 1. ONLY REGISTERS 0,1,9 AND "LINK® MAY BE USED AS SHOWN. *
* 2. R6 IS THE BASE REGISTER FOR THE EXIT. *
* 3. WORK REGISTERS MAY BE USED BUT MUST BE SAVED AND RESTORED *
* BEFORE BRANCHING TO "STOW® OR RETURNING ON R9. *
* 4. A SAVE AREA IS PROVIDED IF NEEDED NAMED “U2SAVE® *
* 5. THE ACTUAL ADDRESS/LENGTH FOR EACH NAMED AREA MUST BE *
* CALCULATED USING YOUR OWN ALGORITHM. *
* 6. INCLUDE AN "ALLOW® TABLE ENTRY USING THE "STORAGE PROTECTION"*
* SCREEN. (SEE NOTE ABOVE). *
* *
* - FOR EXAMPLE: IF THE SPECIAL CODE IS LOCATED VIA AN ADCON - *
* - WITHIN THE C.1.C.S. CWA AREA - *
* _ ; _ *
* - MVC  NAME,=CL8"CWACODE" - *
* - L R1,512+20(R13) EXTRACT CWA FIELD - *
* - L RO,16(R1) LOAD LENGTH (ASSUMING LENGTH 1S - *
* - BAL  LINK,STOW HELD IN FULLWORD AT - *
* - OFFSET 16 WITHIN CODE)- *
* - .ETC -
K *
*
* * o *
* * INITIALIZATION EXIT STARTS HERE *
* * o *
EXITO1  CSECT MUST BE PRESENT
ORG *- ORG OVER EARLIER "BR R9" INSTR
USING EXITO1,R6 TELL ASSEMBLER THE BASE REG.
* * *
* * TELL SMARTTEST THE NAME, ADDR AND LEN OF SPECIAL AREA 1. *
* * *

MVC  NAME,=CL8"MYCODE1" SET NAME OF MY FIRST CODE AREA A.
L R1,=A(ADDRESS OF SPECIAL CODE 1) SEE NOTE 4.ABOVE B.
L RO,=A(LENGTH OF SPECIAL CODE 1) SEE NOTE 4.ABOVE C.
BAL  LINK,STOW GO TO SAVE INFORMATION D.

00340000
00350000
00360000
00370000
00380000
00390000
00400000
00350000
00360000
00370000
00380000
00390000
00400000
00420000
00430000

PROVIDE YOUR OWN LOGIC TO :-

00470000
00480000
00490000
00500000
00510000
00520000
00530000
00540000
00550000
00560000
00570000
00580000
00590000
00600000
00610000
00620000
00630000
00640000
00650000
00660000
00670000
00680000
00690000
00700000
00710000
00720000
00730000
00740000
00750000
00760000
00770000
00780000
00790000
00800000
00810000
00820000
00830000
00840000
00850000
00860000
00870000
00880000
00890000
00900000
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*

*

* TELL SMARTTEST THE NAME, ADDR AND LEN OF SPECIAL AREA 2.

MVC  NAME,=CL8"MYCODE2®"  SET NAME OF MY FIRST CODE AREA

L R1,=A(CADDRESS OF SPECIAL CODE 2) SEE NOTE 4.ABOVE
L RO,=A(LENGTH OF SPECIAL CODE 2) SEE NOTE 4.ABOVE
BAL  LINK,STOW GO TO SAVE INFORMATION

* * *

*

* RETURN TO SMARTTEST®S INITIALIZATION USING R9. *

BR R9 RETURN

LTORG , GENERATE LITERALS
* A e e *
* * END OF USER EXIT 01 *
* K *

MEND

B.
C.
D

*

*

AL

00910000
00920000
00930000
00940000
00950000
00960000
00970000
00980000
00990000
01000000
01010000
01020000
01030000
01040000
01050000
01060000

User Exit 2 - Storage Validation Exit

User Exit 2, shown in Figure 22, is the Storage Validation Exit. This exit can optionally
be used to dynamically override the SmartTest-CICS storage protection rules. To usethis

exit, specify EXIT2=YES on the Environment Table. For more information, see

"|Installing and Customizing SmartTest" on page 5.

Figure22 « User Exit 2 - Storage Validation Exit

* ASG, INC. ASG-SMARTTEST Rx.X MMM YYYY * 00020000
* * 00030000
* OPTIONAL USER EXIT #2. STORAGE VALIDATION EXIT. * 00040000
MACRO 00060000
VIACEX02 , 00070000

.* THIS IS A SKELETON "USER WRITTEN® DYNAMIC EXIT(EXIT2) FOR SMARTTEST* 00090000

PROVIDE FURTHER USER VALIDATION OF A TARGET ADDRESS AND LENGTH
BEFORE DECIDING TO GIVE A "STORAGE VIOLATION" ERROR.

TO USE THIS EXIT, CODE THIS MACRO PER EXAMPLE AND ASSEMBLE
SMARTTEST TABLES SPECIFYING "EXIT2=YES".

.* .* .* .* .* .* .* .* .*

.* OF TEST AND LOOPS PERFORMED, OTHERWISE A DEGRADATION OF
.* THE RESPONSE TIMES MAY BE NOTICED WITH SMARTTEST PROTECTED TASKS

*

.* PROGRAM CHECKS MUST NOT OCCUR IN THIS ROUTINE, SO PERFORM ANY

-* NECESSARY VALIDATION ON INTERMEDIATE ADDRESSES USED TO CALCULATE

.* ADDRESS/LENGTHS BEFORE USING IN INSTRUCTIONS WHICH ACCESS STORAGE.

*

.* IF A PROGRAM CHECK DOES OCCUR, PSW+ REGS ARE IN VIACEMSP PROGRAM
.* AT OFFSET +X"34" IMMEDIATELY AFTER THE PROGRAM CHECK.

*

IF USED, IT IS INVOKED FROM THE VALIDATION ROUTINE OF SMARTTEST TO *

*

L B

*

*

*

*

*

*

00100000
00110000
00120000
00130000
00140000
00150000
00160000
00170000

THIS ROUTINE IS EXTREMELY PERFORMANCE CRITICAL. MINIMIZE THE NUMBER* 00180000

00190000
00200000
00210000
00220000
00230000

* 00240000

*

*

*

00250000
00260000
00270000
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* 00280000

*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*

REGISTER USAGE:

RO - RESERVED ** DO NOT USE ***
R1 - RESERVED ** DO NOT USE ***
R2 - WORK REG

R3 - WORK REG

R4 - RESERVED ** DO NOT USE ***
R5 - RESERVED ** DO NOT USE ***
R6 - WORK REG

LINK(R7) - WORK REG USED FOR LINKAGE
R8 - WORK REG

R9 - WORK REG

R10 - WORK REG

R11 - WORK REG

R12 - TCA

R13 - CSA

R14 - RESERVED ** DO NOT USE ***
R15 - BASE REGISTER

00310000
00320000
00330000
00340000
00350000
00360000
00370000
00380000
00390000
00400000
00410000
00420000
00430000
00440000
00450000
00460000
00470000
00480000
00480000
00490000
00500000
00510000
00520000
00530000

ok % % o ok ok F

THIS EXAMPLE ILLUSTRATES THE FOLLOWING:

1) FOR ONLY THE PROGRAM NAMED *SPECIAL®, ALLOW AN AREA IN THE CWA

FOR A LENGTH OF 128 BYTES TO BE UPDATED.

2) FOR ALL PROGRAMS, ALLOW AN AREA WHICH IS INDIRECTLY ADDRESSED
FROM THE CWA, FOR A LENGTH CONTAINED IN THE 1ST TWO BYTES OF THE

AREA, TO BE UPDATED.

00560000
00570000
00580000
00590000
00600000
00610000
00620000
00630000

*

NOT1

*k

CWA

CLC U2PGM,=CL8"SPECIAL" OPTIONAL TEST OF CURRENT PROGRAM

BNE  NOT1 NOT THE ONE
** ONLY FOR SPECIAL PGM ***

LA  R6,512(R13) POINT TO CWA (CSA+X"200%)

USING CWA,R6

L R2,CWAFLD1  LOAD ADR OF AREA

LH  R3,=H"128"  LOAD LENGTH
BAL  LINK,VALADR TRY THIS AREA
EQU *

R, *

* ITEM 2 *

L R2,CWAFLD2 LOAD ADR OF AREA 2
* SHOULD CHECK R2 IS VALID ADR BEFORE USING IN NEXT INSTR.

L R2,20(R2) PICK UP ADDRESS FROM +20
* SHOULD CHECK R2 1S VALID ADR BEFORE USING IN NEXT INSTR.
LH R3,0(R2) LOAD LENGTH FROM 1ST TWO BYTES

* EVEN IF GARBAGE ADDR IN R2 AT THIS POINT WILL NOT PGM CHK
BAL  LINK,VALADR TRY THIS AREA

COPY IN MY DSECTS, AND THEN RESUME CSECT

COPY DFHCSADS

EQU *

00650000
00660000
00670000
00680000
00690000
00700000
00710000
00720000
00730000
00740000
00750000
00760000
00770000
00780000
00790000
00800000
00810000
00820000
00830000
00840000
00850000
00860000
00870000
00880000
00890000
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*x COPY CSAWADS COPY USER CWA 00900000
EX1TO2  CSECT RESUME CSECT 00910000
* 00920000
* * DROP THROUGH TO RETURN TO CALLER * 00930000
* 00940000

MEND 00950000

User Exit 3 - Terminal 1/0O Optimization Exit

User Exit 3 has been removed as of SmartTest Version 2.1. It isno longer needed.

User Exit 4 - ACB Naming Exit

User Exit 4, shown in Figure 23, is the ACB Naming exit used to specify alist of ACB
names that the VIACVTAM module uses to establish the TSO-CICS connection. This
user exit allows you to customize the specified ACB namesin the CNTL member
VIACVTAM. To usethisexit, link edit VIACEXO04 to alibrary that can be loaded from
STEPLIB, JOBLIB, LINKLIST, or LPA.

Figure 23« User Exit 4 - ACB Naming Exit

* ASG, INC. ASG-SMARTTEST Rx.Xx MMM YYYY * 00020000
* * 00030000
* OPTIONAL USER EXIT #4. PROVIDE VTAM ACB NAMES TO ASG-SMARTTEST * 00040000

* 00060000
*  VIACEX04 CAN BE USED TO SPECIFY A LIST OF ACB NAMES THAT 00070000
* VIACVTAM WILL USE TO ESTABLISH THE TSO-CICS CONNECTION. 00080000
* 00090000
* ON ENTRY TO VIACEXO04: 00100000
* 00110000
* REGISTER 13 CONTAINS THE ADDRESS OF A SAVE AREA. 00120000
* REGISTER 14 CONTAINS THE RETURN ADDRESS, AND 00130000
* REGISTER 15 CONTAINS THE ENTRY POINT OF VIACEXO04. 00140000
* 00150000
* R9->VTAM-TSO Communication block and provides addressability 00160000
* to the following (3) data items: 00170000
CSALS EQU X°D8",8 +D8 - CICS alias name, char(8) 00180000
CSACB EQU X"3C-,8 +3C - CICS ACB name, char(8) 00190000
TSOAPL EQU X"347,8 +34 - TSO applic. id, char(8) 00200000
* 00210000
* 00220000
*  THE USER MUST SAVE THE REGISTERS ON ENTRY AND RESTORE THEM ON EXIT. 00230000
* 00240000
* 00250000
*  ON RETURN: 00260000
* 00270000
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ook % % % ok o o % X X 3k ok F % %

REGISTER 15: SHOULD CONTAIN A COMPLETION CODE: A PLUS VALUE

WILL CAUSE THE CONNECTION ATTEMPT TO BE ABANDONED.

IF ZERO, THEN REGISTER O SHOULD CONTAIN THE ADDRESS
OF A LIST OF ACB NAMES THAT CAN BE USED FOR THIS

SESSION.

A NEGATIVE VALUE WILL CAUSE THE ACB NAME SELECTION
MECHANISM TO CONTINUE AS IF NO EXIT WERE PRESENT.

EACH ACB NAME IN THE LIST MUST BE 8 CHARACTERS (LEFT
JUSTIFIED AND PADDED WITH BLANKS) AND EACH LIST SHOULD BE
DELIMITED BY X"FF*.

FOLLOWING 1S A SAMPLE EXIT ROUTINE.

PRINT NOGEN

VIACEX04 CSECT

B START-VIACEX04(R15) BRANCH AROUND CONSTANTS

DC CL8"VIACEX04* MODULE ID EMBEDDED IN CODE.
DC CL8"&SYSDATE" DATE AND TIME OF ASSEMBLY...
DC CL8"&SYSTIME" ...IMBEDDED IN CODE.
START STM  R14,R12,12(R13) SAVE CALLERS REGS IN CALLERS SA.
LR R12,R15 GET EP IN R12.
USING VIACEX04,R12 ADDRESSABILITY FOR MODULE
ST R13,SAVE+4 SAVE CALLERS SA POINTER IN MY SA.
LA R9,SAVE ADDR OF MY SA IN R9.
ST R9,8(,R13) STORE THAT INTO CALLERS SA
LR R13,R9 ADDR OF MY SA IN R13.

L B B B ) LN I N

L I N B ]

You can call your own (authorized) program to obtain the LU
name of the TSO terminal. The chain is

PSA -> ASCB -> TSB -> TSBX -> TVWA -> NIB
You might want to select by CPUID. The following instructions
just get the SID.

L R4,16 LOAD THE CVT ADDRESS

USING CVT,R4 ESTABLISH ADDRESSABILITY

L R4 ,CVTSMCA EXTRACT THE SMF ADDRESS FROM CVT
USING SMCABASE,R4 ESTABLISH ADDRESSABILITY

MvC  SID,SMCASID SAVE SID

EE S L R S L

IT you want to use your TSO terminal ID and you have RACF, this
can be obtained from the ACEE as follows:

USING PSA,O

L R4 ,PSAAOLD THIS USER®"S ASCB
L R4,X"6C"(,R4) THE ASCB EXTENSION
L R4,X"C8"(,R4) THE ACEE

USING ACEE,R4
MVC  TERMID,ACEETRID

* ok Kk ok ok Kk Kk ok Kk Kk ok Kk Kk Kk Kk ok ok ok ok Kk Kk ok Kk Kk ok Kk Kk ok Kk ok ok Kk oKk

Suppose you need the TSO user ID. That also is available from
the ASCB:

USING PSA,0

L R4 ,PSAAOLD THIS USER"S ASCB

L R4,X"B0"(,R4) TSO USERID (JOB NAME)
MVC  USERID,O0(R4)

00280000
00290000
00300000
00310000
00320000
00330000
00340000
00350000
00360000
00370000
00380000
00390000
00400000
00410000
00420000
00430000

00450000
00460000
00470000
00480000
00490000
00500000
00510000
00520000
00530000
00540000
00550000
00560000
00570000
00600000
00610000
00620000
00630000
00640000
00650000
00660000
00670000
00680000
00690000
00700000
00710000
00720000
00730000
00740000
00750000
00760000
00770000
00780000
00790000
00800000
00810000
00820000
00830000
00840000
00850000
00860000
00870000
00880000
00890000
00900000



L I B I ]

MODCDEF

L I B I )

L I N B ]

RETURN

*

SAVE
RETCODE
CP1MOD2
CP2MOD4
CP2MOD5
*

MODL
SID
TERMID
USERID
CICSID

MVI
GTSIZ
CH
BNL
MVI
CH
BNL
MVI
CH
BNL
MVI
DS

L
L
MvC

MvC
L

L
L
L

LM
BR

LTORG
DS

DC
DC
DC
DC

DC
DC
DC
DC
DC

Appendix D - SmartTest-CICS User Exits

* kA kA kA Kk * * k k k k kA Kk kA kA kA k k * * * k* k* k*k ¥k ¥k ¥k *k Kk * X X X

The following instructions can be used to obtain the model number
of the terminal.

MoDL,C*4*
E

RO,=H"43" IS IT A MOD 47
MODCDEF YES

mopL,C=3*

RO,=H"32" IS IT A MOD 37
MODCDEF YES

mobL,C*5*

RO,=H"27" IS IT A MOD 57
MODCDEF YES

mMoDL,C=2* N - MUST BE MODEL 2
OH

* Kk kA A Kk kX X k k k k *k k kA kA k k k * *k * k*k k*k k*k ¥k ¥k ¥k Kk Kk * * X X
IT you want to examine the CICS ACB name, the CICS logon applid

that the user entered, or the TSO appl name, retrieve saved
register 9, and use the offsets listed above:

R1,SAVE+4
R9,12+(R9+2)*4(R1) RETRIEVE SAVED R9
CICSID,CSACB(R9)  CICS ACB NAME

Insert here code to select the proper list. If an error exists,
put non-zero value in “retcode”.

RETCODE,=F"16"

RO, CPIMOD2
R13,SAVE+4 GET SAVE AREA ADDRESS
R15,RETCODE SET RETURN CODE
R14,12(R13) RETURN REGISTER
R1,R12,24(R13) RESTORE CALLING ENVIRONMENT
R14 RETURN

9D

Fro"

A(CIM2)

A(C2M4)

A(C2M5)

cr -

cL4- -

cLs" - TSO TERMINAL 1D

cLs" - TSO USER ID

cLs" - CICS ACB NAME

00910000
00920000
00930000
00940000
00950000
00960000
00970000
00980000
00990000
01000000
01010000
01020000
01030000
01040000
01050000
01060000
01070000

01080000
01090000
01100000
01110000
01120000
01130000
01140000
01150000
01160000
01190000
01200000
01210000
01220000
01230000
01240000
01250000
01260000
01270000
01280000
01290000
01300000
01310000
01320000
01330000
01340000
01350000
01360000
01370000
01380000
01390000
01400000
01410000
01420000
01430000
01440000
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User Exit 5 - Dynamically Loaded Modules Exit

User Exit 5 has been removed as of SmartTest Version 2.1. It isno longer needed.

User Exit 6 - Providing LOGONMSG Data to CICS EXxit

148

User Exit 6, shown in Figure 24, is used to provide logon message datato CICS.

Figure24 « User Exit 6 - Provide LOGONMSG Datato CICS

* ASG, INC. ASG-SMARTTEST Rx.Xx MMM YYYY *

*

* OPTIONAL USER EXIT #6. PROVIDE LOGONMSG DATA TO CICS.

*

*

*

*

00020000
00030000
00040000
00050000

VIACEXO6 CAN BE USED TO SPECIFY LOGONMSG DATA WHICH CAN BE
RETRIEVED BY CICS WITH "EXEC CICS EXTRACT LOGONMSG*
(NOT AVAILABLE ON CICS RELEASES PRIOR TO 1.7).

ON ENTRY TO VIACEXO06:

REGISTER 3 CONTAINS THE ADDRESS THE TSO USERID (ISPF ZUSER)
REGISTER 13 CONTAINS THE ADDRESS OF A SAVE AREA.

REGISTER 14 CONTAINS THE RETURN ADDRESS, AND

REGISTER 15 CONTAINS THE ENTRY POINT OF VIACEXO06.

ook % % % ok ok ok F X X X%

R9->VTAM-TSO Communication block and provides addressability
* to the following (3) data items:

CSALS EQU X"D8",8 +D8 - CICS alias name, char(8)
CSACB EQU X®3C-,8 +3C - CICS ACB name, char(8)
TSOAPL EQU X"34-°,8 +34 - TSO applic. id, char(8)

*

ON RETURN:

REGISTER 15: SHOULD CONTAIN THE ADDRESS OF THE LOGONMSG
in the FORMAT:
Llogon message data
WHERE "L*" IS A ONE BYTE LENGTH OF DATA TO FOLLOW.

LGNMSG=YES MUST BE SPECIFIED IN THE SIT (OR AS A SIT OVERRIDE).
DATA CAN BE EXTRACTED ONLY ONCE -- REFER TO THE EXTRACT COMMAND
IN THE COMMAND LEVEL APRM.

FOLLOWING IS A SAMPLE EXIT ROUTINE.

o % % ok ok ok o kX X % ok ok F % X

THE USER MUST SAVE THE REGISTERS ON ENTRY AND RESTORE THEM ON EXIT

FOF X % ok o ok o X X ok ok ok Ok X X X % % F

X ok ok F % % F o F ok % * * F ¥

00070000
00080000
00090000
00100000
00110000
00120000
00130000
00140000
00150000
00160000
00170000
00180000
00190000
00200000
00210000
00220000
00230000
00240000
00250000
00260000
00270000
00280000
00290000
00300000
00310000
00320000
00330000
00340000
00350000
00360000
00370000
00380000
00390000
00400000
00410000




PRINT NOGEN
VIACEX06 CSECT

START

B
DC
DC
DC
STM
LR
USING
ST
LA
ST
LR

Appendix D - SmartTest-CICS User Exits

START-VIACEX06(R15) BRANCH AROUND CONSTANTS

CL8"VIACEX06* MODULE ID EMBEDDED IN CODE.
CL8"&SYSDATE" DATE AND TIME OF ASSEMBLY...
CL8"&SYSTIME" ...IMBEDDED IN CODE.
R14,R12,12(R13) SAVE CALLERS REGS IN CALLERS SA.
R12,R15 GET EP IN R12.

VIACEXO6,R12 ADDRESSABILITY FOR MODULE
R13,SAVE+4 SAVE CALLERS SA POINTER IN MY SA.
R9,SAVE ADDR OF MY SA IN R9.

R9,8(,R13) STORE THAT INTO CALLERS SA
R13,R9 ADDR OF MY SA IN R13.

Kk Kh A A kA k * x k* k k k k k kA kA k k k * * * * k*k k*k ¥ ¥k ¥k Kk Kk X X Xx

* Build the installation specific information to be extracted

* py CICS.

*
*
*

*

*

*

RETURN

*

SAVE
*
LGNMSG
MSGO
LMSG
*
RO
R1
R2
R3
R4
R5
R6
R7
R8
R9
R10
R11
R12
R13
R14
R15

L
L

LA

L
L
LM
BR

LTORG
DS

DC
DC
EQU

EQU
EQU
EQU
EQU
EQU
EQU
EQU
EQU
EQU
EQU
EQU
EQU
EQU
EQU
EQU
EQU
END

Retrieve saved register 9.

R1,SAVE+4
R9,12+(R9+2)*4(R1) RETRIEVE SAVED R9

R15,LGNMSG DATA TO BE EXTRACTED.
R13,SAVE+4 GET SAVE AREA ADDRESS
R14,12(R13) RETURN REGISTER
RO,R12,20(R13) RESTORE CALLING ENVIRONMENT
R14 RETURN

9D

AL1(LMSG)

C"This data will be extracted by CICS.*
*-MSGO

©CoOo~NOOUMWNEO

*

*

* Kk kA kA kX * k k k k k kA k kA kA k k k * *k * *k k*k k*k ¥k ¥k ¥k Kk Kk * * X X

At this point you can examine the CICS ACB name, the CICS alias,
and the TSO SLU name at the offsets listed above.

00440000
00450000
00460000
00470000
00480000
00490000
00500000
00510000
00520000
00530000
00540000
00550000
00560000
00570000
00580000
00590000
00600000
00610000
00620000
00630000
00640000
00650000
00660000
00670000
00680000
00690000
00700000
00710000
00720000
00730000
00740000
00750000
00760000
00770000
00780000
00790000
00800000
00810000
00820000
00830000
00840000
00850000
00860000
00870000
00880000
00890000
00900000
00910000
00920000
00930000
00940000
00950000
00960000
00970000
00980000
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Appendix E

SmartTest-CICS MRO Installation and
Setup

This appendix describes installation and setup requirements for the MROLIST
parameter value and the additional installation definitions for supporting Cross-Route
(CRTE).

Introduction

Running SmartTest in an MRO environment might require special installation
requirements or connection procedures, based on the MRO testing needs. When using the
MROLIST installation parameter (specified in the VIACEMT1 table), you need to
specify how SmartTest isto processin an MRO environment.

Note:

See "Installing and Customizing SmartTest" on page 5 for specific instructions for
installing SmartTest.

Installation Procedure

Define remote PCT definitions for the VIAC transactions in the TOR for each AOR
where SmartTest isinstalled. See "Step 13 - Specifying MRO Transaction Definitions
(Optional)" on page 83 for sample definitions.

If SmartTest isnot installed in the TOR, then one additiona local PCT (VIAR) and two
PPT entries (VIACRUN and VIACZATT) must be defined.
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To define a remote connection

1

4

Note:

From the SmartTest-CICS Session Setup screen, connect to the TOR. Type TOGGLE
and press Enter to return to TSO and select option 3 (Remote Connections screen).

Select the CICS SY SIDsthat qualify for SmartTest testing and choose only the ones
in which testing will occur. This minimizes unnecessary region communications.

Set the CURRENT SY SID field value to the CICS SY SID vaue of the AOR in
which you want SmartTest to process when not in an active test session.

SmartTest uses the CURRENT SY SID to determine from which region resources,
such asfiles, memory areas, and load modules, are acquired. The CURRENT
SY SID specification is an informal cross-routing technique for every SmartTest
function that is not part of an active test.

Begin using SmartTest for testing and/or reviewing resources.

Because step 1 through step 3 are normally first-time setup tasks, they are not required
for future sessions.




Appendix F

SmartTest CNTL and CLIST Members

This appendix lists the SmartTest CNTL and CLIST members.

SmartTest CNTL Members

STFINDAT Script used to find date-sensitive code; containsalist of date identifiers;
used as a parameter to the EXECUTE command.

VIASPRMP  SmartTest default installation option parameters.

VIABKTRK  Macro used by Backtrack VIAPBTTJJCL.

VIACALC SmartTest COBOL demonstration program.

VIALAB SmartTest VIAMAIN demonstration program execution JCL.

VIAMAIN SmartTest COBOL demonstration program.

VIAMEJCL  SmartTest VIAMERGE demonstration program execution JCL.

VIAMERGE SmartTest COBOL demonstration program source.

VIAMINO1 Input files for the VIAMERGE demonstration program.

VIAMINO2

VIAMINO3

VIAMSGS SmartTest COBOL demonstration program copybook.

VIAPALSC  Script used to execute an Alliance application level query.

VIAPASM SmartTest Assembler demonstration program source code.

VIAPASMA  JCL to assemble and link the VIAPASM demonstration program.

VIAPASMJ  SmartTest VIAPASM demonstration program execution JCL.
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VIAPBTS SmartTest BTSIN data cards for BTS installation verification
demonstration.

VIAPBTS] SmartTest BTS execution JCL for BTS installation verification
demonstration.

VIAPBTTB  SmartTest Backtrack allocation exit table source.

VIAPBTTJ JCL to assemble and link SmartTest Backtrack allocation exit.

VIAPCII COBOL Il and later compile procedure. This PROC should be copied to
auser PROCLIB, or it must be embedded in compile JCL members.

VIAPCOB SmartTest COBOL demonstration program, using SmartTest features
and online debugging techniques.

VIAPCOBC  JCL to compile and link the VIAPCOB demonstration program.

VIAPCOBJ  JCL to execute the VIAPCOB demonstration program.

VIAPDLGC  JCL to compile and link VIAPDLGM demonstration program.

VIAPDLGM  SmartTest COBOL dialog manager demonstration program.

VIAPEMEX  Module exclusion table for excluding modules from monitoring at test
time.

VIAPEMOX  JCL to assemble and link VIAPEMOX member to the ESW load
library. VIAPEMOX is used for testing IDM S programs which also
access DB2.

VIAPEMXS  Step exclusion table for excluding modules from the SmartTest STEP
facility.

VIAPEXIT JCL to assemble and link edit the SmartTest user exits and tables.

VIAPEXSB  Batch submit user exit.

VIAPMSGB  SmartTest batch connect message source.

VIAPMSGJ  JCL to assemble and link the SmartTest batch connect messages.

VIAPNOST  Macro used by the VIAPEMXS JCL.

VIAPPLI SmartTest-PLI demonstration program source.

VIAPPLIC JCL to compile and link the VIAPPLI demonstration program.

VIAPPLVC  JCL toinvoketheVisualAgeor Enterprise PL/I compiler to compilethe
SmartTest PL/I IVP programs.

VIAPPLIJ SmartTest-PLI VIAPPLI demonstration program execution JCL.
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Member Description

VIAPQBTH  Alliance application level query for MV S batch environments; lists the
data items found in the application; displays the associated program
name, source library, and member for each dataitem.

VIAPQDB2  Alliance application level query for DB2 environments; lists the data
items found in the application; displays the associated program name,
source library, and member for each dataitem.

VIAPQDBP  Alliance application level query for environments using DB2 stored
procedures; lists the data items found in the application; displays the
associated program name, source library, and member for each data
item.

VIAPQISP Alliance application level query for | SPF batch environments; lists the
data items found in the application; displays the associated program
name, source library, and member for each dataitem.

VIAPQTSO  Alliance application level query for TSO environments; lists the
program and all load modules where it resides, and lists all JCL
members that execute the |oad modules.

VIAPRT SmartTest COBOL demonstration program.

VIAPSNAP  Load module to perform a snap dump.

VIAPSTUB  Object deck used by SmartTest link JCL.

SmartTest-CICS CNTL Members

M ember Description

VIACASM SmartTest-CICS Assembler demonstration program source.

VIACASMJ JCL to assemble the Environment Table (VIACEMT1) and CPU
Table (VIACCPU). Modification instructions are in the VIACASMJ

member.
VIACCII SmartTest-CICS COBOL Il or later demonstration program source.
VIACCII2 SmartTest-CICS COBOL Il or later demonstration program source.
VIACCII3 SmartTest-CICS COBOL Il or later demonstration program source.
VIACCPU CPU ldentification Table. Add al CPUs that will have access to
SmartTest-CICS.

VIACCP21 Macro for assembling VIACEMTL.

155



ASG-SmartTest Installation Guide

156

VIACCP31 Macro for assembling VIACEMT1.

VIACCP32 Meacro for assembling VIACEMT1.

VIACCP33 Macro for assembling VIACEMT1.

VIACCP41 Macro for assembling VIACEMT1.

VIACDBRM DB2 DBRM datafor binding VIACDB2.

VIACDEM2 SmartTest-CICS COBOL |1 or later demonstration program source.

VIACEMT1 Environment Options. This appendix lists the available options to
customize SmartTest-CICS to your installation.

VIACEM41 Optional Environment Table member.

VIACEM51 Optional Environment Table member.

VIACENV Macro for assembling VIACEMT1 module.

VIACEXO01 User exit number 1 - Initialization exit.

VIACEX02 User exit number 2 - Storage Validation exit.

VIACEX04 User exit number 4 - ACB Naming exit.

VIACEXO06 User exit number 6 - Exit to Provide LOGONM SG Datato CICS exit.

VIACJASM JCL to assemble and link edit the Assembler demonstration program
(VIACASM).

VIACIBND JCL to bind the VIACDB2 DBRM CNTL member (VIACDBRM).

VIACJICII JCL to compile and link edit the COBOL Il demonstration system
(VIACDEMZ2, VIACCII, VIACCII2, and VIACCII3).

VIACJES3 JCL to defineaVSAM CSD for JES 3 sites.

VIACIMAP JCL to assemble and link edit the demonstration program mapsets
(VIACMAP and VIACMAA).

VIACJIPLI JCL to assembleand link edit the SmartTest-CICS PL/I demonstration
program source (VIACPLI).

VIACMAA BMS Assembler source for command level Assembler demonstration.

VIACMAP BMS Assembler source for demonstration program map.

VIACPLI SmartTest-CICS PL/I demonstration program source.

VIACPLT CICSPLT Post-initialization entry.




Appendix F - SmartTest CNTL and CLIST Members

Member Description

VIACPLTX CICSPLT Shutdown entry.

VIACPRAJ JCL to format and print the CICS trace dataset.

VIACPRDJ JCL to format and print the CICS dump dataset.

VIACPRVJ JCL to format and print the VTAM trace dataset.

VIACRCT DB2 RCT control cards.

VIACSDJB For CICS 4.1 and above, the JCL to update the CICS CSD file for
SmartTest-CICS PPT and PCT. Modification instructions are in the
VIACSDJIB member.

VIACTBLD Initialization member for the VIACTBLSfile.

VIACTBLJ JCL to define and initialize the SmartTest-CICS Monitoring Rules
Table (Protection Table) -- VIACTBLS.

VIACVTAM VTAM terminal entries model.

VIAPRMFT RMF table allocation program.

SmartTest-IMS CNTL Members

Member Description

VIAPCMD SmartTest-IM S authorized command processor (BMP program
source input).

VIAPCMDJ JCL to assemble and link SmartTest-IM S authorized command
processor (BMP program).

VIAPDTLO SmartTest-IM S database input data cards.

VIAPIMSA JCL to allocate databases for the demonstration program.

VIAPIVAL SmartTest-IMS COBOL demonstration program.

VIAPIVC JCL to compile and link the VIAPIV A1 demonstration program.

VIAPIVD SmartTest-IMS DBD source input.

VIAPIVF1 SmartTest-IM S Format source input.

VIAPIVF2 SmartTest-IM S Format source input.

VIAPIVP] SmartTest-IMS JCL to create the demonstration facility.
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Member Description

VIAPIVPL SmartTest-IMS PSB source input for database load.

VIAPIVP1 SmartTest-IMS PSB source input for database read.

VIAPMODB SmartTest-IMS JCL to create transactions eligible for testing.

VIAPMOFF Macro used by VIAPOGMJ.

VIAPOGMJ JCL to create SmartTest-IM S environment-specific definitions. See
"Step 2 - Modifying and Executing CNTL Library Members' on
page 101 for more information.

VIAPMTRJ JCL to print SmartTest-IMS internal tracefile.

VIAPLTRM LTERM names and MFS device types defined to IMS/DC.

VIAPQBTS Alliance application-level query for BTS environments; lists the
transaction that invokes the specified program.

VIAPQIMB Alliance application-level query for IMSbatch environments; liststhe
dataitems found in the application; displays the associated program
name, source library, and member for each dataitem.

VIAPQIMS Alliance application-level query for IMS environments; lists the
transaction that invokes the specified program.

VIAPTRAN IMS/DC transaction names eligible for testing.

SmartTest CLIST Members

M ember Description

SMARTEST  Used by the VIATEST CLIST toinvoke the SmartTest product from native TSO.

VIAEDUSR  User exit to support source managers other than the | SPF options of Librarian
and Panvalet.

VIAPJCLC Invoked to execute the batch JCL conversion process.

VIAPICLE Displays errors during JCL conversion process.

VIAPSBAT  Invoked to edit generated JCL for the batch job submit function.

VIAPSUB Invoked to submit a batch job.

VIAPTSOT Invokes the SmartTest program under TSO test for diagnostic purposes only.
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M ember Description

VIAPUBTS  Usedto restore BTS system variables and parameters to the site standards.
Default dataset names are provided and should be modified to use site standards,
which canbefoundin existing BTStest JCL and CLISTs. Theseitemshave been
provided with standard IBM installation defaults:

BTSLOADLIB
BTSFORMAT
QIOPCB
QALTPCB
QALTRAN
BTSOUT
BTSPUNCH
BTSDEBUG
BTSSNAP

'BTS.BTSLIB
'IMS.FORMAT'
TEMPORARY DATASET
TEMPORARY DATASET
TEMPORARY DATASET
TERM

none

none

none

VIAPUIDC IMS/DC only. Used to restore IMS/DC system variables and parameters to the

site standards. Default
IOPCB LTERM name
which can be found in

dataset names, suffix for MODBLKS, and a default
are provided and should be modified to use site standards,
existing IMS/DC JCL. These items have been provided

with standard IBM installation defaults:

IMS/DC FORMAT IMS.FORMAT

IMS/'DC RECON none

DFSSTAT none

FPTRACE none

IOPCB LTERM IOPCB

IMS/'DC MODBLKS 'IMS.MODBLKS
IMS/'DC MODBLKS SUFFIX A

IMS/DC TRANSACTION DEFINITIONS 'ASG.VIACENXX.CNTL'
MEMBER VIAPTRAN

IMS/DC LTERM DEFINITIONS 'ASG.VIACENXX.CNTL'
MEMBER VIAPLTRM
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Member Description

VIAPUIMS  Used to restore IMS system variables and parameters to the site standards.
Default dataset names and parametersfor DLI and BM P are provided and should
be modified to use site standards, which can be found in existing IMS test JCL
or CLISTs. Theseitems have been provided with standard IBM installation

160

defaults:
IMSRESLIB
IMSPROCLIB
DFSVSAMP
DB2 LOADLIB
IMSMON
IEFRDER
IMSPSB LIB
IMSDBD LIB
IMSACBLIB
DLI PARMS
BUF
SPIE
TEST
EXCPVR
RST
SRCH
MON
SWAP
IRLM
BKO
BMP PARMS
OPT
SPIE
TEST
DIRCA
CPUTIME

'IMS.RESLIB’
'IMS.PROCLIB'
'IMS.PROCLIB(DFSVSMDB)'
'DSN220.DSNLOAD!

none

temporary dataset

none

none

none

Z2Z20Z00000®

ooz
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Member Description

VIAPUSPF Restores | SPF system variables to the site standards:
ISPF PROGRAM LOAD LIBRARY 'ISP.V3R1MO0.ISPLOAD' (REQUIRED)

ISPF PANEL LIBRARY none (see Note below)
ISPF LINK LIBRARY none (see Note below)
ISPF TABLE LIBRARY none (see Note below)
|SPF MESSAGE LIBRARY none (see Note below)
ISPF SKELETON LIBRARY none (see Note below)
ISPF LIST DATASET SYSOUT

ISPF LOG DATASET SYSOUT

Note:

For those default libraries listed above as None, your existing | SPF libraries are
used if no other is supplied.

VIATEST Invokes the SmartTest program from a CLIST using the correct application ID
(VIAP).
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Appendix G
Problem Determination

CICS: VEXE Transaction Abend

SmartTest-CICS acquires CI CS resources through Command Level requests. Should a
request receive an unexpected response, SmartTest abends the transaction with a VEXE
abend code. Within the VEXE transaction dump, a piece of transaction storage contains
information about the type of request and the CICS response codes. The transaction
storage is normally the first allocated piece of storage and contains VIACEXEC at
offset +8.

Thistable lists critical fields that ASG Customer Support will need to help determine the
cause of the abend:

+40 through +43 Command level function code.

+44 through +47 EIBRESP code.

+48 through +4B EIBRESP2 code.

+BO0 through +B7 The SmartTest CSECT name in control.
+B8 through +BB CSECT internal reference number.

In addition to the VEXE transaction dump, the VIACEXEC control block iswritten to
Temporary Storage under the key VIACEXEC. To accessthisinformation online, usethe
SmartTest-CICS File Services facility or enter this CECI command:

CECI READQ TS QUEUE("VIACEXEC") ITEM(1)

To expand this record, Tab to the INTO area and press Enter.
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CICS: VIAL Memory List Transaction

For debugging purposes, the transaction VIAL is provided to view and update memory.
Type VIAL to receive help information:

VIAL
CICS x.x

HELP: ADDRESS, PGM, MOD, CSA, TCA, TCT, TSM, +/-/@QOFFSET,
D=X""XX", D=C"C"

where:

Parameter Description

ADDRESS Identifies any absolute address.

PGM Specifies the PPT module entry point.

MOD Specifies the PPT module load point.

CSA Specifies the CICS CSA control block.

TCA Specifies the CICS TCA control block.

TCT Specifiesthe CICS TCT control block.

TSM Specifies the CICS TSM control block.

+nnn Specifies the positive offset.

-nnn Specifies the negative offset.

@nnn Specifies the offset from the base address that pointsto an indirect address.

The memory at the indirect address displays.

D=X"xx"  Changesthe dataat the specified addresswith the hexadecimal value(s) "xx".

D=C"x" Changes the data at the specified address with the character value(s) "x".

This transaction isintended for the systems programmer and ASG personnel, and is not
documented in the ASG-SmartTest CICS User’s Guide.
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SmartTest-CICS Resource Requirements

SmartTest-CICS requires varying amounts of CICS program and transaction storage,
depending on the features used and the number of users. This table provides storage

estimates for different types of storage.

Resident Program Storage 51K
Non-Resident Program RMODE(24)

High Usage 114K

Low Usage 55K
Non-Resident Program RMODE(31)

High Usage 95K

Low Usage 8K
Temporary

Each active SmartTest terminal 2K

User-testing three COBOL |11 modules 1K
User-24 Transaction

Average amount per testing defaults 15K
User-31 Transaction

Average amount per testing defaults 8K

Counts feature for 3 programs 12K

Backtrack feature (default size) 100K

All of the resources used by SmartTest can be reclaimed by stopping SmartTest with the
VIAI STOP transaction. In addition, all of the temporary storage records can be purged
without stopping SmartTest by typing VIAI PURGE.

165



ASG-SmartTest Installation Guide

166



Index

Symbols
/SIGN command 103

A
abend codes
APCT 62
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user 222 25
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ACB naming exit 156
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modifications 133
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APPL entries 51
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compile JCL 119
DEBUG option 117
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ASMBLR parameter 47
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authorized programs, testing 22
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AutoChange
accessing from ESW screen xiii
description x
autoinstall
CEDA 30
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B

Batch connect
assemble messages 154
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Batch connection facility 2

Batch session testing 25

Batch submit exit 135, 139, 154

Batch-Connect-JCL-STEPLIB installation
option 12

BMC Superoptimiser 34

BMP 14

BMPPARMS 14

BMSG 53

Bridge
accessing from ESW screen Xiii
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BTS
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CLISTs 13, 159
execution JCL 154
FORMAT 13
parameters 13, 159
system variables 13, 159
test JCL 13,159

BTSDEBUG 13

BTSOUT 13

BTSPUNCH 13
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C
CA-OPTIMIZER Il compiler option 130
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autoinstall 30
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CENTER parameter 9, 47, 100
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ASG dataset restrictions 35
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command level 37

connect problems 96

connecting through SmartTest 96

CSECT number limitation 35

CWA 57
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extended file services for DB2 and
DLI 79

File Services option 74
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Global User Exits 57
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how to connect 96
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initial transid 34

installation checklist 90

internal security 33

logon message 39
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monitoring transaction level 37
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OS loaded modules 59
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PL/I support 79
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program protection tables 38
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restrictions 3.3 and above 33

security requirements 32

shared storage requests 62
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SmartTest exits 39

SmartTest installation and
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SmartTest NEWCOPY 33

SmartTest resource requirements 165

standaloneillustration 77
startup JCL 88
storage protection, turning off 38
storage utilization 39, 59
Temporary Storage queues 32
terminal control exit 34
terminal data compression 34
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trace dataset 157
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XZCIN user exit 34
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CICSCWA 58

CICS data compression
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MEGAPACKER 34
Pl 34
session manager 34
UFO 34
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CICS demonstration programs
COBOL Il programs 89
COBOL optimization 89
VIACMAP mapset 89
VIAMAA mapset 89

CICS disconnect time 53

CICS EIB updating, restricting access 57

CICS ESA, data space access 37

CICS external security software
ACF2 53
excluding modules 33

CICS File Services
DB2and DLI 79
DB2 catalog prefix 59
installing 74
restricting access 56
VIACDB 79
VIACDLI 79
VIACIBND 80

CICS global protection tables 69

CICSlog 59

CICSlogoff 31,51



CICSlogon
APPL entries 51
APPLID 54
connection to CICS 96
describing to SmartTest-CICS 51
good morning screen 52
logon message 39
LOGONMSG 39
process 31
pseudo-conversational menu 53
Session Setup screen 52, 54
CICS MACLIB name, installation
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CICS maximum resource utilization
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temporary storage requests 61
total storage 61
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MACLIB 63
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TOR 87
VIACEMxx modules 63
CICSPL/I, installing 74
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upgrading from prior release 74
CICSregion logon APPLID
example 54
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release specification 57
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Index

CICS security
ENTRY 55
EXITPROGRAM 32
external software 33
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internal 33
operator access 54
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RSLC 33
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software 33
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good morning screen 52
LOGONMSG 39
pseudo-conversational menu 53
Session Setup screen 52
CICS SOURCE library name 44
CICS standaloneillustration 77
CICS storage utilization
executable code not in program
storage 39, 59
outside TCA chain 39,59
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interval control exit 37
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installation options 57
CICS terminal definitions
autoinstall 51
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creating new 30
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DELETE access on File Services 57 Environment Selection Menu 107
File Services 59 Environment Selection menu 21
LOADLIB 14 environment table 155

READ access on File Services 57 environment table parameters
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validating support 23 APPLID 52
DB2CTLG 59 BMSG 53
DB2-Procedure-Plan installation option 11 CICSVER 58
DCSINIT 59 CWA 58
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APSoption 117 DCSINIT 59
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installation
CICS COBOL command level
trandlator 47
CICSMACLIB name 44
CICSMTS (Macro Temporary Store)
library 44
CICSoptions 57
CICS SOURCE library name 44
considerations 6
CPUID for CICS 48
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options 11
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M
macro
SPIE 137
STAE 137
maintenance 133
MAXCALL 60
MEGAPACKER 34
memory display 55
memory list transaction, VIAL 164
memory requirement 15
menu, Environment Selection 21, 107
messages
BREAK AT START OF TEST
SESSION 97
FILE I/O REQUESTS EXCEED
MAX 60
ICH408l 32
ILLEGAL SVC CALL 62
POSSIBLE CICS CALL LOOP 60
SmartTest-CICSiinitialization 59, 92
SmartTest-CICS termination 92
STORAGE ACCUMULATED
EXCEEDS MAX 61
TEMP STORAGE REQUESTS
EXCEED MAX 61
TRANS DATA REQUESTS
EXCEED MAX 60
migrating to new version of IMS 101
MLPA
adding SmartTest modules 15
copying VIAPPRBE 22
MLPA/PLPA 38



MODBLKS dataset 103
MODEL terminal definitions 29
modifications 133
Module Exclusion table 135-136
module exclusion table 154
monitoring
CICS program level 37
CICS protection tables 37
CICS session setup screen 37
CICStransaction level 37
HOGAN 40
program level 38
transaction level 38
MRO
accessto AOR 52
APPL entry 52
connection definitions 52
installing in 151
PCT entries 83
remote connections screen 52
remote PCT definitions 52, 83
test sessions 86
transaction definitions 83
multiple CPUs, domains 29
multiple release support, CICS 38
MV S linkage conventions 136

N

NATURAL, co-existing with SmartTest 39
NETNAME, VTAM labels 30

NEWAPPL (VIAP) parameter 16
NEWCOPY CICS programs 97
NEWCOPY command 33

NUMBEXT 61

NUMMAX 61

o]

OBJECT option, Assembler H 11

operating environment 6

OPERATOR entries 55

OPID 55

OPIDTYP 61

Options - Log/List/Punch Definition
pop-up 18, 94, 106, 112

Options - PF Key Definition pop-up 112

Options - Product Parameters pop-up 18, 94,
105, 112

OPTIONS entries 58

Options pull-down 17, 94, 105, 112

P
PANEACCS module 40
panel, VPPISPFT 22

Index

PANEXEC 40
PCT
MRO entries 52, 83
remote definitions 86
remote PCT definitions 83, 85
validating entries 97
performance 15
PERMUNT parameter 47
PERMVOL parameter 47
Pl 34
PL/1 69
PL/I support 79
PLIMAIN 61
PLPA
adding SmartTest modules 15
and authorized programs 22
PLT 88
pop-up
File - AKR Allocate/Expand 19
File- AKR Utility 18
Options - Log/List/Punch
Definition 18, 106
Options - Product Parameters 18
post-initialization entry 88, 156
PPT
entries 157
SmartTest-CICS entries 69
validating entries 97
product integration Xiii
program list table 88
program protection table - CICS 38
Program Specification screen
allow ADD 56
allow ADD, CHANGE, DELETE 56
software products 39
protection tables - CICS 37
PSB swapping in CICS 59
pseudo code 2
pseudo-conversational menu 31
PTF 90, 133
PTFsfor SmartTest-CICS 90
pull-down
File 106
Options 17, 94, 105, 112

Q

QALTPCB 13
QALTRAN 13
QIOPCB 13

R

RCT 69
RDO GROUPLIST - CICS 44
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Recap
accessing from ESW screen Xiii
description xi
Remote Connections screen 86
remote connections screen - CICS 52
remote monitoring facility, allowing
access 57
remote PCT definitions 83, 86
RENTPGM restrictions 33
RENTPGM=NOPROTECT SIT override
option 33
RENTPROT 62
resource requirements, SmartTest-CICS 165
RESSEC initialization parameter 32
restricting use of SmartTest’s features 54
restrictions
CICS 4.1 and above 33
RMF table 82
RMFSCOPE environment parameter 62
RSL=PUBLIC 33
RSLC 33
RSLC=YES 33

S
SAMH-Object installation option 11
SAMPLPTF 133
screen
APS Generator Options 118
Facility Specification 56
File - AKR Allocate/Expand 107,114
File- AKR Utility 95, 106, 113
File- Analyze Submit 96, 114, 122
Options - Log/List/Punch
Definition 94,112
Options - PF Key Definition 112
Options - Product Parameters 94, 105,
112
Program Specification 39, 56
Remote Connections 86
Storage Specification 56
Swap Specification 56
Task Specification 56
script file 2
security
requirements for CICS 32
software for CICS 33
security software 92
Service Packs, using 1
Session Setup screen
CICS 37,52
transaction limits and options 61
shared DASD 92
shared storage regquests - CICS 62
Show and Tell 34

SHRTBL 62
shutdown entry 157
signoff TRANSID, CICS 31, 51

signon
CICStable 55
validity checking for IMS 103
SIT
CWA length 58
ICVTSD parameter 37
interval control exit 37
override option
RENTPGM=NOPROTECT 33
overrides 88
SmartDoc
accessing from ESW screen Xiii
description xi
SmartEdit
accessing from ESW screen xiii
description xii

SmartEdit, disabling from SmartTest 17
SMARTEST CLIST member 16, 158
SmartQuest
accessing from ESW screen xiii
description xii
SmartTest
accessing from ESW screen Xiii
batch session testing 25
CNTL libraries 9, 126
customizing Stored Procedure
option 125
description xii
installation requirements 6
introduction 1
invoking asacommand 17
invoking from CLIST 16, 161
invoking from ISPF 16
invoking from native TSO 158
operating environment 6
operational considerations 25
validating TSO 17
validating update facility 24
SmartTest-APS
APS18SUB CLIST 119
CLIST 119
compile JCL 119
customization 117
DEBUG option 117
Generator Options screen 117
SmartTest-CICS
abend codes 40
changing release 41
coexistence with other vendor
products 39
initialization options 57



initializing 92
installation instructions 41
installation worksheet 44
interim modifications 134
maintenance 92
new installation 41
PPT entries 69
PTFs 90
resource requirements 165
upgrading 41
upgrading from R3.1 43
user exits 30
SmartTest-IMS
customization 99
validating 105
SmartTest-PLI
customization 121
validating 122
SMSG 53
SPIE macro 137
SPZAPJCL 133
SREQD 52
STAE macro 137
standard logon sequence 31
standard signon sequence 31
Step Exclusion table 135-136
step exclusion table 154
STFINDAT CNTL member 153
stopping SmartTest 134
storage protection - CICS, turning off 38
Storage Specification screen, allowing ADD,
CHANGE, DELETE 56
storage validation exit 143, 156
storage violations 59
stored procedure
customizing 125
modifying VIAPBIND 126
stored procedure option, installing and
customizing 125
SUBMIT command 139
submitting the jobstream 118
SUBTABLE label 139
supported environments
databases 7
environments 7
languages 6
SVC numbers 62
swap program feature, SWAPADD
option 62
swap space 15
Swap Specification screen, allowing ADD,
CHANGE, DELETE 56
SWAPADD 62
swapping PSBsin CICS 59

Index

symbolic parameters 44, 100
SY SDA parameter 9, 47, 100
SYSIBM 59
SY SOUT parameter 9, 47, 100
system variables and parameters
BTS 13
IMS 14
ISPF 15

-
T1CIREL 63, 85
T1CIREL parameter 68
table
instaling user table 22
Module Exclusion 135-136
Step Exclusion 135
TAPE parameter 47
Task Specification screen, allowing ADD,
CHANGE, DELETE 56
TCT entries 97
temporary storage cleanup 76
temporary storage key 60
Temporary Storage queues 32
temporary storage queues 35
terminal control exit - CICS 34
terminal data compression - CICS 34
TERMINAL definition- CICS 34
terminal 1/O arealength 46
Terminal 1/0O Areas (TIOAs) 30
Terminal Owning Region (TOR) 29, 31
Terminal Scan Delay - CICS 37
testing
authorized programs 22
Dialog Management programs 22
Update Facility 24
TIOAs 30, 34
TOP SECRET, co-existing with
SmartTest 39
TOR
partial installation 87
remote PCT definitions 83
termina owning region 29, 31
transaction ID file 101
Transient Data Destination 59
TRNPARM parameter 47
TSD 37
TSO
logon region size 6
obtaining TSOID in IMS 104
TSO/ISPF
environment 2
setting up 2
TSOID, obtaining in DFSCSGNO 104
TYPE=APPL 51
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TYPE=EXABEND 66
TYPE=EXCSECT 66
TYPE=OPERATOR 55
TYPE=OPTIONS 58
TYPETERM definitions 29-30

U
UFO
co-existing with SmartTest 39
compression exit 34
Update Facility
testing 24
validating 24
upgrading
ASG-SmartTest-CICS 41
from SmartTest-CICS R3.1 43
uppercase trandation user exits 34
user 222 abend code 25
user catalog 19, 95, 106, 113
user definition files, preparing 103
user exit
Batch submit 154
initialization 141
reviewing 22
SmartTest-CICS 39
storage validation 143
to assemble and link edit 154
using 135
user exit 1 141
user exit 2 143
user tables 22, 135
USERL B parameter 9

V
validating
DB2 support 23
IDMS support 22
SmartTest-ASM 112
SmartTest-CICS installation 90
SmartTest-PLI 122
Update Facility 24
VCOB demonstration transaction 96
VEXE transaction abend 163
VIAA 33
VIAA PCT entry 87
VIABKTBK CNTL member 153
VIABKTRK CNTL member 153
VIAC 33
VIACALC CNTL member 153
VIACAPPL CNTL member 31
VIACASM CNTL member 155
VIACASM program 156
VIACASMJCNTL member 48, 68, 155

VIACBR CNTL member 89
VIACCII CNTL member 89, 155
VIACCII program 156
VIACCII2 CNTL member 155
VIACCII2 program 156
VIACCII3 CNTL member 155
VIACCII3 program 156
VIACCP21 CNTL member 155
VIACCP31 CNTL member 156
VIACCP32 CNTL member 156
VIACCP33 CNTL member 156
VIACCP41 CNTL member 156

VIACCPU CNTL member 35, 48, 90, 155

VIACDB 79
VIACDBRM CNTL member 156
VIACDEM CNTL member 89
VIACDEM2 CNTL member 156
VIACDEM2 program 156
VIACDLI 79
VIACEMA41 CNTL member 68, 156
VIACEM51 CNTL member 68, 156
VIACEM52 CNTL member 68
VIACEM53 CNTL member 67-68
VIACEMTL1 CNTL member 35, 58, 68,
155-156
VIACEMTL1 table 96, 155
VIACEMxx module 63
VIACENV CNTL member 51, 156
VIACEXOL CNTL member 156
VIACEX02 CNTL member 156
VIACEX04 CNTL member 156
VIACEX06 CNTL member 156
VIACEXEC module 40
VIACJASM CNTL member 90, 156
VIACIBND CNTL member 80, 156
VIACJCII CNTL member 89, 156
VIACJES3 CNTL member 156
VIACIMAP CNTL member 89, 156
VIACJIPLI CNTL member 156
VIACMAA CNTL member 156
VIACMAA program mapset 156
VIACMAP CNTL member 156
VIACMAP program mapset 156
VIACPLI CNTL member 74, 156
VIACPLT CNTL member 88, 156
VIACPLTX CNTL member 88, 157
VIACPRAJCNTL member 157
VIACPRDJCNTL member 157
VIACPRVJCNTL member 157
VIACPY Il CNTL member 89
VIACRCT CNTL member 81, 157
VIACRUN 151
VIACRUN PPT entry 87
VIACSD41 CNTL member 157



VIACTBLD CNTL member 69, 157
VIACTBLJCNTL member 69, 157
VIACTBLSfile 39, 41, 90, 157
VIACTBLS protection table 157
VIACTBLSVSAM file 88
VIACTSCL temporary storage cleanup
program 76
VIACVTAM CNTL member 35, 48, 90, 157
VIACZATT 151
VIACZATT PPT entry 87
VIACZATT user exit 34
VIAD transaction 33, 83
VIAEDUSR CLIST member 158
VIAI 33
VIAI START 92
VIAI STOP 92
VIAL 33
VIAL memory list transaction 164
VIALAB CNTL member 10, 153
VIAMAIN CNTL member 153
VIAMAIN program 153
VIAMECII CNTL member 20
VIAMEJCL CNTL member 10, 153
VIAMERGE CNTL member 153
VIAMERGE program 153
VIAMINOL CNTL member 153
VIAMINO2 CNTL member 153
VIAMINO3 CNTL member 153
VIAMSGS CNTL member 153
VIAPASM CNTL member 153
VIAPASM program 153
VIAPASMA CNTL member 10, 114, 153
VIAPASMJCNTL member 10, 153
VIAPBIND CNTL member 11, 126
VIAPBKRP CNTL member 35
VIAPBTSI CNTL member 154
VIAPBTSICNTL member 154
VIAPBTTB CNTL member 154
VIAPBTTB module 138
VIAPBTTB table 138
VIAPBTTJCNTL member 154
VIAPCII CNTL member 10, 154
VIAPCMD CNTL member 101, 157
VIAPCMDJCNTL member 101, 157
VIAPCOB CNTL member 154
VIAPCOB program 154
VIAPCOBC CNTL member 10, 154
VIAPCOBJCNTL member 10, 154
VIAPDLGC CNTL member 10, 154
VIAPDLGM CNTL member 154
VIAPDLGM program 154
VIAPDTLO CNTL member 157
VIAPEMEX CNTL member 136, 154
VIAPEMOX CNTL member 22, 154

Index

VIAPEMRP load module 15
VIAPEMXS CNTL member 135, 154
VIAPEMXSJCL 154
VIAPESUP load module 15
VIAPEXIT CNTL member 10, 137, 139,
154
VIAPEXSB CNTL member 139, 154
VIAPFSPP |load module 15
VIAPIMSA CNTL member 102, 157
VIAPIVA1 CNTL member 157
VIAPIVA1L program 157
VIAPIVC CNTL member 102, 157
VIAPIVD CNTL member 157
VIAPIVF1 CNTL member 157
VIAPIVF2 CNTL member 157
VIAPIVP1 CNTL member 158
VIAPIVPJCNTL member 101, 157
VIAPIVPL CNTL member 158
VIAPJCLC CLIST member 158
VIAPJCLE CLIST member 158
VIAPLTRM CNTL member 158
VIAPMODB CNTL member 101, 158
VIAPMOFF CNTL member 158
VIAPMSGB CNTL member 154
VIAPMSGJCNTL member 154
VIAPMTRJCNTL member 158
VIAPNOST CNTL member 154
VIAPNOST macro 135
VIAPOCRP load module 15
VIAPODBP load module 15
VIAPOGMJCNTL member 101, 158
VIAPOGMJ, rerunning 101
VIAPPCPP load module 15
VIAPPGMP |load module 15
VIAPPLI CNTL member 154
VIAPPLI demonstration program 10
VIAPPLIC CNTL member 10, 122, 154
VIAPPLIJCNTL member 10, 154
VIAPPLVC CNTL member 10
VIAPPRBE load module 15, 22
VIAPPRBE monitor program 12
VIAPPVRP load module 15
VIAPRESP load module 15
VIAPRMFT CNTL member 82, 157
VIAPRT CNTL member 155
VIAPSBAT CLIST member 158
VIAPSNAP CNTL member 155
VIAPSTUB CNTL member 155
VIAPSUB CLIST member 158
VIAPTRAN CNTL member 158
VIAPTSOT CLIST member 158
VIAPUBTS CLIST member 13, 159
VIAPUIDC CLIST 102
VIAPUIDC CLIST member 100-101, 159
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VIAPUIMS CLIST member 14, 160
VIAPUSPF CLIST member 15, 161
VIAQUEUE batch execution queue file 9
VIAR 33, 86
VIAR PCT entry 87
VIASBDAM CNTL member 9
VIASGBL CLIST member 17
VIASLPAJCNTL member 16
VIASLPXJCNTL member 16
VIASOFT parameter 9, 100
VIASUBDS utility 118
VIATEST CLIST member 16, 158, 161
virtual terminal 28-30
VIVPinstalation verification transaction 93
VPPISPFT panel 22
VPVIDCIP parameter 100
VPVIDCLD parameter 100
VPVIDCTD parameter 101
VPVIDCTM parameter 101
VPVMBLB1 parameter 100
VPVMV SUF parameter 100
VSAMVOL parameter 47
VTAM

CICS connectivity considerations 36

definitions 28

domain 29

trace dataset 157
VTAM definition requirements 28
VTAM virtual terminal definitions

ACBNAME 30

APPL 49

APPLID 31

attributes 50

CICSregion VTAM APPLID 51

DLOGMOD 30, 45, 49-50

install definitions 48

IOAREALEN 30

ISTINCLM 49

LABEL 49

major node name 50

MODETAB 49

NETNAME 30, 49

non-SNA terminal 49

gueriable devices 50

session manager 49

SYS1L.VTAMLST 50

terminal capabilities 50

VIACASMJ 48

VIACCPU 48

VIACVTAM 48

VTAM labels 30
VTAM virtual terminal definitions - CICS

ACBNAME 49

virtual terminal 51
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XCMD parameter 32
XZCATT user exit 34
XZCIN user exit 34
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